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Notices

REACH

Complying with the REACH (Registration, Evaluation, Authorisation, and Restriction of
Chemicals) regulatory framework, we published the chemical substances in our products at
ASUS REACH website at http://csr.asus.com/english/REACH.htm.

Federal Communications Commission Statement

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions:
+  This device may not cause harmful interference; and

+  This device must accept any interference received including interference that may cause
undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with manufacturer’s instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not occur
in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user
is encouraged to try to correct the interference by one or more of the following measures:
+  Reorient or relocate the receiving antenna.

+ Increase the separation between the equipment and receiver.

+  Connect the equipment to an outlet on a circuit different from that to which the receiver is
connected.

+  Consult the dealer or an experienced radio/TV technician for help.

k The use of shielded cables for connection of the monitor to the graphics card is required
to assure compliance with FCC regulations. Changes or modifications to this unit not
expressly approved by the party responsible for compliance could void the user’s authority
to operate this equipment.
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RF exposure warning

This equipment must be installed and operated in accordance with provided instructions and
the antenna(s) used for this transmitter must be installed to provide a separation distance of
at least 20 cm from all persons and must not be co-located or operating in conjunction with
any other antenna or transmitter. End-users and installers must be provide with antenna
installation instructions and transmitter operating conditions for satisfying RF exposure
compliance.

Canadian Department of Communications Statement

This digital apparatus does not exceed the Class B limits for radio noise emissions from
digital apparatus set out in the Radio Interference Regulations of the Canadian Department of
Communications.

This class B digital apparatus complies with Canadian ICES-003.

Macrovision Corporation Product Notice

This product incorporates copyright protection technology that is protected by method

claims of certain U.S. patents and other intellectual property rights owned by Macrovision
Corporation and other rights owners. Use of this copyright protection technology must be
authorized by Macrovision Corporation, and is intended for home and other limited viewing
uses only unless otherwise authorized by Macrovision Corporation. Reverse engineering
or disassembly is prohibited.

Lithium-lon Battery Warning

CAUTION: Danger of explosion if battery is incorrectly replaced. Replace only with the
same or equivalent type recommended by the manufacturer. Dispose of used batteries
according to the manufacturer’s instructions.

ASUS Recycling/Takeback Services

ASUS recycling and takeback programs come from our commitment to the highest standards
for protecting our environment. We believe in providing solutions for you to be able to
responsibly recycle our products, batteries, other components as well as the packaging
materials. Please go to http://csr.asus.com/english/Takeback.htm for the detailed recycling
information in different regions.
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Safety information

Disconnect the AC power and peripherals before cleaning. Wipe the Desktop PC using a
clean cellulose sponge or chamois cloth dampened with solution of nonabrasive detergent
and a few drops of warm water then remove any extra moisture with a dry cloth.

+ DO NOT place on uneven or unstable work surfaces. Seek servicing if the casing has
been damaged.

+ DO NOT expose to dirty or dusty environments. DO NOT operate during a gas leak.

+ DO NOT place or drop objects on top and do not shove any foreign objects into the
Desktop PC.

+ DO NOT expose to strong magnetic or electrical fields.

+ DO NOT expose to or use near liquids, rain, or moisture. DO NOT use the modem during
electrical storms.

+  Battery safety warning: DO NOT throw the battery in fire. DO NOT short circuit the
contacts. DO NOT disassemble the battery.

+ Use this product in environments with ambient temperatures between 0°C (32°F)and
35°C (95°F).

« DO NOT cover the vents on the Desktop PC to prevent the system from getting
overheated.

+ DO NOT use damaged power cords, accessories, or other peripherals.

+  To prevent electrical shock hazard, disconnect the power cable from the electrical outlet
before relocating the system.

»  Seek professional assistance before using an adapter or extension cord. These devices
could interrupt the grounding circuit.

»  Ensure that your power supply is set to the correct voltage in your area. If you are not
sure about the voltage of the electrical outlet you are using, contact your local power
company.

+ Ifthe power supply is broken, do not try to fix it by yourself. Contact a qualified service
technician or your retailer.



Conventions used in this guide

To ensure that you perform certain tasks properly, take note of the following symbols used
throughout this manual.

i DANGER/WARNING: Information to prevent injury to yourself
when trying to complete a task.

' CAUTION: Information to prevent damage to the components
H when trying to complete a task.

4& IMPORTANT: Instructions that you MUST follow to complete a
task.

/ NOTE: Tips and additional information to help you complete a
task.

Where to find more information

Refer to the following sources for additional information and for product and software
updates.

ASUS websites

The ASUS website provides updated information on ASUS hardware and software
products. Refer to the ASUS website www.asus.com.

ASUS Local Technical Support

Visit ASUS website at http://support.asus.com/contact for the contact information of
local Technical Support Engineer.
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ASUS Essentio Desktop ASUS ROG U9N Gaming ASUS GX900 Gaming
PC Keyboard package x1 Mouse x1

Power cord x1

b

Warranty card x1 Support DVD x1 Recovery DVD x1
(optional)

nstalaion Suse

Installation Guide x1

OR

Wi-Fi Ring moving antenna x1 Antenna x1 (optional)

/ - If any of the above items is damaged or missing, contact your retailer.

+ Theillustrated items above are for reference only. Actual product specifications may vary
with different models.

For details on using the bundled gaming keyboard and mouse, refer to sections Using
the ASUS ROG Gaming Keyboard and Using the ASUS GX900 Gaming Mouse.






Getting started

Welcome!

Thank you for purchasing the ASUS Essentio CG8580 Desktop PC!

The ASUS Essentio CG8580 Desktop PC provides cutting-edge performance,
uncompromised reliability, and user-centric utilities. All these values are encapsulated in a
stunningly futuristic and stylish system casing.

R Read the ASUS Warranty Card before setting up your ASUS Desktop PC.

Getting to know your computer

% llustrations are for reference only. The ports and their locations, and the chassis color vary
- with different models.

Front panel 9 ? [11Y12)
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10.

1.
12.

Power button. Press this button to turn on your computer.

Secure Digital™ / MultiMediaCard slot. Insert a Secure Digital™ card or
MultiMediaCard into this slot.

Optical disk drive bay. There is an optical disk drive in this bay.
Hot Swap Bay (empty). Allows you to install an additional HDD in this bay.
Power LED. This LED lights up when you turn on your computer.

Memory Stick™ / Memory Stick Pro™ card slot. Insert a Memory Stick™ / Memory
Stick Pro™ card into this slot.

CompactFlash®/ Microdrive™ card slot. Insert a CompactFlash® / Microdrive™ card
into this slot.

OC Button. This button adjusts the System Level Up profile of your computer.

USB 3.0 ports. These Universal Serial Bus 3.0 (USB 3.0) ports connect to USB 3.0
devices such as a mouse, printer, scanner, camera, PDA, and others.

DO NOT connect a keyboard / mouse to any USB 3.0 port when installing Windows®
operating system.

®

+ Due to USB 3.0 controller limitation, USB 3.0 devices can only be used under Windows®
OS environment and after the USB 3.0 driver installation.

+ USB 3.0 devices can only be used as data storage only.

+ We strongly recommend that you connect USB 3.0 devices to USB 3.0 ports for faster
and better performance for your USB 3.0 devices.

USB 2.0 ports. These Universal Serial Bus 2.0 (USB 2.0) ports connect to USB 2.0
devices such as a mouse, printer, scanner, camera, PDA, and others.

Microphone port. This port connects to a microphone.

Headphone port. This port connects to a headphone or speaker.

Chapter 1: Getting started
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1. USB 3.0 ports, support ASUS USB 3.0 Boost UASP Mode. These Universal Serial
Bus 3.0 (USB 3.0) ports connect to USB 3.0 devices such as a mouse, printer,
scanner, camera, PDA, and others.

% + The USB 3.0 ports only support Windows® 7 or later versions. UASP standard only
- supports Windows® 8.

DO NOT connect a keyboard / mouse to any USB 3.0 port when installing Windows®
operating system.

+ Due to USB 3.0 controller limitation, USB 3.0 devices can only be used under Windows®
OS environment and after the USB 3.0 driver installation.

+ USB 3.0 devices can only be used as data storage only.
+ We strongly recommend that you connect USB 3.0 devices to USB 3.0 ports for faster

and better performance for your USB 3.0 devices.

2. USB 2.0 ports. These Universal Serial Bus 2.0 (USB 2.0) ports connect to USB 2.0
devices such as a mouse, printer, scanner, camera, PDA, and others.

ASUS CG8580 13



3.  ASUS Wi-Fi GO! card (Wi-Fi 802.11). Connect the Wi-Fi Ring moving antenna to this
port.

* Wi-Fi LED indications
Off No link
Green Linked

% ASUS Wi-Fi GO! card automatically sets itself to the country's available Wi-Fi channels.

4.  DisplayPort. This port connects a display monitor or a home-theater system.

5. DVI-D port. This port is for any DVI-D compatible device and is HDCP compliant
allowing playback of HD DVD, Blu-ray, and other protected content.

6.  USB 3.0 ports, support ASUS USB 3.0 Boost UASP Mode. Bottom port supports
USB BIOS Flashback.

7.  Side Speaker Out port (gray). This port connects to the side speakers in an 8-channel
audio configuration.

8.  Rear Speaker Out port (black). This port connects to the rear speakers in a 4, 6, and
8-channel audio configuration.

9.  Center/Subwoofer port (orange). This port connects to the center/subwoofer
speakers.

10. Microphone port (pink). This port connects to a microphone.

11.  Line Out port (lime). This port connects to a headphone or speaker. In a 4, 6, or
8-channel configuration, the function of this port becomes Front Speaker Out.

12. Line In port (light blue). This port connects to a tape, CD, DVD player, or other audio
sources.

/ Refer to the audio configuration table below for the function of the audio ports in a 2, 4, 6,
- or 8-channel configuration.

Audio 2, 4, 6, or 8-channel configuration

::::::;I 4-channel 6-channel 8-channel
LightBlue | Lineln | Line In \ Line In \ Line In
Lime ‘ Line Out ‘ Front Speaker Out ‘ Front Speaker Out ‘ Front Speaker Out
Pik | Mcm | Mic In \ Mic In \ Mic In
Orange ‘ - ‘ - ‘ Center/Subwoofer ‘ Center/Subwoofer
Black ‘ - ‘ Rear Speaker Out ‘ Rear Speaker Out ‘ Rear Speaker Out
Gray ‘ - ‘ - ‘ - ‘ Side Speaker Out

14 Chapter 1: Getting started



13.

14.
15.

16.
17.

18.

19.
20.

21,

22,

23.

Air vents. These vents allow air ventilation.

DO NOT block the air vents on the chassis. Always provide proper ventilation for your
computer.

Power switch. Switch to turn ON/OFF the power supply to your computer.

Power connector (input rated: 100~120/200~240Vac, 60/50Hz, 10/5A). Plug the
power cord to this connector.

PS/2 Keyboard / Mouse combo port. This port is for a PS/2 keyboard or mouse.

Optical S/PDIF_OUT port. This port connects to an external audio output device via
an optical S/PDIF cable.

HDMI port. This port is for a High-Definition Multimedia Interface (HDMI) connector,
and is HDCP compliant allowing playback of HD DVD, Blu-ray, and other protected
content.

VGA port. This port is for VGA-compatible devices such as a VGA monitor.

LAN (RJ-45) port. This port allows Gigabit connection to a Local Area Network (LAN)
through a network hub.

LAN port LED indications ACT/LINK SPEED
LED LED
Activity/Link LED Speed LED
OFF No link OFF 10Mbps connection | -
ORANGE | Linked | ORANGE | 100Mbps connection
BLINKING | Dataactivity | GREEN | 1Gbps connection LAN port

Sound card ports (removable). These ports connect to your output devices such as
microphone, headset and speakers.

ASUS Graphics Card (optional). The display output ports on this optional ASUS
Graphics Card may vary with different models.

Expansion slot bracket. Remove the expansion slot bracket when installing an
expansion card.

ASUS CG8580




Setting up your computer

This section guides you through connecting the main hardware devices, such as the external
monitor, keyboard, mouse, and power cord, to your computer.

Connecting an external monitor

Using the ASUS Graphics Card (on selected models only)
Connect your monitor to the display output port on the discrete ASUS Graphics Card.

To connect an external monitor using the ASUS Graphics Card:

1. Connect a monitor to a display output port on the ASUS Graphics Card.

2. Plug the monitor to a power source.

% The display output ports on the ASUS Graphics Card may vary with different models.

16 Chapter 1: Getting started



Using the onboard display output ports
Connect your monitor to the onboard display output port.

To connect an external monitor using the onboard display output ports:

1.

Connect a VGA monitor to the VGA port, or a DVI-D monitor to the DVI-D port, or an
HDMI monitor to the HDMI port on the rear panel of your computer.

Plug the monitor to a power source.

g

\

If your computer comes with an ASUS Graphics Card, the graphics card is set as the
primary display device in the BIOS. Hence, connect your monitor to a display output port
on the graphics card.

+ To connect multiple external monitors to your computer, refer to Connecting multiple

ASUS CG8580

external monitors in Chapter 3 of this user manual for details.



Connecting a USB keyboard and a USB mouse

Connect a USB keyboard and a USB mouse to the USB ports on the rear panel of your
computer.

% The pre-installed setup utility for the bundled ASUS GX900 Gaming Mouse can be

/ accessed only when connecting the mouse to your computer before starting Windows®
7 for the first time. Otherwise, you will have to manually install the setup utility from the
bundled Support DVD. Refer to section Using the ASUS GX900 Gaming Mouse of
Chapter 4 for details.
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Connecting the power cord

Connect one end of the power cord to the power connector on the rear panel of your
computer and the other end to a power source.

Chapter 1: Getting started



Turning your computer ON/OFF

This section describes how to turn on/off your computer after setting up your computer.

Turning your computer ON

To turn your computer ON:

1. Turn your monitor ON.

2. Turn the power switch ON, then press the power button on your computer.

Power button

3. Wait until the operating system loads automatically.

Turning your computer OFF
To turn your computer OFF:

1. Close all running applications.
2. Click E on the Windows® desktop.
3. Click IEM=a=EEES] to shut down the operating system.

ASUS CG8580 19
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Using Windows® 7

Starting for the first time

When you start your computer for the first time, a series of screens appear to guide you in
configuring the basic settings of your Windows® 7 operating system.

To start for the first time:

1. Turn your computer on. Wait for a few minutes until the Set Up Windows screen
appears.

From dropdown list, select your language, then click Next.

From the dropdown lists, select your Country or region, Time and currency, and
Keyboard layout, then click Next.

4. Key in uniques names for the user name and computer name, then click Next.

5. Key in the necessary information to set up your password, then click Next. You may
also click Next to skip this step without entering any information.

/ If you want to set up a password for your account later, refer to the section Setting up a
user account and password in this chapter.

6.  Carefully read the license terms. Tick | accept the license terms and click Next.

7. Select Use recommended settings or Install important updates only to set up the
security settings for your computer. To skip this step, select Ask me later.

8. Review your date and time settings. Click Next. The system loads the new settings and
restarts. You may now start using your computer.

ASUS CG8580 21




Using Windows® 7 desktop

% Click the Start icon ﬂ > Help and Support to obtain more information about Windows® 7.

Using the Start menu

The Start menu gives you access to programs, utilities, and other useful items on your
computer. It also provides you with more information about Windows 7 through its Help and
Support feature.

Launching items from the Start menu
To launch items from the Start menu:

1. From the Windows® taskbar, click the Start icon ﬂ
2. From the Start menu, select the item that you want to launch.

% You may pin programs that you want constantly displayed on the Start menu. For more
details, refer to the section Pinning programs on the Start menu or taskbar on this
chapter.

Using the Getting Started item

The Getting Started item on the Start menu contains information about some basic tasks
such as personalizing Windows®, adding new users, and transferring files to help you to
familiarize yourself with using Windows® 7.

To use the Getting Started item:

1. From the Windows® taskbar, click the Start icon © to launch the Start menu.
2. Select Getting Started. The list of available tasks appears.
3. Select the task that you want to do.

Using the taskbar
The taskbar allows you to launch and manage programs or items installed on your computer.

Launching a program from the taskbar
To launch a program from the taskbar:

. From the Windows?® taskbar, click an icon to launch it. Click the icon again to hide the

program.
% You may pin programs that you want constantly displayed on the taskbar. For more details,
- refer to the section Pinning programs on the Start menu or taskbar on this chapter.

22 Chapter 2: Using Windows® 7



Pinning items on the jumplists

When you right-click an icon on the taskbar, a jumplist launches to provide you with quick-
access to the program’s or item’s related links.You may pin items on the jumplist such as
favorite websites, often-visited folders or drives, or recently played media files.

To pin items to the jumplist:

1. From the taskbar, right-click an icon.

2. From the jumplist, right-click the item that you want to pin, then select Pin to this list.
Unpinning items from the jumplist

To unpin items from the jumplist:

1. From the taskbar, right-click an icon.

2. From the jumplist, right-click the item that you want to remove from the jumplist, then
select Unpin from this list.

Pinning programs on the Start menu or taskbar
To pin programs on the Start menu or taskbar:

1. From the Windows® taskbar, click the Start icon ﬂ to launch the Start menu.

2. Right-click the item that you want to pin on the Start menu or taskbar.
3. Select Pin to Taskbar or Pin to Start menu.

% You may also right-click on the icon of a running program on the taskbar, then select Pin
- this program to taskbar.

Unpinning programs from the Start menu
To unpin programs from the Start menu:

1. From the Windows® taskbar, click the Start icon ﬂ to launch the Start menu.

2. From the Start menu, right-click the program that you want to unpin, then select
Remove from this list.

Unpinning programs from the taskbar
To unpin programs from the taskbar:

1. From the taskbar, right-click the program that you want to remove from the taskbar,
then select Unpin this program from taskbar.

ASUS CG8580 23



Using the notification area
By default, the notification area shows these three icons:

Action Center notification

ﬂ. b Click this icon to display all the alert messages/notifications and launch the Windows®
Action Center.

Network connection

d This icon displays the connection status and signal strength of the wired or wireless network
connection.

(}2 Volume

Click this icon to adjust the volume.

Displaying an alert notification
To display an alert notification:

. Click the Notification icon F:' then click the message to open it.

/ For more details, refer to the section Using Windows® Action Center in this chapter.

Customizing icons and notifications

You may choose to display or hide the icons and notifications on the taskbar or on the
notification area.

To customize icons and notifications:
1. From the notification area, click on the arrow icon El X
2. Click Customize.

3. From the dropdown list, select the behaviors for the icons or items that you want to
customize.

Managing your files and folders

Using Windows® Explorer
Windows® Explorer allows you to view, manage, and organize your files and folders.

Launching Windows® Explorer
To launch Windows Explorer:

1. From the Windows® taskbar, click the Start icon ﬂ to launch the Start menu.

2. Click Computer to launch Windows Explorer.

24 Chapter 2: Using Windows® 7



Exploring files and folders

To explore files and folders:

1. Launch Windows® Explorer.

2. From the navigation or view pane, browse for the location of your data.

3. From the breadcrumb bar, click the arrow to display the contents of the drive or folder.

Customizing the file/folder view

To customize the file/folder view:

1. Launch Windows Explorer.

2. From the navigation pane, select the location of your data.

3. From the toolbar, click the View icon = =.

4. From the View menu, move the slider to select how you want to view the file/folder.

% You may also right-click anywhere on the View pane, click View, and select the view type
- that you want.

Arranging your files

To arrange your files:

1. Launch Windows Explorer.

2. From the Arrange by field, click to display the dropdown list.
3. Select your preferred arrangement type.

Sorting your files

To sort your files:

1. Launch Windows Explorer.

2. Right-click anywhere on the View pane.

3. From the menu that appears, select Sort by, then select your preferred sorting type.

Grouping your files
To group your files:
1. Launch Windows Explorer.
Right-click anywhere on the View pane.

From the menu that appears, select Group by, then select your preferred grouping
type.

ASUS CG8580 25



Adding a new folder

To add a new folder:

1. Launch Windows Explorer.

2. From the toolbar, click New folder.
3. Key in a name for the new folder.

/ You may also right-click anywhere on the View pane, click New > Folder.
Backing up your files
Setting up a backup

To set up a backup:

1. Click &4 > Al Programs > Maintenance > Backup and Restore.
2 Click Set up backup. Click Next.

3. Select your backup destination. Click Next.

4

Select Let Windows choose (recommended) or Let me choose as your backup
mode.

% If you select Let Windows choose, Windows will not back up your programs, FAT-
- formatted files, Recycle Bin files, or temporary files that are 1GB or more.

5. Follow the onscreen instructions to finish the process.

Restoring your system settings

The Windows® System Restore feature creates a restore point where the computer’s system
settings are stored at certain time and date. It allows you to restore or undo changes to your
computer’s system settings without affecting your personal data.

To restore your system:

1. Close all running applications.

2. Click &> an Programs > Accessories > System Tools > System Restore.

3. Follow the onscreen instructions to complete the process.
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Protecting your computer

Using Windows® 7 Action Center

Windows® 7 Action Center provides you with alert notifications, security information, system
maintenance information, and the option to automatically troubleshoot and fix some common
computer problems.

% You may customize the notifications. For more details, refer to the previous section
Customizing icons and natifications in this chapter.

Launching Windows® 7 Action Center
To launch Windows® 7 Action Center:

1. To launch Windows 7 Action Center, click the Notification icon FJ, then click Open
Action Center.

2. From Windows 7 Action Center, click the task that you want to do.

Using Windows® Update

Windows Update allows you to check and install the latest updates to enhance the security
and performance of your computer.

Launching Windows® Update
To launch Windows® Update:

1. From the Windows® taskbar, click the Start icon £ to launch the Start menu.
2. Select All Programs > Windows Update.
3. From the Windows Update screen, click the task that you want to do.

Setting up a user account and password
You may create user accounts and passwords for people who will use your computer.

Setting up a user account
To set up a user account:

1. From the Windows® taskbar, click "1 > Getting Started > Add new users.
Select Manage another account.

Select Create a new account.

Key in the name of the new user.

Select either Standard user or Administrator as the user type.

[ T

When done, click Create Account.
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Setting up a user’s password
To set up a user’s password:

1. Select the user that you would like to set a password.
Select Create a password.

2
3. Keyinapassword and confirm it. Key in your password’s hint.
4 When done, click Create password.

Activating the anti-virus software

Trend Micro Internet Security is pre-installed on your computer. It is a third-party anti-virus
software protecting your computer from virus. It is purchased separately. You have a 30-day
trial period after activating it.

To activate Trend Micro Internet Security:

1. Run the Trend Micro Internet Security application.

2 Carefully read the license terms. Click Agree & Activate.

3. Input your e-mail address and select your location. Click Next.
4 Click Finish to complete the activation.

Getting Windows® Help and Support
Windows® Help and Support provides you with guides and answers in using the applications

in Windows® 7 platform.

To launch Windows® Help and Support, click L4 S Help and Support.

/ Ensure that you are connected to the Internet to obtain the latest Windows® online help.
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Connecting devices to your computer

Connecting a USB storage device

This desktop PC provides USB 2.0/1.1 and USB 3.0 ports on both the front and rear panels.
These USB ports allow you to connect USB devices such as storage devices.

To connect a USB storage device:

+ Insert the USB storage device to your computer.

Front panel Rear panel

To remove a USB storage device:

1. Click ¥ from the Windows notification area on your
computer, then click Eject USB2.0 FlashDisk or Eject
USB3.0 FlashDisk if you are using the USB3.0 flash drive
or USB3.0-compatible devices.

i Open Dewices snd Pristers

i EjectArSEZD Flrshvd

i) Safe To Rersove Hardware .
2. When the Safe to Remove Hardware message i i gk e o A o

pops up, remove the USB storage device from vemarord fram e camge

your computer. —m

// gi DO NOT remove a USB storage device when data transfer is in progress. Doing so may
A cause data loss or damage the USB storage device.
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Connecting microphone and speakers

This desktop PC comes with microphone ports and speaker ports on both the front and
rear panels. The audio /O ports located on the rear panel allow you to connect 2-channel,
4-channel, 6-channel, and 8-channel stereo speakers.

Connecting Headphone and Mic
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Connecting 4-channel Speakers

b E E A

Connecting 6-channel Speakers
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Connecting 8-channel Speakers

® ®@¢ _—:TD

Sl L) {I_
=TT | & |'i1 ’:_}_I

e 0 e

qg |
L1l

32 Chapter 3: Connecting devices to your computer



Connecting multiple external displays

Your desktop PC may come with VGA, HDMI, or DVI ports and allows you to connect multiple
external displays.

R When a graphics card is installed in your computer, connect the monitors on the output
ports of the graphics card.

Setting up multiple displays

When using multiple monitors, you are allowed to set display modes. You can use the
additional monitor as a duplicate of your main display, or as an extension to enlarge your
Windows desktop.

To set up multiple displays:
1. Turn off your computer.

2. Connect the two monitors to your computer and connect the power cords to the
monitors. Refer to Setting up your computer section in Chapter 1 for details on how
to connect a monitor to your computer.

M &
| 97, P
| v + S
| 3

% For some graphic cards, only the monitor that is set to be the primary display has display
a during POST. The dual display function works only under Windows.
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Turn on your computer.

4. Do any of the following to open the Screen Resolution setting screen:

+  Click E > Control Panel > Appearance and Personalization > Display >
Change display settings.

+  Right click anywhere on your Windows desktop. When the pop-up menu appears,
click Personalize > Display > Change display settings.

5. Select the display mode from the Multiple displays: drop-down list.

+  Duplicate these displays: Select this option to use the additional monitor as a
duplicate of your main display.

+  Extend these displays: Select this option to use the additional monitor as an
extension display. This increases your desktop space.

+  Show desktop only on 1/2: Select this option to show desktop only on monitor
1 or monitor 2.

+  Remove this display: Select this options to remove the selected display.

6.  Click Apply or OK. Then click Keep Changes on the confirmation message.

Dicplay Setbngs H:g'

Do you want to keep these dplay settings?

Ko chonges | (]

| Reverting to previews saplay sethings in & seconds,
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Connecting an HDTV
Connect a High Definition TV (HDTV) to the HDMI port of your computer.

/ + You need an HDMI cable to connect the HDTV and the computer. The HDMI cable is
purchased separately.

+ To get the best display performance, ensure that your HDMI cable is less than 15
meters.
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Using your computer

Proper posture when using your Desktop PC

When using your Desktop PC, maintaining the proper posture is necessary to prevent strain to
your wrists, hands, and other joints or muscles. This section provides you with tips on avoiding
physical discomfort and possible injury while using and fully enjoying your Desktop PC.

Eye level to the top of
the monitor screen
<

Foot rest 90" angles

To maintain the proper posture:

Position your computer chair to make sure that your elbows are at or slightly above the
keyboard to get a comfortable typing position.

Adjust the height of your chair to make sure that your knees are slightly higher than
your hips to relax the backs of your thighs. If necessary, use a footrest to raise the level
of your knees.

. Adjust the back of your chair so that the base of your spine is firmly supported and
angled slightly backward.

. Sit upright with your knees, elbows and hips at an approximately 90° angle when you
are at the PC.

Place the monitor directly in front of you, and turn the top of the monitor screen even
with your eye level so that your eyes look slightly downward.

Keep the mouse close to the keyboard, and if necessary, use a wrist rest for support to
reduce the pressure on your wrists while typing.

. Use your Desktop PC in a comfortably-lit area, and keep it away from sources of glare
such as windows and straight sunlight.

. Take regular mini-breaks from using your Desktop PC.
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Using the memory card reader

Digital cameras and other digital imaging devices use memory cards to store digital picture or
media files. The built-in memory card reader on the front panel of your system allows you to
read from and write to different memory card drives.

.';; ;
To use the memory card:
1. Insert the memory card into the card slot.
% + Amemory card is keyed so that it fits in only one direction. DO NOT force a card into a
slot to avoid damaging the card.

You can place media in one or more of the card slots and use each media
independently. Place only one memory card in a slot at one time.

2. Select a program from the AutoPlay window to access your files.

/ + If AutoPlay is NOT enabled in your computer, click Windows® 7 Start button on the
- taskbar, click Computer, and then double-click the memory card icon to access the data
onit.

Each card slot has its own drive icon which is displayed on the Computer screen.

The memory card reader LED lights up and blinks when data is being read from or
written to the memory card.

3. When finished, right-click the memory card drive icon on the Computer screen, click
Eject, and then remove the card.

R Never remove cards while or immediately after reading, copying, formatting, or deleting
data on the card or else data loss may occur.

E To prevent data loss, use “Safely Remove Hardware and Eject Media” in the Windows
: notification area before removing the memory card.
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Using the optical drive
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Inserting an optical disc
To insert an optical disc:
1. While your system is on, press the PUSH button.
2 Press the eject button below the drive bay cover to open the tray.
3. Place the disc to the optical drive with the label side facing up.
4 Push the tray to close it.
5 Select a program from the AutoPlay window to access your files.
% If AutoPlay is NOT enabled in your computer, click Windows® 7 Start button on the taskbar,

/. click Computer, and then double-click the CD/DVD drive icon to access the data on it.

Removing an optical disc
To remove an optical disc:

1. While the system is on, do either of the following to eject the tray:

+  Press the eject button below the drive bay cover.

Right-click the CD/DVD drive icon on the Computer screen, and then click Eject.
2. Remove the disc from the disc tray.
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Using the ASUS ROG U9N Gaming Keyboard

Your CGi8580 Essentio Desktop PC comes with the bundled ASUS ROG U9N Gaming
Keyboard for an optimal gaming experience.

/ Check the section Package contents for the package contents of the ASUS ROG U9N
Gaming Keyboard.

Installing the ASUS ROG U9N Gaming Keyboard

1. Use the bundled PS/2 to USB adaptor to connect your gaming keyboard to your
computer’s USB 2.0 port.
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2. Align and insert the wrist pad into the gaming keyboard’s wrist pad slots (A). Using both
thumbs, push down the wrist pad until it snaps in place (B).

3. Restart your computer. Windows® automatically installs all necessary drivers for your
keyboard.
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Using the ASUS GX900 Gaming Mouse

Your CG8580 Essentio Desktop PC comes with the bundled ASUS GX900 Gaming Mouse
for your full-blast game control.

% Check the section Package contents for the package contents of the ASUS GX900
Gaming Mouse.

The ASUS GX900 Gaming Mouse comes with a left button, a right button, a scroll wheel, two
side buttons, a DPI button, and a specially designed Profile Switch button.

Description Description
1 Left button 7 GX900 logo
2 Right button 8 IE Forward button
3 Scroll wheel 9 |E Backward button
4 DPI switch 10 Mouse feet
5 Profile switch button/Profile indicator* 11 Mouse feet and Twin-Eye Laser sensor
6 LED DPI indicator** 12 Weight base (5 x 4.5g blocks)***

*** To adjust the mouse weight, add or remove the weight blocks.
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*Profile switch LED indications

LED colors | Indications

None Normal Profile
Green Profile 1
Red Profile 2
Orange Profile 3

**DPI switch LED indications

LED colors | Indications
2 DPI Level 1

4 DPI Level 2

Launching the program

A specially designed program is pre-installed on your computer, which allows you to set up
your ASUS GX900 Gaming Mouse to avail all its features.

When you connect ASUS GX900 Gaming Mouse to your computer before starting Windows®
7 for the first time, the program automatically detected the mouse and can be accessed
directly. Otherwise, you will have to manually install the setup utility from the bundled Support
DVD.

To install the program from Support DVD, place the support DVD into the optical drive and
follow the onscreen instructions to launch the program.

% If Autorun is NOT enabled in your computer, browse the contents of the support DVD to
locate the GX900.exe file. Double-click the GX900.exe file to launch the program.

Setting your ASUS GX900 Gaming Mouse

/ Ensure that your gaming mouse is connected to your computer’s USB port. The program
automatically detects the mouse and displays the main menu.
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Main Menu

ltems  Description

1 |Click each tab to display the selected profile menu.

Displays the profile icon to configure profile 1-3 menus.

Click to reset the DPI configuration to the previously saved settings.
Drag the slider to adjust the DPI value for each level.

Click to reset the button settings to the previous settings

Click to display the different profile color indicators and their status.
Click to load the saved profile to your mouse.

Click to save the current profile settings to your hard disk drive.
Click to reset all the mouse settings to the factory default settings.
Click to save the settings you have made.

Click to save the settings you have made and exit the program.

©W N oA WN

-
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* Each profile provides two DPI levels. Two DPI switch LEDs light up indicating that you are
using Level 1, and four LEDs light up indicating that you are using Level 2.
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Profile 1 menu

BUTIONSETTIN

Description
1 ‘Click to open the Edit menu and change the profile name and profile icon.
2 ‘Enter the desired profile name.
3 \Click to locate the image file you want to use as the profile icon.

Select the function for each button/action from the drop down list.

* Refer to the table below for more details.

Functions Description

L-Button Left mouse button function
R-Button Right mouse button function
M-Button Middle mouse button function

|IE Backward button function. If selected, press the button to go back to
the previous page.

IE Forward button function. If selected, press the button to go to the
next page.

|IE Backward

|IE Forward
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Functions Description

Keyboard

Macro

Script #1-6

DPI [+]

DPI [-]

DPI Level 1/2
Profile Switch
Normal Profile
User Profile 1/2/3

Wheel (left/right)

Rapid Fire (mouse)

Rapid Fire (key)

Web Browser
E-mail

Media Player
Play/Pause
Stop

Next Track
Prev Track
Volume Up/Down
Mute
Calculator
My Computer
Disabled

Press the button to perform a keystroke or keystroke sequence.

Press the button to run a command or series of commands that you
can edit via the Edit Macro menu. See Macro menu for details.

Press the button to run a script that you can edit via the Edit Script
menu. See Edit Script menu for details.

Press the button to increase the DPI value.

Press the button to decrease the DPI value.

Press the button to use the DPI Level 1/2.

Profile Switch button function.

Press the button to use the normal profille.

Press the button to use the customized profile 1/2/3.

Press the button to scroll leftward/rightward as a tilt wheel does.

7

Press the button to do a rapid fire in a click-to-attack game, which is
the same as triple clicking the left mouse button.

Press the button to do a rapid fire in a game using the spacebar to

This function only works for Microsoft® Office applications under
the Windows® 7/Vista operating systems.

attack, which is the same as pressing the keyboard’s spacebar thrice.

Press the button to launch your default web browser.
Press the button to launch your default e-mail application.
Press the button to launch your default media player.

These buttons become playback control buttons in an active media
player.

Press the button to increase/decrease the system volume.
Press the button to turn the volume’s mute mode on/off.
Press the button to launch the Calculator application.
Press the button to open My Computer window.

Select this item to deactivate the mouse’s selected button.
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Edit Macro menu

Edit Macro Click to open the Edit Macro menu.

Timing Check.this item to record the timel petween pressing down and
releasing a button. (Default: 12 milliseconds)

Insert When qhecked, thg new instruct!on will pe ingerted pefore thg seIeptgd
instruction. Otherwise, any new instruction will be given the first priority.

Start* Click to start recording the keystrokes and/or mouse actions.

Stop Click to stop recording the keystrokes and/or mouse actions.

Clear Click to clear all saved instructions.

Move up/down |Click to move up/down the selected instruction.

Instruction When Timing is unchecked, all the actions’ delay time will be the value

cycle time you chose from the drop down list.

Loop Sets the macro to run at a click and stop when clicked again.

Fire Sets the macro to run once in one click.

. Sets the macro to run when you hold down the button and stop when

Keeping fire you release the button.

Export Click to save the current macro to your hard disk drive.

Import Click to load a macro from your hard disk drive.
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Edit Script menu

ltems Description

Edit Script Click to open the Edit Script menu.

Timing Check_this item to record the time_ petween pressing down and
releasing a button. (Default: 12 milliseconds)

Insert When ghecked, thg new instruct!on will pe ingerted pefore thg selepte;d
instruction. Otherwise, any new instruction will be given the first priority.

Start Click to start recording the keystrokes and/or mouse actions.

Stop Click to stop recording the keystrokes and/or mouse actions.

Clear Click to clear all saved instructions.

Move up/down |Click to move up/down the selected instruction.

Instruction When Timing is unchecked, all the actions’ delay time will be the value

cycle time you chose from the drop down list.

Loop Sets the script to run at a click and stop when clicked again.

Fire Sets the script to run once in one click.

" Sets the script to run when you hold down the button and stop when

Keeping fire
you release the button.

Export Click to save the current script to your hard disk drive.

Import Click to load a script from your hard disk drive.
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Connecting to the Internet

Wired connection
Use an RJ-45 cable to connect your computer to a DSL/cable modem or a local area network
(LAN).

Connecting via a DSL/cable modem
To connect via a DSL/cable modem:

1. Set up your DSL/cable modem.

% Refer to the documentation that came with your DSL/cable modem.

2. Connect one end of an RJ-45 cable to the LAN (RJ-45) port on the rear panel of your
computer and the other end to a DSL/cable modem.

= 0O
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3. Turn on the DSL/cable modem and your computer.

4. Configure the necessary Internet connection settings.

% Contact your Internet Service Provider (ISP) for details or assistance in setting up your
“ Internet connection.
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Connecting via a local area network (LAN)
To connect via a LAN:

1. Connect one end of an RJ-45 cable to the LAN (RJ-45) port on the rear panel of your
computer and the other end to your LAN.

2. Turn on your computer.

3. Configure the necessary Internet connection settings.

/ Contact your network administrator for details or assistance in setting up your Internet
connection.
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Wireless connection (on selected models only)

Connect your computer to the Internet through a wireless connection.

R To establish a wireless connection, you need to connect to a wireless access point (AP).

To establish a wireless connection, use either of the following method:

D

OR
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/ + To increase the range and sensitivity of the wireless radio signal, connect the external
- antennas to the antenna connectors on the ASUS WLAN Card.

Place the antennas on the top of your computer for the best wireless performance.

+ The external antennas are optional items.

To connect to a wireless network:

1. Click the network icon n in the notification area to display the available wireless
networks.

2. Select the wireless network that you want to connect to, then click Connect.

3. You may need to key in the network security key for a secured wireless network, then
click OK.

4. Wait while your computer is connecting to the wireless network.

The wireless connection is established successfully. The connection status is displayed
and the network icon displays the connected status.
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Using the utilities

% The Support DVD and Recovery DVD may not be included in the package. You may use
the Recovery Partition feature to create the Support DVD and Recovery DVD. For details,
refer to Recovering your system in this chapter.

ASUS Al Suite Il

ASUS Al Suite Il is an all-in-one interface that integrates several ASUS utilities and allows
users to launch and operate these utilities simultaneously.

Using Al Suite Il

Al Suite Il automatically starts when you enter the Windows® operating system. The Al Suite
Ilicon appears in the Windows® notification area. Click the icon to open the Al Suite Il main
menu bar.

Click each button to select and launch a utility, to monitor the system, to update the
motherboard BIOS, to display the system information, and to customize the settings of Al
Suite II.

Click to show the ASUS
support information

Click to select a utility Click to update the

motherboard BIOS

Click to monitor sensors Click to show the Click to customize
or CPU frequency system information the interface settings

R + The applications in the Tool menu vary with models.

+ The screenshots of Al Suite Il in this user manual are for reference only. The actual
screenshots vary with models.
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The Tool menu
The Tool menu includes the System Level Up, Probe I, Sensor Recorder, and Ai Charger+.

System Level Up

System Level Up allows you to overclock the system in Windows® environment using the
profile settings.

To launch System Level up, click Tool > System Level Up on the Al Suite Il menu bar.

In setting the function, assign the hot keys for the system level up profile exchange. You can
adjust the hot key settings manually. See figure below for details.

Adjust the System Level Up via two methods:

BIOS

In the BIOS Setup program, click Al Tweaker > System Level Up, and select your desired
option.

OC Button
Press the OC button on the upper left side corner of the front panel.
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Launching and configuring Probe II

Probe Il is a utility that monitors the computer’s vital components, and detects and alerts you
of any problem with these components. Probe Il senses fan rotations, CPU temperature,
and system voltages, among others. With this utility, you are assured that your computer is
always at a healthy operating condition.

To launch Probe II:

Click Tool > Probe Il on the Al Suite Il main menu bar.

To configure Probe II:

Click the Voltage/Temperature/Fan Speed tabs to activate the sensors or to adjust the
sensor threshold values.

The Preference tab allows you to customize the time interval of sensor alerts, or
change the temperature unit.

Saves your
configuration
Loads the default Applies your changes
Loads your saved threshold values for
configuration each sensor
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Launching and configuring Sensor Recorder

Sensor Recorder allows you to monitor the changes in the system voltage, temperature, and
fan speed, as well as recording the changes.

To launch Sensor Recorder:

. Click Tool > Sensor Recorder on the Al Suite Il main menu bar.

To configure Sensor Recorder:

. Click the Voltage/Temperature/Fan Speed tabs and select the sensors that you want
to monitor.

. The History Record tab allows you to record the changes in the sensors that you
enable.

Select the
sensors that you
want to monitor

Drag to view the
status during a
certain period
of time

Click to zoom infout

Click to return to !
- the Y axis

the default mode Click to zoom in/out

the X axis
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Launching and configuring Ai Charger+

Ai Charger+, a unique and fast-charging software, allows you to charge your BC 1.1*

mobile devices on your computer’s USB port three times faster than the standard USB
devices™*.

/ + Ai Charger+ is available only on USB 3.0 ports and starts when your PC is in SO State.

Ai Charger+ helps charge the connected USB devices even when your PC is in S3/S4/
S5 States after it starts in SO State.

R + * Check your USB device manufacturer if it fully supports the BC 1.1 function.
+ ™ The actual charging speed may vary with your USB device’s conditions.

+  Ensure to remove and reconnect your USB device after enabling or disabling
Ai Charger+ to ensure normal charging function.

To launch Ai Charger+, click Tool > Ai Charger+ on the Al Suite || main menu bar.

Al Charger+
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The Monitor menu

The Monitor menu includes the Sensor and CPU
Frequency panels.

Launching Sensor

The Sensor panel displays the current value of a system sensor such as fan rotation, CPU
temperature, and voltages.

To launch Sensor:

. Click Monitor > Sensor on the Al Suite Il main menu bar.

Launching CPU Frequency
The CPU Frequency panel displays the current CPU frequency and CPU usage.

To launch CPU frequency:

. Click Monitor > CPU Frequency on the Al Suite Il main menu bar.

Resident in the right pane (system information area) Sensor panel CPU Frequency panel
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The Update menu

The Update menu allows you to update the motherboard
BIOS and the BIOS boot logo with the ASUS designed update
utilities

ASUS Update
The ASUS Update is a utility that allows you to manage, save, and update the motherboard
BIOS in Windows® OS. The ASUS Update utility allows you to update the BIOS directly
from the Internet, download the latest BIOS file from the Internet, update the BIOS from an
updated BIOS file, save the current BIOS file or view the BIOS version information.

Updating the BIOS through the Internet
To update the BIOS through the Internet:

1. From the ASUS Update screen, select
Update BIOS from file, then click Next.

2. Select the ASUS FTP site nearest you
to avoid network traffic.

Tick the two items if you want to enable
the BIOS downgradable and Auto-BIOS
backup functions.

3. Select the BIOS version that you want
to download, then click Next.

When no updated version is detected,
a message is displayed informing you
that there is no new BIOS file from
the BIOS server.
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4.  Click Yes if you want to change the boot
logo, which is the image appearing on
screen during the Power-On Self-Tests
(POST). Otherwise, click No.

5. Follow the onscreen instructions to
complete the update process.

Updating the BIOS through a BIOS file
To update the BIOS through a BIOS file:

1. From the ASUS Update screen, select
Update BIOS from file, then click Next.

2. Locate the BIOS file from the Open
window, click Open, and click Next.

3. Click Yes if you want to change the boot
logo, which is the image appearing on
screen during the Power-On Self-Tests
(POST). Otherwise, click No.

4, Follow the onscreen instructions to
complete the update process.
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The System Information screen

The System Information screen displays the information about
the motherboard, CPU, and memory slots.

. Click the MB tab to see the details on
the motherboard manufacturer, product
name, version, and BIOS.

Click the CPU tab to see the details on
the processor and the Cache.

Click the Memory tab and then select
the memory slot to see the details on
the memory module installed on the
corresponding slot.
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. Click the Disk tab and then select each
disk to see the details on it.

The Support screen

The Support screen displays the information
about the ASUS website, technical support
website, download support website, or contact

The Settings screen

The Settings screen allows you to customize the main menu

bar settings and the interface’s skin.

. Application allows you to select the application that you want to enable.

. Bar allows you to modify the bar setting,

. Skin allows you to customize the interface’s contrast, brightness, saturation, hue, and
gamma.
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ASUS Al Manager

ASUS Al Manager is a utility which gives you quick and easy access to frequently-used
applications.

Launching Al Manager
To launch the Al Manager from the Windows® desktop, click Start > All Programs > ASUS >
Al Manager > Al Manager 1.xx.xx. The Al Manager quick bar appears on the desktop.

Right-click this icon to switch between the quick bar and the
main window, and to launch the Al Manager either from the
quick bar or taskbar.

Switch to Quick Bar
Switch to Main Window

Start at Quick Bar
v Start at ToolBar

Exit
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Al Manager quick bar

The Al Manager quick bar saves the desktop space and allows you to launch the ASUS
utilities or display system information easily. Click any of the Main, My Favorites, Support or
Information tab to display the menu’s contents.

—

Main

Exit button
Switch to main Window
Add to ToolBar

Support
My Favorites Information

Click the Maximize/restore button I to switch between full window and quick bar. Click the
Minimize button B2 to keep the Al Manager on the taskbar. Click the Close button B quit
the Al Manager.

Main

The Main menu contains three utilities: Al Disk, Al Security, and Al Booting. Click the arrow
on the Main menu icon to browse through the utilities in the main menu.

il = © @ &

Click to extend or restore

Al Disk

Al Disk allows you to easily clear temporary IE files, |E cookies, IE URLs, IE history,
or the Recycle Bin. Click the Al Disk icon on the quick bar to display the full Al Disk
window and select the items you want to clear. Click Apply when done.
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Al rit)
Al Security enables you to set a password to secure your devices, such as USB flash
disks and CD/DVD disks, from unauthorized access.

To lock a device:

1. When using Al Security for the first time, you are asked to set a password. Key in
a password with at most 20 alphanumeric characters.

2. Confirm the password.
Key in the password hint (recommended).
When done, click Ok.
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Select the device you want to lock, then click Apply.
Key in the password you have set previously, then click Ok.
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To unlock the device:
1. Deselect the locked device, then click Apply.

2. Key in the password you have set previously, then click Ok.

To change the password:

+  Click Change Password, then follow the onscreen instructions to change
password.
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Al Booting
Al Booting allows you to specify the boot device priority sequence.
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To specify the boot sequence:

1. Select a device, then click the left/right button to specify the boot sequence.
2. When done, press Apply.

My Favorites

My Favorites allows you to add applications that you frequently use, saving you from
searching for the applications throughout your computer.
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To add an application:

1. Click Add, then locate the application you want to add to My Favorites.
2. Click Open on the file location window. The application is added to My Favorites list.

Right click on the application icon to launch, delete, or rename the selected application. You
can also double click to launch the selected application.
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Support

Click any links on the Support window to go to the ASUS website, technical support website,
download support website, or contact information.
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Information

Click the tab on the Information window to see the detailed information about your system,
motherboard, CPU, BIOS, installed device(s), and memory.

—

@
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Nero 9

Nero 9 allows you to create, copy, burn, edit, share, and update different kinds of data.
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Installing Nero 9
To install Nero 9:

1. Insert the Nero 9 DVD into your optical drive.
2. If Autorun is enabled, the main menu appears automatically.

% If Autorun is disabled, double-click the SeupX.exe file from the main directory of your Nero
9 DVD.

3. From the main menu, click Nero 9 Essentials.
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4. Select the language you want to use for Installation Wizard. Click Next.
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7. Select Typical then click Next.
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8.  Tick Yes, | want to help by sending anonymous application data to Nero then click
Next.

9. When done, click Exit.

P
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Burning files
To burn files:

1. From the main menu, click Data Burning > Add.
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2. Select the files that you want to burn. When done, click Add.
b i el Sk ——
m;rnm - = ) B
g e b s o
[ o
- 1::':._ Ja - )
=
e, | E
w DT iDn Py :::1-1-..51:
I
Toa ramay I B ) !
o o |
ASUS CG8580

7



3. After selecting files that you want to burn, click Burn to burn the files to a disc.
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% For more details about using Nero 9, refer to the Nero website at www.nero.com
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Recovering your system

Using the Recovery Partition

The Recovery Partition quickly restores your Desktop PC’s software to its original working
state. Before using the Recovery Partition, copy your data files (such as Outlook PST files)
to USB storage devices or to a network drive and make note of any customized configuration
settings (such as network settings).

About the Recovery Partition

The Recovery Partition is a reserved space on your hard disk drive used to restore the
operating system, drivers, and utilities installed on your Desktop PC at the factory.

R DO NOT delete the partition named g T —
RECOVERY. The Recovery Partition . = =
is created at the factory and cannot be =5
restored if deleted. Take your Desktop
PC to an authorized ASUS service
center if you have problems with the T |
recovery process. e

Using the Recovery Partition:
1. Press <F9> during bootup.
2. Press <Enter> to select Windows Setup [EMS Enabled].
3. Select one of the following recovery options.
System Recovery:
This feature allows you to restore the system to the factory default settings.

System Image Backup:

This feature allows you to burn the system image backup in DVD discs, which you can use
later to restore the system to its default settings.

System DVD Backup:
This feature allows you to make a backup copy of the support DVD.

4. Follow the onscreen instructions to complete the recovery process.

/ Visit the ASUS website at www.asus.com for updated drivers and utilities.
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Using the Recovery DVD (on selected models)

Prepare 1~3 blank writable DVDs as instructed to create the Recovery DVD.

Remove the external hard disk drive before performing system recovery on your Desktop
PC. According to Microsoft, you may lose important data because of setting up Windows on
the wrong disk drive or formatting the incorrect drive partition.

7
AEN

To use the Recovery DVD:

1. Insert the Recovery DVD into the optical drive. Your Desktop PC needs to be powered
ON.

2. Restart the Desktop PC and press <F8> on bootup and select the optical drive (may be
labeled as “CD/DVD”) and press <Enter> to boot from the Recovery DVD.

Select OK to start to restore the image.

4. Select OK to confirm the system recovery.

R Restoring will overwrite your hard drive. Ensure to back up all your important data before
the system recovery.

5. Follow the onscreen instructions to complete the recovery process.

g DO NOT remove the Recovery disc, unless instructed to do so, during the recovery process
or else your partitions will be unusable.

/ Visit the ASUS website at www.asus.com for updated drivers and utilities.
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Introduction to Intel® 2012 Desktop responsiveness
technologies

This document details the overview of the installation and configuration procedures of the
Intel® 2012 Desktop responsiveness technologies.

Intel® 2012 Desktop responsiveness technologies feature the three technologies:

Intel® Smart Response Technology
Intel® Rapid Start Technology

Intel® Smart Connect Technology

System Requirements for Intel® 2012 Desktop responsiveness
technologies

In order for the system to run smoothly for the Intel® 2012 Desktop responsiveness, you must
meet the following requirements:

1. CPU: Intel® 3rd/2nd generation Core Processor family

2. 0S: Windows® 7 operating systems

3. SSD: One dedicated SSD (Solid State Disk) to support Intel® Smart Response and
Intel ® Rapid Start Technology is necessary.

% Refer to the SSD Capacity Requirements table for the information of SSD size, partition
capacity, and system memory requirements.

4. HDD:  Atleast one HDD (Hard Disk Drive) for the system OS drive.

5. DRAM: To enable Intel® Rapid Start Technology, DRAM size smaller than 8GB is
required.

Ensure to enable the acceleration of Intel® Smart Response Technology before
creating the partition for the Intel® Rapid Start Technology.

"‘
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SSD Capacity Requirements

SSD Partition Capacity System DRAM
Requirements 4GB

‘ Intel® Rapid Start 2GB 4GB

8GB
‘ Intel® Smart Response 20GB 20GB 20GB

Separate 20GB Separate Separate
Intel® Smart Response and 2GB 20GB and 4GB = 20GB and 8GB
and partition partition partition
Intel® Rapid Start (SSD size > (SSD size > (SSD size >
22GB) 24GB) 28GB)

Separate Separate 20GB

®
NCRETEEES O EE  Separate 20GB 20GB and 4GB and 8GB

Intel® Rapid Start, and 2GB partition

Intel® storage combinations

) partition partition
Intel® Sm:r:'(tjConnect (SSZEZ)GSII;)e g (SSD size > (SSD size >
24GB) 28GB)
R +  The SSD used for Intel® Rapid Start and Intel® Smart Response is not allowed for
creating RAID.

+  Due to OS behavior, Intel® Rapid Start Technology works inefficiently with over 4G
system memory under Windows® 7 32-bit operating system.

+ Only Intel® internal SATA ports (gray and blue) support Intel® 2012 Desktop
responsiveness technologies.

+  The performance of Intel® Smart Response Technology and Intel® Rapid Storage
Technology vary by the installed SSD.
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Intel® Smart Response Technology

Intel® Smart Response Technology boosts overall system performance. It uses an installed
fast SSD (min. 20GB available) as a cache for frequently accessed operations, speeding up
hard drive/main memory interaction. Key benefits are expedited hard drive speeds, reduced
load and wait times, and maximized storage utilization. Power consumption also goes down
by reducing unnecessary hard drive spin.

Before applying Intel® Smart Response Technology, setting the SATA Mode BIOS item to
[RAID mode] in BIOS setup is necessary.

Installing Intel® Smart Response Technology

1. Place the support DVD to the optical drive. The Drivers installation tab appears if your
computer has enabled the Autorun feature.

2.  Click the Drivers tab, then click Intel® Rapid Storage Technology Driver software.
3.  Follow the onscreen instructions to complete the installation.

Using the Intel® Smart Response Technology

1.  Click Accelerate to launch Smart
Response Technology settings.

2. a. Select the SSD you want to use to
accelerate your storage system.
b. Select the size allocated for SSD
caching.
. Select which HDD for caching.
d. Enhanced mode: WRITE THROUGH,
write to SSD and HDD at the same

time. b g
Maximized mode: WRITE BACK, write

to SSD and write back to HDD in a later I
time. -

o
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3. Select Disable Acceleration to disable | —1
this function, and select Change Mode to L |g iEl@
switch acceleration mode to Enhanced/ i —

Maximized. et i .

R + To enable Intel® Smart Response Technology, you need at least one SSD ( ZOGB) and
a HDD, and only one SSD can be assigned for caching.

+ If you want to restore the OS, go to BIOS Option ROM > Acceleration Optlons and
remove the Disks/Volume Acceleration to disable Intel® Smart Response Technology.
Refer to Chapter 4, section Installing Serial ATA hard disk for the entry of BIOS Option
ROM.

+ The maximum caching size on the SSD is 64GB. If it exceeds, the storage capacity left
out for caching can still be identified by the system for normal storage.

Intel® Rapid Start Technology

Intel® Rapid Start Technology allows you to quickly resume your computer from sleeping
mode. Saving your computer’s system memory to the configured SSD provides a faster
wake-up response time, but keeps the energy in a low profile.

+ Before applying Intel® Rapid Start Technology, go to Advanced Mode > Advanced >
R PCH Configuration in BIOS item, and enable Intel® Rapid Start Technology.
+  Ensure to follow the procedure Creating a partition precisely to enable the Intel
Rapid Start function. Error message appears if you install the Intel® Rapid Start Utility
before creating a partition.

Creating a partition

Ensure to backup your data before using the Microsoft partition tool. Incorrect
partitioning process will result to data loss.
Adjusting the DRAM to a high frequency will result to unstable system performance.

L)

1. Go to Start, right-click Computer > Manage > Disk Management.

2. Select the SSD that you want to create the partition.
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3. Right click the New Volume S ——

Mew Voleme [IX) Cpen

that you want to shrink from, 5947 G NTPS HINE
and select Shrink Volume. i [P Pt owel
Change Dvve Lester anal Putha
Fererat.
ek Wokamae.
Dbt okume

- S5
Help

4. If your SSD is not initialized and unformatted:
a. Right click the disk that you want to create the partition, and select Initialize.
b. Right click the unallocated volume, select New Simple Volume, and follow the
remaining steps.
Dk 1 I

JI—
£0000E 8000 GI}
Netisshred | Ussllocated

If your SSD is smaller than 64GB, and is set to Full disk capacity caching option for Intel®
Smart Response, you can not see any volume in the Disk Management. Ensure to set your
cache memory value of 18.6GB in Intel® Smart Response to allow enough capacity for the
Intel® Rapid Start partition.

cab)>
-

5. Key in the required partition Sk I v

size, and must be equal to .
the system DRAM memory o ot et 1 ) i
(1GB = 1024MB). Click 5w o weslatic shevk ece  ME i
Shrink. Erioe St et o moace o vk, WE Qe ]

Tt apy i tvre, v WG s
Go to Start > Control I Tiow carvet sk @ vekame berand T pors shar sy umsvete flies are ocmsd
Panel > System and A O, e A sl
Security > System, and '
check the DRAM size ot T e ke in Dok Mgt sl for e ksmugtion
information.

| St | et

The unallocated volume is = _____________|
allocated to the selected Hew Volume (D3}

disk 5152 GB MTFE B0 GE
) Healthy (Frimary Patition) Wrafiocated *
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6.  Tolaunch the disk partitioning tool, click Start > Programs > Accessories >
Command Prompt tool.

Type diskpart and press Enter.

8. In the diskpart prompt, type
list disk after DISKPART,
and press Enter. Select the
disk with the unallocated
volume by typing select
disk x (x = disk number), and
press Enter .

%/E +  The value “x” refers to a disk number where you created the unallocated partition.
Refer to step 5 for details about the unallocated disk space in the SSD.

9.  Type create partition
primary, and press Enter.

10.  After creating a primary
partition, type detail
disk, and press Enter
to view the details of the
partitioned disk.

11.  Select the RAW volume
which has the same size ISKPART > select volume 3

as the shrinked volume,
type select volume x

olume 3 is the szelected volume.

(x = number), and press ISEPART >
Enter to store the Intel®
Rapid Start partition.
% + The value “x” refers to a disk number where you want to create the store partition.
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12. Type set id=84 override, press Enter, and wait for the “shrinking process” until
the Disk Management utility identifies a new partition called Hibernation Partition.

I
800 GB
Healthyy (Hibernation Partit

ft

% The Hibernation Partition does not appear when you choose “GPT (GUID Partition Table
store type”. Ensure the “Unallocated” disappears from the volume, and a new partition is
identified.

13.  Reboot the system after creating the partition.

' The partition for Intel® Rapid Start Technology is incomplete if the computer is not rebooted,
M and this results to function failure of Intel® Rapid Start Technology.

Enabling and disabling the Intel® Rapid Start Technology under the 0OS

A& Install the Intel® Rapid Start Technology first from your support DVD in order to launch the
Intel® Rapid Start Manager.

After creating the partition, launch the Intel® Rapid Start Manager to enable or disable the
Intel® Rapid Start Technology.

1. Click the Show hidden icons arrow from the right
side of the task bar, and click Intel® Rapid Start
Technology Manager icon.
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2. Tick On in the Status field to enable the function, and click Save.

Select and click to enable
or disable the function

Intel® Rapid Start Technalagy Manager

Intel® Rapid 5tart Technology Manager

Status = E
Intel Rapid Start Technology © | @ On offt | ‘

. Hide Advanced Settings
Click to enable or
Advanced Settings

disable battery o
saving mode. This rtcal Battery © on 5 o ‘
function only applies

to notebooks. imer @ B0 o
10 Minutes
L] 120
Save | Cancel |

Click to enable or disable the timer. When enabled, move Click to save the Click to cancel the
the scroll bar to the desired time. When the system is settings made.  settings made.
idle for more than the time period you set, the system

automatically goes into the Intel® Rapid Start mode.

Default time is 10 minutes.

Recovering the partition

This procedure allows you to delete the Intel® Rapid Start Technology from your system, and
recover the partition you made for the Intel Rapid® Start Technology installation.

1. Run the Command Prompt tool.
2. Type diskpart and press Enter.

3.  Atthe diskpart prompt, type D15 KERRT >
list disk after DlSKPART, Diek EiE
and press Enter.

4.  Select the disk (SSD) where the TR RIS T
Intel® Rapid Start Technology
USRI NGO i=k 1 iz now the selected disk.
type select disk x
(x = number), and press Enter.

DISKPART >

% The value “x” refers to a disk number where you want to delete the store partition.
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5. Type list partition,
press Enter, and select the
partition where the Intel®
Rapid Start Technology is
installed by typing select
partition x (x = number),
and press Enter.

% The value “x” refers to a disk number where you want to delete the store partition.

6. Type delete partition override, and press Enter. The diskpart utility deletes
the selected partition

B.00 GO

Unalicsatad *

In the desktop, click Start, right-click Computer, and click Manage.

In the Computer Management window, fie— ]
click Disk Management, right click the e e

shrinked new volume, and select Extend Mapbdey (Feiumy Jpeiiion raizeated

Volume. D55 {

Crunge Dvive Luther mnd Patin

Pimwyp  Farmat
|

Thrark Vekurne

9.  Asthe Extend Volume Wizard appears, |
click Next.

il

Webroms bo Hhe Extend Wobums
wizard
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10. Click Next after selecting the default  [foioaa =
selected disk. -

3 OO S A T T8 I e e T

11.  Extend volume setup is completed. Click Finish to recover the Intel® Rapid Start
Technology partition.

12.  Reboot the system after deleting the partition.

13.  Go to Start > Control Panel > Programs > Programs and Features > to remove the
Intel® Rapid Start Manager for the complete deletion of Intel® Rapid Start Technology.

Intel® Smart Connect Technology

The Intel® Smart Connect Technology is a feature that provides the latest content updates
and energy efficiency to your computer’s platform.

Once installed and activated, the Intel® Smart Connect Technology periodically wakes up the
system from sleeping mode, performs user state gathering, and initiates re-entry to sleeping
mode to wake-up after a set time interval.

and Seesmic applications.

It is necessary to enable the items of the PCH Configuration in the BIOS before
applying the Intel® Smart Connect Technology. Go to Advanced Mode > Advanced
> PCH Configuration, and enable the Intel® Smart Connect Technology.

%f + Intel® Smart Connect Technology supports Windows® Live Mail, Microsoft Outlook,

Installing the Intel® Smart Connect Technology

1. Place the support DVD to the optical drive.

2. Go to Utilities, and click Intel® Smart Connect Technology.
3.  Asthe setup wizard appears, click Next to begin the setup.
4

Tick I accept the terms in the License Agreement, and click Next.
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5. Select all and click Next for Bl ot it Dot Tesheamgy 20 8 iy m—— |

e

= Pty o T e pmp

6.  Click Install to proceed the installation.

Click Yes to restart your system, and for the newly installed Intel® Smart Connect
Technology to take effect.

Using the Intel® Smart Connect Technology

desktop, and enter the applications, passwords.
Ensure that the internet is in connection when enabling the Intel® Smart Connect
Technology.

R +  Before the system goes to sleep mode, ensure to keep your applications on the

1.  Click Start > All Programs > Intel > Intel® Smart Connect Technology.
2. Inthe Basic tab, click Enable Updating. When enabled, the Advanced tab is available
for advanced function settings.

The Advanced tab is activated Click to view version
when updating is enabled information and help topics

Click to configure

the basic settings ="~ - Lea When updating is
Click to enable | enabled, click to
or disable the reset all settings

function v to default.
When the scroll bar
is activated, adjust l

the waking up time
period for Internet
data update.
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3.  Todisable the ot e e e I ¢

updating function, click o B i

Disable Updating. Cinae——] ey
Clicking this button s - T TN
automatically disables .
the configuration in the e b
Advanced tab. To reset T -
to defaults, click Reset

All to Defaults.

4. Inthe Advanced tab,
set up the schedule
during low power usage
time period for power :iﬁt;l)
saving. This setting only
applies to the assigned
time period.

5. In the Help tab, click About to view the feature’s version. Click Topics to learn more
about the Intel® Smart Connect Technology and its configuration.
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Troubleshooting

Troubleshooting

This chapter presents some problems you might encounter and the possible solutions.

? My computer cannot be powered on and the power LED on the front
panel does not light up

Check if your computer is properly connected.
. Check if the wall outlet is functioning.

. Check if the Power Supply Unit is switched on. Refer to the section Turning
your computer ON/OFF in Chapter 1.

? My computer hangs.

. Do the following to close the programs that are not responding:
1. Simultaneously press <Alt> + <Ctrl> + <Delete> keys on the keyboard,
then click Start Task Manager.
2. Click Applications tab.
3. Select the program that is not responding, then click End Task.

If the keyboard is not responding. Press and hold the Power button on the top
of your chassis until the computer shuts down. Then press the Power button
to turn it on.

? I cannot connect to a wireless nestwork using the ASUS WLAN Card
(on selected models only)?
Ensure that you enter the correct network security key for the wireless network
you want to connect to.
. Connect the external antennas (optional) to the antenna connectors on the

ASUS WLAN Card and place the antennas on the top of your computer
chassis for the best wireless performance.

?  The arrow keys on the number key pad are not working.

Check if the Number Lock LED is off. When the Number Lock LED is on,

the keys on the number key pad are used to input numbers only. Press the
Number Lock key to turn the LED off if you want to use the arrow keys on the
number key pad.
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No display on the monitor.

Check if the monitor is powered on.

Ensure that your monitor is properly connected to the video output port on
your computer.

If your computer comes with a discrete graphics card, ensure that you connect
your monitor to a video output port on the discrete graphics card.

Check if any of the pins on the monitor video connector is bent. If you discover
bent pins, replace the monitor video connector cable.

Check if your monitor is plugged to a power source properly.

Refer to the documentation that came with your monitor for more
troubleshooting information.

When using multiple monitors, only one monitor has display.

Ensure that the both monitors are powered on.

During POST, only the monitor connected to the VGA port has display. The
dual display function works only under Windows.

When a graphics card is installed on your computer, ensure that you connect
the monitors to the output port on the graphics card.

Check if the multiple displays settings are correct. Refer to section
Connecting multiple external displays in Chapter 3 for details.

My computer cannot detect my USB storage device.

The first time you connect your USB storage device to your computer,
Windows automatically installs a driver for it. Wait for a while and go to My
Computer to check if the USB storage device is detected.

Connect your USB storage device to another computer to test if the USB
storage device is broken or malfunctions.

I want to restore or undo changes to my computer’s system settings
without affecting my personal files or data.

The Windows® System Restore feature allows you to restore or undo changes
to your computer’s system settings without affecting your personal data such
as documents or photos. For more details, refer to the section Restoring your
system in Chapter 2.
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?  The picture on the HDTV is distorted.

It is caused by the different resolutions of your monitor and your HDTV. Adjust
the screen resolution to fit your HDTV. To change the screen resolution:

1. Do any of tbe following to open the Screen Resolution setting screen:

+ Click > Control Panel > Appearance and Personalization >
Display > Change display settings.

+ Right click anywhere on your Windows desktop. When the pop-up
menu appears, click Personalize > Display > Change display
settings.

2. Adjust the resolution. Refer to the documentation came with your HDTV
for the resolution.

3. Click Apply or OK. Then click Keep Changes on the confirmation
message.

? My speakers produce no sound.

Ensure that you connect your speakers to the Line out port (lime) on the front
panel or the rear panel.

. Check if your speak is connected to a electrical source and turned on.
Adjust your speakers’ volume.
Ensure that your computer’s system sounds are not Muted.
If it is muted, the volume icon is displayed as m . To enable the system
sounds, click m from the Windows notification area, then click 4 .
+  Ifitis not muted, click m and drag the slider to adjust the volume.

Connect your speakers to another computer to test if the speakers arer
working properly.

?  The DVD drive cannot read a disc.

. Check if the disc is placed with the label side facing up.

Check if the disc is centered in the tray, especially for the discs with
non-standard size or shape.

Check if the disc is scratched or damaged.

=)

The DVD drive eject button is not respond.

i -~ |
1. Click E > Computer.

2. Right-click et PORNENE o Click Eject from the menu.
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Power

Problem

No power
(The power
indicator is off)

Possible Cause

Incorrect power voltage

Action

+ If your computer has a power
voltage switch, set it to your area’s
power requirements.

+ Adjust the voltage settings. Ensure
that the power cord is unplugged
from the power outlet.

Your computer is not
turned on.

Press the power key on the front panel
to ensure that your computer is turned
on.

Your computer’s power
cord is not properly
connected.

+ Ensure that the power cord is
properly connected.

+ Use other compatible power cord.

PSU (Power supply unit)
problems

Please call our Call Center for repair.

Display

Problem

No display
output after
turning the
computer on
(Black screen)

Possible Cause

The signal cable is

not connected to the
correct VGA port on your
computer.

Action

+ Connect the signal cable to the
correct display port (onboard VGA or
discrete VGA port).

« If you are using a discrete VGA
card, connect the signal cable to the
discrete VGA port.

Signal cable problems

Try connecting to another monitor.

Chapter 7: Troubleshooting



LAN

Problem

Cannot access
the Internet

Possible Cause

The LAN cable is not
connected.

Action

Connect the LAN cable to your
computer.

LAN cable problems

Ensure the LAN LED is on. If not,
try another LAN cable. If it still does
not work, contact the ASUS service
center.

Your computer is not
properly connected to a
router or hub.

Ensure that your computer is properly
connected to a router or hub.

Network settings

Contact your Internet Service Provider
(ISP) for the correct LAN settings.

Problems caused by the
anti-virus software

Close the anti-virus software.

Driver problems

Reinstall the LAN driver

Audio
Problem Possible Cause Action
) + Refer to your computer’s user
Spealker or headphone is manual for the correct port.
connected to the wrong )
port. + Disconnect and reconnect the
speaker to your computer.
. Speaker or headphone Try using another speaker or
No Audio does not work. headphone.
The front and back audio Try both the front a_nd back auc_ilo
ports. If one port failed, check if the
ports do not work. : .
port is set to multi-channel.
Driver problems Reinstall the audio driver
ASUS CG8580
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System

Problem Possible Cause Action
Too many programs are
many prog Close some of the programs.
running.
System speed is + Use an anti-virus software to
too slow scan for viruses and repair your

Computer virus attack computer.

Reinstall the operating system.

Send the damaged hard disk

drive to ASUS Service Center for
servicing.

Replace with a new hard disk drive.

Hard disk drive failure

Replace with compatible memory
modules.

The system often | Memory module problems Remove the extra memory
hangs or freezes. modules that you have installed,
then try again.

There is not enough
air ventilation for your
computer.

Move your computer to an area with
better air flow.

Incompatible softwares are | Reinstall the OS and reinstall
installed. compatible softwares.
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CPU

Problem Possible Cause Action

It is normal. The fan runs on its
Your computer is booting full speed when the computer is

up. powering on. The fan slows down
after entering the OS.
T?to ntO|sy_ right The BIOS settings have Restore the BIOS to its default
after turning on been changed. settings.

the computer.

Update the BIOS to the latest
version. Visit the ASUS Support
site at http:/support.asus.com to
download the latest BIOS versions.

Old BIOS version

Ensure that you are using a
compatible or ASUS-recommended
CPU fan.

The CPU fan has been
replaced.

There is not enough
air ventilation for the
computer.

Ensure that your computer is

Computer is too working in an area with good air flow.

noisy when in use.

+ Update the BIOS.

The system temperature is |  If you know how to reinstall the
too high. motherboard, try to clean the inner
space of the chassis.

% If the problem still persists, refer to your Desktop PC’s warranty card and contact the ASUS
b Service Center. Visit the ASUS Support site at http:/support.asus.com for the service
center information.
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ASUS contact information

ASUSTeK COMPUTER INC.
Address

Telephone

Fax

E-mail

Web site

Technical Support
Telephone
Online support

15 Li-Te Road, Peitou, Taipei, Taiwan 11259
+886-2-2894-3447
+886-2-2890-7798
info@asus.com.tw
www.asus.com.tw

+86-21-38429911
support.asus.com

ASUS COMPUTER INTERNATIONAL (America)

Address
Telephone
Fax

Web site

Technical Support
Telephone

Support fax

Online support

800 Corporate Way, Fremont, CA 94539, USA
+1-510-739-3777

+1-510-608-4555

usa.asus.com

+1-812-282-2787
+1-812-284-0883
support.asus.com

ASUS COMPUTER GmbH (Germany and Austria)

Address

Fax

Web site
Online contact

Technical Support

Telephone (Component)

Telephone (System/Notebook/Eee/LCD)
Support Fax

Online support

Harkort Str. 21-23, D-40880 Ratingen, Germany
+49-2102-959911

www.asus.de

www.asus.de/sales

+49-1805-010923*
+49-1805-010920*
+49-2102-9599-11
support.asus.com

* EUR 0.14/minute from a German fixed landline; EUR 0.42/minute from a mobile

phone.

Manufacturer: ASUSTeK Computer Inc.

Address: No.150, LI-TE RD., PEITOU, TAIPEI 112,
TAIWAN

Authorised representative in ASUS Computer GmbH

Europe:

Address: HARKORT STR. 21-23, 40880 RATINGEN,
GERMANY
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Copyright © 2012 ASUSTeK Computer Inc. Bce npasa 3ampuuiensi.

ITro6ast yacTb 3TOro PYKOBOJICTBA, BKI0Yasi 0G0PY/I0BAHNE 1 MPOrPAMMHOE 00eCTIeyeHNe, OMMCAHHBIE B HEM, HE MOXKET
ObITb y0/IMpOBAHA, NEpejiana, Peo0Pa3oBaHa, COXPAHEHa B CHCTEME TOMCKa Wil IepEBeficHa Ha PYroit si3bIK B J1000i
(opMe i J0ObIMU CPEJICTBAMH, KPOME JIOKYMEHTALMH, XPAHSILLENCs IOKyNaTeNeM C LeJbi0 Pe3epBUPOBaHKs, Ge3
crerpaibHoro miackmerroro paspeniernsi ASUSTeK COMPUTER INC. (“ASUS™).

Tapanrusi npekpaiaercst ecan: (1)usnenie oTpeMOHTHPOBAHO, MOIM(HUIMPOBAHO WIN U3MEHEHO Ge3 MUCHMEHHOrO
paspetennst ASUS; (2)cepuilHblii HoMep U3eNHsl TOBPE3K/IEH, HePa300PUMB MO0 OTCYTCTBYET.

ASUS npejjoctaBiser laHHOE PYKOBOJCTBO "KaK ecTh' 6€3 rapaHTuu Jo6Oro THUMa, SBHO BbIPAKEHHON MIN
noupa3yme5aemoﬁ, BKJIKOYasl HESBHBIC FAPAHTUN UK YCJIOBUSA MOy YCHUSA KOMMCp‘lCCKOﬁ BbINO/IbI WJIM IIPUTO/ITHOCTH J1JIs
KOHerTHOﬁ LieJIi, HO HE OrPAHUYMBAACH STUMU FAPAHTUAMU U YCIIOBUSAMU. Hu TpU KakKnx 00CTOSATENLCTBAX KOMIAHUSI
ASUS, €€ QUPEKTOPA, TOKHOCTHBIC JINLA, CTY>XKALME UK ar€HTbl HE HECYT OTBETCTBEHHOCTH 34 no0ble KOCBEHHBIE,
CneyranbHbIC, CIIy‘ILi];’leIC W SABJIAIOLIAECS CJICICTBUEM 4ero-mdo y6bITKM (BKJIIO‘I'dﬂ y6bITKM 13-3a NOoTepU le/lﬁblﬂl/[,
norepn GU3Heca, NOTEPH [IAHHBIX, IPHOCTAHOBKH OM3HeCa 1 T.11.), Aaxke ec ASUS coo6immia 0 BO3MOXKHOCTH TaKHX
yGLITKOB, BO3HUKAKUIUX U3- 3a mo6oit HC)]OPEI6OTKVI WM OIIMOKY B JIAaHHOM PYKOBOJICTBE WJIH TIPOJTYKTE.

TexHuueckue XapakTePUCTHKN U CBEGHNUS, COAEPXKAIIMECS B JTAHHOM PYKOBOJICTBE, IIPE/ICTABIEHBI TONBKO ISt
MH(OPMATUBHOTO MCTIOJL30BAHUS, 1 MOTYT ObITh M3MEHEHBI B 000E BpeMsi 6€3 YBEJIOMIIECHUS, U HE JIOJKHBI OBITh
ucTonKoBaubl Kak o6s3atenbctBa ASUS. ASUS He Geper Ha ce0st HUKaKOi OTBETCTBEHHOCTH MM 005I3aTENBCTB 32
JTO0bIE OLIMOKM U1 HETOYHOCTH B JIAHHOM PYKOBOJICTBE, BKJIIOYAst H3/EIsl WM IPOrpaMMHOe o0ecrieueH1e, ONMCaHHbIe
B HEM.

npO}IyKTbl W Ha3BaHUsA KOpﬂOpal],Mﬁ, VMEIOLHECS B 3TOM PYKOBOJICTBE MOT'Y T SIBJIATBCS 3aPErMCTPUPOBAHHBIMU TOPTOBBIMI
3HAKaMH WM aBTOPCKUMM TpaBaMu COOTBETCTBYIOLIMX KOMIAHUI 1 HCTOJIB3YIOTCS TOJIBKO B LEJIAX MJZlCHTl/leI/IKaIMI/I.
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YBegomiienus

REACH

Cormacho pernamenty EC REACH (Registration, Evaluation, Authorization, and Restriction of
Chemicals — Peructpauus, Ouenka, Pasperenns n OrpaHuyeHus Ha MCTONb30BaHHE XUMUYECKUX
Bewect), Ha caiite ASUS REACH paswmelieH CNMCOK XWMHYECKMX BELIECTB CORCPXKALMXCS B
npopyktax ASUS: http://csr.asus.com/english/REACH.htm.

YnocroBepenne ®enepanbuoi Komuccnn mo cesizu CIHIA

Mantoe ycrpoiictBo cootBerctByeT yactu 15 [pasun FCC. Dkcnnmyarariyst 060pya0Banusi JOMyCTAMA
TIpy COOMIOAEHUHN CTIEIYIOLIMX YCIIOBHIA:

+  JlanHHOe yCTpOFCTBO HE JJOJIKHO CO3/{aBaTh NOMEX

. Ha pa60Ty yCTpOfICTBa MOT'yT OKa3bIBaThCSl BHEIIHME MOMEXHU, BKIIIOYAs TTOMEXHU, BbI3bIBAIOLINE
HEXKEJIATENbHBIE PEKUMbI €0 pa60T1>1.

JlanHoe o0OpyHOBaHHE ObLIO NMPOTECTUPOBAHO M COYTEHO COOTBETCTBYIOIIMM OIPAHIYEHISIM IO
mipoBbIM yeTpolicTBaM knacca B B cootserctBum ¢ yactbto 15 Ilpasun FCC. Otn orpaHnyeHust
PacCuUMTaHbl Ha OOECIevueHne 3alUThl B Pa3yMHbIX INpefielaX OT BPEJOHOCHBIX BO3AEHCTBUIl TpH
YCTAHOBKE B KIJIOM NoMelleHud. [laHHOe 000pyJ0BaHUE CO3AET, MCTOJBL3YET M MOXKET H3IyyaTh
SHEPIHIO B PAJUOAHANA30He, KOTOpasi, IPH yCTAHOBKE I UCTIONB30BAHUN JAHHOTO 060DPY/IOBAHHS HE B
COOTBETCTBUH C MHCTPYKLMSIMH IPOU3BOAMTEIIS, MOKET CO3/1aBaTh IOMEXH B pajiMocBsi3u. TeM He MeHee,
HEBO3MOXKHO TapaHTUPOBATb OTCYTCTBHE MOMEX B KaXK[OM KOHKPETHOM clTyuae. B ciryuae, eciu ganHoe
000py/IoBaHNe JIHCTBUTENLHO BbI3bIBAET TMOMEXHM B PAMO WJIM TEJEBU3MOHHOM MPHUEME, YTO MOXKHO
TIPOBEPHTb, BKJIIOUIB ¥ BBIKJIIOUNB AAHHOE 000PYA0BAHNE, OIb30BATENIO PEKOMEHIYEeTCsl OMbITATLCS
YJIAIIUTD OMEXH CNEIYFOLIMMU CPEAICTBAMMU:

+  IlepeopueHTUPOBATH WM NIEPEMECTUTD NPHHUMAIOLIYIO AHTEHHY.

*  YBeJIMYUTb PACCTOSHNE MEXKLY AAHHBIM IPUOOPOM U IPUEMHHUKOM.

+  TogkmounTs faHHOE 0OOPYJOBAHUE K PO3ETKE APYIOil 3MEKTPOLENH, HeXeNu Ta, K KOTOpOil
TIOKJTIOYEH IPUEMHUK.

+  ITIpoKOHCYJILTHPOBATHCS C MPOJABLIOM HITH KBATM(UIMPOBAHHBIM pajiio/ TB-TeXHIKOM.

k I/Icnonbsyﬁ're 9KPpaHMPOBAHHBIE Kabemu JUIA TIOAKITFOYEHNS MOHUTOPA K BUTICOKAPTE - 3TO TAPAHTUPYET
coBmecTuMocTb ¢ TpeboBannsMu FCC. M3MeHeHus WM JJONONHEHNs K JJAHHOMY NYHKTY, He
COIIaCOBAHHBIE, HEMOCPE/ICTBEHHO, CO CTOpOHOﬂ, OTBETCTBEHHOI 32 COOTBETCTBUE npaBuiam, MOTyT

CcaenaTh He]’(eﬁCTBI/ITSJ'ILHLIM TPaBO MOJIb30BATENA Ha TIOJIb30BAHNE TAHHBIM oGopynoBa}meM.

9
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TpeGoBaHusi 0 BO3AEHCTBHIO PAOYACTOTHI

310 060pY/0BAHNE AOKHO ObIT YCTAHOBJIEHO U PAGOTATD B COOTBETCTBUY C HHCTPYKLUSIMH, U AHTEHHBI,
HCTIOJIb3YeMble C 9TUM NepeflaTINKOM J0JDKHBI ObITH YCTAHOBJIEHbI HA paccTosiHUM He MeHee 20 cM oT
Jtofiefi 1 He JI0JKHBI ObITh PACTIONOXKEHbI PSIOM C IPYTUMU aHTeHHaMU WK NepefaTyikamul. KoHeunble
T0JIb30BaTEN JIOJKHBI CNEf0BaTh MHCTPYKLMSM MO 3KCIUTyaTaluu [l yMEHbIUEHUs BO3fieicTBUs
PaarovacTOTHOM SHEPTUM.

YnocroBepenue denapramenta no cpegcream cBsizu Kananoi

Tantoe uupoBoe YCTPOICTBO HE MPEBLILIACT OrpaHMYEHKsI Kilacca B 1o Bbiene o pajuouyma ot
UM(POBBIX YCTPOICTB, YCTAHOBICHHBIX B MPABWJIAX N0 PAIUONIOMEXaM JIEMAPTAMEHTA 110 CPEJICTBaM
cBsi3u Kanappl.

TanHoe uupoBoe ycTpoiicTBo Kiacca B cootserctsyer cranapry ICES-003.

Nudopmanus 06 uzneanu kopnopauun Macrovision

JlaHHOE M3Aenye BKIOYAeT B Ce0st TEXHOJNOTMIO 3alMThI aBTOPCKHX MpPaB, 3ALIMIICHHYIO MATEHTAMI
CIIA, 1 vHble MpaBa MHTEIIEKTYaJIbHOI COOCTBEHHOCTH, NPUHAIEXKale Koprnopauun Macrovision
¥ ApyruM JmiaM. Mcronb30BaHie JAHHON TEXHOJNOTHH 3aliThl aBTOPCKHX MPAB BO3MOXKHO TOJBKO C
coryacusi Kopnopaiyu Macrovision 1 IpefiycMOTPEHO TOJIBLKO i1t IOMAILTHET0 ¥ HHOTO OTPaHMYeHHOTo
HCTOJIb30BAHNS, €CIM MHOe He MpefmucaHo Kopmopauuein Macrovision. VmkeHepHbll aHamm3 u
pa3bopKa 3anpelueHbl.

JINTHEBO I AKKyMY.1TOp

BHUMAHUE: Ilpu 3ameHe aKKyMyJsiTopa BO3MOXEH B3pbIB. 3aMEHsITe akKyMyJssTopa
Ha TaKkoil e THI WM aHAJIOTOYHBIA, PEKOMEHJOBAHHDBIA NPOM3BOMNTENEM. Y TWIH3NDYITE
VCTIONB30BAHHbIE AKKYMYJISTOPbI B COOTBETCBUH C HHCTPYKIWMSMU POU3BOJUTEIS.

YTunnszauus u nepepadoTka

Komnanus ASUS Geper Ha ce0s 00s13aTenbeTBa N0 yTUIM3ALUU CTAporo 000pYIOBaHUS, UCXOAS U3
TIPUHLIMIOB BCECTOPOHHEH 3aLLUTHI OKPYKAKOLLEl Cpefibl. Mbl IPEOCTABIISeM PELICHHS HALINM KITHEHTaM
JUISt IepepaboTKM HAlIMX POAYKTOB, aKKyMYJISITOPOB 1 APYTHX KOMIOHEHTOB, a TaKKe YNaKoBKL. s
TIOJTyYeHNs! TOAPOGHOI MH(pOPMALIK 00 YTUIN3ALKH 1 [TepepaboTKe B PAa3INIHbIX PETHOHAX [TOCETUTE
http://csr.asus.com/english/Takeback.htm.



Wndopmauus o npaBuiax 6e30nacHOCTH

Tlepen oumcTKOI OTKITFOUNTE MUTAHUE U BCE MOAKIOYEHHbIE nepudepuitHbie ycTpoiictsa. ITporpute
TIOBEPXHOCTb KOMIBIOTEPA YNCTOI IyOKOI MM KYCOUKOM 3aMILIM, CMOYEHHOM B BOJIE MJTH HeaGpasuBHOM
YHCTSILEM CPEICTBE, 3aTeM Y/JAIINTE JIMLLIHION BIAry CyXOil TPSMKOIL.

+ HE ycranasmiBaiite yCTPOCTBO Ha HEPOBHYIO WM HEYCTOIUMBYIO MOBEPXHOCTb. B ciyuae
TIOBPE-KJICHIISI KOPITYCa, He BK/IIOYas yCTPOICTBO, 0OPATUTECH B CEPBHCHBIIT LIGHTP.

+  HE nomemaitre ycTpoiicTBO B MbUIBHYIO WM rpsiznyto cpeny. HE moms3yitrecs ycrpoiicTBoM BO
BpeMsl yTEUKHU rasa.

+ HE craBbre u He poHsiiiTe IpeMeThl Ha MOBEPXHOCTH KOMIBIOTEpPA 1 He 3aCOBLIBAITE B HErO
NIOCTOPOHHHE MPEAMEThL.

+  HE mnopgepraiite KOMIbIOTEp BO3AEHCTBIIO CHILHBIX MATHUTHBIX MM 3MEKTPHYECKIX TOJIEH.

*  HE nopsepraiite Bo3[ieiiCTBIIO KUIKOCTEH 1 HE UCTIONB3YITE B YCIIOBUSIX NOBBILLEHHO BIAXKHOCTH.
HE nomns3yittech MOfeMOM BO BpeMsi IPO3bL.

+  Tlpepynpexpenne 6esomacoctn: HE 6pocaiire akkymynsaTop B oronb. HE 3ambIkaiite KOHTaKTBI
akkymyssitopa. HE pazOupaiite akkymyssitop.
+  PekoMmeHpyercs ncrnonb3oBath npofykT npu Temneparype ot 0°C o 35°C.

+ HE He nepekpbIBaiiTe BEHTHIISLMOHHbIE OTBEPCTUSI KOMIBIOTEPA, TAK KK 3TO MOXET BbI3BATh
TeperpeB yCTpOHCTBa.

*  HE wucnons3yiite nospex/eHHble Kabelu, akceccyapbl U ipyrue nepucepuitHble yeTporicTsa.

e Jlns npefoTBpAIeHNs] NOPaXKEHUs 3NMEKTPUYECTBOM OTKIIOUUTE MHTaiolye Kabequ npu
TIepEMEILICHNN YCTPOICTBA.

o Ilpexpge ueM BOCHOIb30BATBCA AQNANTEPOM WM YANMHUTENEM, MPOKOHCYIbTHPYHTECH CO
CNeLMaICToM. DT! YCTPOICTBA MOTYT NPEPBATh KOHTYP 3a3eMIICHHS.

e Y06enurech, B TOM, YTO YCTAHOBKM HanpsbkeHust Bauero 61oka nuTaHust COOTBETCTBYIOT MECTHBIM
npaBuiam 1 HopMaTiBaM. Eciu Bbl He yBepeHbI B BeIMUMHE HANPSIKEHUs], CBSKUTECH ¢ Baieit
SHEPreTNYeCKOil KOMIaHUE.

»  Eciu anekTponuTaHue HEHCTIPABHO, HE MBITAATECH HANAMUTD €ro CaMOCTOSITENbHO. CBSXKUTECH C
MECTHOM CIly 60§ 00CITy>KUBAHUS.
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3H3'[KI/I, NCNO0JIb3yEMbIC B PYKOBO/ICTBE

B PYKOBOACTBE UMEIOTCA NPUMEYAHUA U NPEAYIPEXKICHNUSA, C KOTOPbIMU Bam HY>KHO O3HaKOMUTBCS IS
YCHEILIHOrO BbIMOTHEHHA 3aJa4.

) OINACHO/BHUMAHMUE: Uncpopmaryst 0 AefCTBISX, KOTOPbIE MOTYT PUBECTH K
é OBITOBBIM TPABMaM.

OCTOPOXHO: Huopmanps 0 AeiicTBUSIX, KOTOPbIE MOTYT NPUBECTH K MOBPEXKCHUIO
000py/IOBaHKSI.

camd>

k BAKHO: UncTpykuyi, KOTOpbIM BbI IOIKHBI CIIEI0BATH TIPH BBIONHEHHN 3aja4.

/ NMPUMEYAHUE: CoBeTbl 1 IONOHUTEbHAS MH(POPMALHSE [IJIs1 TTIOMOLLIH.

I'ne HaiiT Goabie MHGOPMaLUN

OGparuTech K CNEAYIOMMM KMCTOYHMKAM 3a JIOMONHUTENBHON MH(opMaiuein ¥ i OGHOBIEHUS
NPOrPaMMHOr0 0GecTieyeHH s

Caiitbl ASUS

Caitr  ASUS npefioctasisieT OGHOBNEHHYIO MH(OPMALMIO O MNPOAYKTaX U MPOrpaMMHOM
obecneyer ASUS. Ioceture caiir ASUS www.asus.com.

JlokanbHas TexHndeckas nopaepxka ASUS

Tocerure caitr  ASUS  http://support.asus.com/contact s NOMydYeHHs KOHTAKTHON
MHMOPMALKH JIOKALHOM TEXTOYIEPKKH.
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Hacrombasrit ITK ASUS Kommmnexr knasnarypst ASUS | Urposast mbis ASUS GX900

Essenti ROG U9N x1 x1
@ Y \nstahion Gude

PykoBOACTBO 10 yCTaHOBKE
x1

lnyp nuranms x1

=

TapanTuiiHbIi TaI0H X1 Support DVD x1 Recovery DVD x1 (omuust)

NN

BbiHocHast aHTenHa x 1 Anrenna x1 (onwyst)

/ + Bcmm Kakue-nm60 aneMeHTbI KOMIIEKTa IOCTaBKM OTCYTCTBYIOT I NOBPEXJIEHbI, 00paTUTeCh K
- TpojiaBLLy.

. I/Iﬂﬂ}OCT'palll/I" TPENCTABJICHbI TOJIBKO JIJIS CIIPABKH. C]']CI.U/IClJVIKaL[VH/I TPOYKTa MOXKET OTIINYIATBCSA
B 3aBUCUMOCTH OT MOJICJIH.

*  TlonpoGHyto nHopMALTIO N0 HCTIOTb30BAHMIO NOCTABIISEMbIX B KOMILIEKTE KIABUATYPbI M MBI
cMotpurte B pasienax Menonb3osanue kinasuatypsl ASUS ROG UIN u Hcnosb3oBanue Mbiwin
ASUS GX900.
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Hauano padotsl

Jlo6po noxanosats!

Brarogapum Bac 3a npuo6perenne HactonbHoro ITK ASUS Essentio CG8580!

Hacrombhpiit  IIK  ASUS  Essentio CG8580 oGecrneunBaerT BBICOKYIO —MPOU3BOAMTENBHOCTS,
GECKOMIIPOMICCHYH HaJIEKHOCTL U ODUEHTHPOBAH HA [MOJb30BaTeNs. Bce 9TO MOMEWIEHO B
(byTypUCTHYECKHMIT 1 CTHIIBHBII KOPITYC.

R Tlepen ycranoskoit HactosbHOro ITK npoynTaiite rapaHTHIAHbIN TaloH.

3HAKOMCTBO C KOMIBIOTEPOM

% I/I.TUIIOCTpaHl/H/l TOJIbKO [IJIsl CIIPABKH. HOprI M HUX PACMOJIOKEHUE MOXKET U3MEHATBLCS B 3aBUCUMOCTH
A OT MOJIE/TH.

Iepepusist naness Q ? (11712)
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ASUS CG8580
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10.

11.
12.

Knonka nutanns. Haxxmute 9Ty KHOIKY A1l BKIIIOYEHUS] KOMIIBIOTEPA.

Cnor mst kapt namsitu Secure Digital™ / MultiMedia. Crofa BecTaBisitoTcst KapThl Mamsiti
Secure Digital™ niu MultiMedia.

OTcek ONTHYECKOT0 MPUBOJA. B 9TOM OTCEKE YCTAHOBIEH ONTUYECKUIT PUBOJ.
Orcek xecTKOro aucka (mycroit). I1o3BosisieT yCTaHOBUTD JOMONHUTEIBHBIIT KECTKUII UCK.
Nnpukarop muranusi. DTOT MHIMKATOP 3ar0paeTcsl Y BKIOUESHNH KOMITLIOTEpA.

Cnor pist kapt namsitu Stick™ / Memory Stick Pro™. Crofia BCTaBsitoTcst KapThl MaMsITH
Memory Stick™ / Memory Stick Pro™.

Cnor post kapt namstn CompactFlash / Microdrive™, Croga BcTaBaIsFOTCSI KapThl AMSITH
CompactFlash / Microdrive™.

Knonka OC. Jra kHonka HacTpauBaeT npocuib Bamrero komnetorepa.

Ioprer USB 3.0. Tonkimouenne USB-ycTpoilcTB HampuMep, KiIaBHaTypbl, MBILIHN, TPUHTEPA,
ckatepa, PDA u ipyrux ycTpoficTs.

+ HE nopmovaitre knasuatypy / Mbitib K opty USB 3.0 npu ycraHoBKe onepaiyioHHOl CHCTEMbI
Windows.

« Ycrpoiiersa USB 3.0 MoryT 6biTh ncnonb3oBatbi B OC Windows ToIbKO Tociie yCTaHOBKH fpaiiBepa
USB 3.0.

+ Yerpoitcrsa USB 3.0 MoryT GbITh HCTIOB30BAHbI TOBKO B KAYECTBE YCTPOICTB XPAHEHHS.

«  JInisi onmyyenust BbICOKOiA pou3BojTenbHocTH yerpoiicts USB 3.0, MbI HACTOSITEITBHO peKOMEH]TyeM
nofikmoyarh ux K nopram USB 3.0.

Iopter USB 2.0. Tlopkimouenne USB-ycTpoilcTB HanpuMep, KiIaBHaTypbl, MBILIHX, IPUHTEpA,
ckatepa, PDA u ipyrux ycTpoficTs.

Pa3znem Mukpodona. INoxxmouenye MEKpogoHa.

Paznem HAyUIHUKOB. HOJIKJI}O‘-IGHVIC HayILIHNKOB WJIA KOJIOHOK.
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1. Iopter USB 3.0 noppepxusator pexxum ASUS USB 3.0 Boost UASP. Topximouenue USB-
YCTPOJICTB HanpuUMep, KIIaBUaTypbl, MbILLK, IPUHTEPA, CKanepa, PDA u ipyrux ycTpoiicTs.

/ Moptsi USB 3.0 nogpepskusatotcs Tonbko Windows 7 imi 6ozee Hobix Bepeusix. ITporokon UASP
a nojyiepxusaercst Tobko Windows 8.

« HE nopkmoyaiire kiasuatypy / Mbitib K topty USB 3.0 npu ycraHoBKe OnepaiyioHHOl CHCTEMBI
Windows.

« Ycrpoiiersa USB 3.0 MoryT GbiTh ncnonb3osatbi B OC Windows ToIbKO 1ociie yCTaHOBKH fpaiiBepa
USB 3.0.

* Yerpoitcrsa USB 3.0 MoryT GbITh HCTIONB30BAHbI TOBKO B KAYECTBE YCTPOICTB XPAHEHHS.
*  JInsi nomyyeHnst BICOKOIt Npon3BojuTessHocTH yerpoiicTs USB 3.0, Mbl HACTOSTEBHO PEKOMEHTyeM

nofikmoyath ux K nopram USB 3.0.

2. Iopter USB 2.0. [opkmrouerne USB-ycTpolicTB HampuMep, KIaBUATYpBI, MbIILIH, IPHHTEPA,
ckanepa, PDA u ipyrux ycTporicTs.

3. Kapra ASUS Wi-Fi Go! (Wi-Fi 802.11). [Tojk/oueHye BHIHOCHON aHTEHHBI.
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4. DisplayPort. TTopkirouennst MOHITOPA WITH IOMALIHETO KUHOTEATPA.

5. Paznem DVI-D. Sror nopr npeHasHaueH st nopkmouenns K modomy DVI-D-coBmecTimomy

* IHQMKaTopbl 0eCIIPOBOJIHON CETH

Cocrosinne Onucanue

Otk Her coepunenust
3eneHblil TopkmroueHo
% Kapra ASUS Wi-Fi Go! aBToMaTiyecKi yCTAHOBUT JOCTYTIHbIE JUTSl CTPAHbI KaHAIbI.

YCTPOJCTBY 1 MO3BOJISIET BOCTIpou3BoAnTh cofiepxkumoe HD DVD u Blu-Ray.

6. Iopter USB 3.0 noapepxkusaot pexkum ASUS USB 3.0 Boost UASP. Huxumit mopr
noapepxusaer USB BIOS Flashback.

7. Brixon Ha GokoBbIe KOJTOHKH (cepbiit). Ciojia NOAKIHOYATCsl GOKOBbIE KOJIOHKH 8-KaHAIILHOI
ayMOCHCTEMBI.

8. Boixog Ha ThLTOBBIE KOJMIOHKH (YepHbiit). Ciofla MOIKITFOYAIOTCS ThUIOBbIE KOJIOHKH 4, 6 1 8-
KaHANBHBIX ay[IMOCHCTEM.

9. Boixon Ha neHTpasbHbI KaHan/caoBydep (opanxkeBbiit). Cofia MOKIIOUAIOTCS LEHTPATbHbIE
KOJIOHKHM/cabByep.

10. Pasnem mMukpocona (po3oBblii). [logkiroyeHre MUKpodoHa.

11.  AypuoBsixop (canaroBsiit). [lofkoueHne HAYIHUKOB WTH KOJTOHOK. B 4, 6 i 8-kaHanbHO#
KOH(PUTY ALK 3TOT PA3bEM CTAHOBUTCS BHIXOJIOM Ha (DPOHTAJIbHBIE KOJIOHKH.

12.  Aypmosxop (romy6oii). K aromy pasbemy MOXHO nofkiounts Maraurogod, CD, DVD nieep
VI JIPYrHe HCTOYHNKH 3BYKA.

13.  BeHTHISALMOHHBIE OTBEPCTHSI. BEHTHISLMOHHbIE OTBEPCTHS NPEHA3HAYCHBI TS OXJIAXK/ICHUS
yCTpOJiCcTBa.

/ DyHKIMM ayMOPa3beMOB ISl Pa3IMYHbIX KOH(UTYpaLyil CMOTPUTE B TaGJIMLE HIKE.

2, 4, 6 nim 8-kaHaIbHAA KOH(UTypauus

Haymmankn
Iopt Y annel 6-channel 8-channel
2-kaHana
Tony6oit Aymuosxon Aymmosxon Aymmosxon Aynnosxon
. Bbixof Ha (hpoHTAIbHBIE Bbixof Ha (ppoHTAIbHBIE Boixop Ha
Canaroblit AyJHOBBIXOL i dp i dp "
KOJIOHKH KOJIOHKH (DpOHTAIIbHBIE KONOHKH
Po3oBblit Mic In Mic In Mic In Mic In
. [CHTpaMIbHAST KOMOHKA/ eHTpasbHAs KONOHKa/
OparxkeBblit - _ enp: Lientp:
cabByep cabBycep
ephmit BbIX0J1 Ha ThIIOBbIE BbIX0J1 Ha ThIIOBbIE BbIxof1 Ha ThLIOBbIE
P KOJIOHKH KOJIOHKH KOJOHKI
N Boixoy Ha GOKOBbIE
Cepsiit - - -
KOJIOHKH
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14.
15.
16.

17.

18.

19.

20.

21.

22.

23.

He Gnokupyiite BEHTHISLMOHHbIE OTBEPCTHS Ha Kopryce. Beerjia obecneuusaiite He0OXouMyi0
BEHTWIALUIO 111 KOMIIBIOTEPA.

Knonka nuranus. Bkmouenne/0TKITIOUeHNe KOMITBIOTEPA.
Pazbem nuranus. [Tojkiounte K 3TOMy pazbeMy LIHYP MATAHUS.

KomounupoBannbiii nopt PS/2 knaBuatypa/Mpimib. DTOT [OPT TpefHA3HAYSH ISt
TOJIKITF0YeHIst PS/2 MBIl i KiaBuatypsl.

Ontuyeckuit S/PDIF Out. K stomy noprty mopkioyaiotest UupoBble ayuoyCTpOHACTBa ¢
nomotipio onruyeckoro S/PDIF kabesst.

Paszsem HDMI. Dtor nopt npejiHazHayeH jisl NOJKMIOUEHHs K MOHUTODY WM TEJNEBU30DY U
no3BoJIsieT Bocnpoun3BoauTh cofiepxkumoe HD DVD u Blu-Ray.

Pazsem VGA. 1o paszsem s nopkitouernst VGA-COBMECTHMBIX yCTpoiicTs, Hanpumep VGA
MOHHTOPA.

Pazpem LAN . D10 pasbem st NOAKIIOUCHNS K JIOKabHol cetit (LAN).

Mupukaropsl LAN nopra Mumkarop  Mugukatop
AKTHBHOCTH CKOpoCTH
HMupukarop akTieHocTH Mngukarop ckopocti | |
BBIKJT Her coejunenust BBIKII ' 10M6ur/c nogkmoueHue
OPAHXEBBII ‘ ToaxkmoueHo ‘ ‘ 100M6wuT/c nogxkoueHne
MUTAET ‘ Tepejaua JaHHbIX ‘ 3EJIEHBIN ‘ 1I6ut/c nojkmoyeHe
Pazpem LAN

Ayanopasbemsl (cheMHbIe). K 9THM pazbeMaM MOAKIIOYAIOTCS ayUOYCTPOIICTBA, HalpiMep
MUKPO(OH, HAYIIHUKY U KOJIOHKIL.

JTuckperHasi BUieoKapTa (TOJIbKO Ha HEKOTOPBIX MOJIENIAX). BbIXOJT IMCKPETHOIT BUIICOKAPTHI
MOKET U3MEHSIThCS B 3aBUCUMOCTH OT MOJIEJTH.

Meranaunyeckue 3ariymKki. CHIMUTE METAUTHYECKYIO KPBIIKY HANPOTHB CJIOTA, B KOTOPBI
Bbl XOTHTE YCTAaHOBUTD KApTy PacLUMPEHNs.
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IoaroroBka KomMnpOTEpa K pagoTe

B arom pasjiesie OnMCaHO MOJKIHOYEHUE K KOMIIBIOTEPY OCHOBHBIX yCTpOﬁCTB, HanpuMmep MOHHUTOpA,
KJIaBUATYPbl, MBbILIA U IIHYpa MATAHUS.

Houx.moqeﬂne BHEIITHETO MOHHUTOPA

HUcnonb3oBanue )IPICerTHOﬁ BUICOKAPTHI (TOIIBKO Ha HEKOTOPBIX MOI[QIIHX)

HO]]KJI}O‘II/ITC MOHUTOD K BbIXOY HHCKPCTHOﬁ BUICOKAPTHI.

JIs1 nOAK/IK0UEeHHs] BHENIHEr0 MOHMTOPA K JUCKPETHOI BUAEOKapTe:

1. TTopKITIOUNTE MOHUTOP K BBIXOAY AMCKPETHOI BUACOKAPTBL.
2. ToaKITI0YNTE MOHUTOP K HCTOYHKKY [THTAHHUS.
% BBbIXOJ1 IMCKPETHOI BUJICOKAPTBI MOXKET U3MEHSITHCS! B 3aBUCHMOCTH OT MOJIETIH.

)
¢
)
)
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o
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Hcnons3oBanne P[HTCI‘pPlpOBaHHOﬁ BHICOKAPTBI
HOJIKJI}O‘H/ITC MOHHUTOP K BbIXOAY I/IHTCFpI/IPOBaHHOI;'I BUJCOKAPTHI.
HJIH NOAK/IIOYCHUSA BHEITHET0 MOHUTOPA K HHTerMpOBaHHOﬁ BHUJICOKApTE:

1. Mopxmounre Morntop K VGA nm DVI-D nmn HDMI pa3bemy Ha 3ajiHeil NaHe M KOMIbIOTEPA.

2. TNopxmrounTe MOHUTOP K UCTOUHMKY MUTAHMUS.

R * Ecnu koMnbloTep OCHAILEH AUCKPETHOI BUEOKAPTOil, OHA YCTAHABIMBAETCS B KauecTBE
OCHOBHOTO ycTpoiicTBa oToOpaxenns B BIOS. CrejopaTelibHO, NOJKITIOUMTE MOHUTOP K BBIXOJY
BUJICOKAPTBI.

o JI7st NOfKITFOUEHHsT K KOMIIBIOTEPY HECKOJILKMX MOHUTOPOB, oﬁpaTmecs Kk rnase 3 [opkmouenne
HECKOJIbKMX BHEIIHUX MOHUTOPOB B 3TOM PYKOBOJICTBE M0JIb30BATEIS.
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Iopkmouenne USB knaBuaTypsl U MbImm

[opkmounre USB xnasuarypy u USB Mbiub k USB-nopTam Ha 3ajiHeil naHem KOMITbIOTEpA.

B8

N O

" e -
il N |

I

ITopkMr0ueHre MHYpa NUTAHUS

IopkmounTe OJMH KOHELL LIHYpa IUTAHKs! K Pa3beMy NIUTaHNs Ha 3aIHei NaHeI KOMIIbIOTepa, a Ipyroi
KOHell K Po3eTKe.

coo0e ],
(E= ) =
(oA (0000000000
— ]
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Bxiouenue/oTKIoueHne KOMIIBIOTEPA

B arom Ppasfiesie ONUChIBACTCs BKIHOYECHUE U OTKIIHOYEHUE KOMITBIOTEPA.

Bkiouenne KOMIBbIOTEPA
Jlns1 BKIIIOYEHHs] KOMIBIOTepa:
1. BkJrounte MOHUTOP.

2. Bxutounte BbIKtOUaTeNb Ha 3a1HElH MaHEeJH, 3aTEM Ha>KMUTE KHOMKY MUTAHUSA Ha KOMIIBIOTEPE.

Knonka nuranns

"-".- g

wﬁ{".z"‘\ I

3. JloxpauTech 3arpy3Kil ONepaiOHHON CHCTEMbL.

OTki09eHne KOMIIbIOTEPA
[t OTKITI0YueHnst KoMIIbIOTEpA:

1. 3aKpoiiTe Bee 3amyIleHHbIE TIPHIOXKEHUS.

2. Haxmure E Ha paboueM ctone Windows.

3. Haxmure | Shut down | JUIS BBIKJTIOYEHUS KOMITBIOTEPA.
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Ucnonaszosanue Windows 7

IlepBoe BKIIOYEHHE

ITpu nepBoM BKIIOUEHNH TIOSIBUTCST HECKOMIBKO 3KPAHOB, TIOMOTAIOLIMX HACTPOUTH OCHOBHBIE TAPAMETPbI
onepauuoHHoit cucrembl Windows 7.

le/l NepBOM BK/IIOYEHHUM BBIMOJIHUATE Cleyrouiee:

1. Bxmounte kommnbroTep. Joxurech nossnenns skpana Hactpoiika Windows.

2. B BbmapatoreM crucke BbidepuTe 1 Haskmute [anee.

3. B Bbmaparomenm cricke Bbibepure CTpana miam pernoH, Bpems n eHeXHble eIMHALBI 1
Packnajka Ki1aBuatypsl, 3atem Haxmure [anee.

4. BaepuTe UMt M0/Ib30BaTeIs 1 MMsI KOMIIBIOTepa, 3ateM Haxkvute [anee.

5. Baepute HeoOX oMMy 0 MH(OPMALKIO NIl HACTPOIKY Napons, 3aTeM Haxkmute [anee. Bol Takcke
MoKeTe HaxaTh Jlaliee 1 IpOMyCTUTE 3TOT 1ar 63 BBOfja MH(OPMALIL

% Ecmu Bol xoTuTe 3aJ1aTb Naposb st yquHoﬁ 3aMK1CH M03XKE, CMOTPUTE pas3jen COBJlElHPle y‘{eTHOﬁ

- 3aMuCH MoJIb30BaTeJis U NapoJs 3TOM TJIaBbIL.

6. I[IpounTaiiTe JNUEH3MOHHOE COIVIAIICHHME. YcTaHoBUTE (hnaXok S NMpUHMMAI0 yCI0BHS
Imuensnn 1 Haxmute danee.

7. Jlns HacTpoiiku mapameTpoB Ge3omacHocTi Bamrero kommbioTepa BbiGepute Memosb3oBath
PeKoMeHyeMble TapaMeTphI WM Y CTAHABINBATH TOJIBKO HAaHGO0JIee BaXKHbIe OGHOBIEHHS.
Bri6epute CHpocHTh MO3/iHee YTOObI NPOMYCTUTD ITOT LIAr.

8. ITposepsTe HacTpoliky faThl 1 BpeMeHn. Haxkvure Janee. CucteMa 3arpy3uT HOBbIE TapaMeTpbl

W BBINOJIHUT NEPE3ArpysKy. Tenepb BbI MokeTe ncnosb3oBath Bari KOMITBIOTED.
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HUcnonb3oBanue padodero crona Windows 7

Haxwmure knonky ITyck h CripaBka U MOJYIEP3KKa Jisi IOy YeHHsl JJONONHUTENLHON HH(pOPMALIK
o Windows 7.

HUcnons3oBanue mexio 'Ilyck'

Menro Tlyck' mpefocTaBiisieT OCTYI K MPOrpaMMaM, yTHINTaM 1 HACTpOiiKaM Baiero Kommbtorepa.
OHO TaKXe NpeoCTaBISET JONONHUTENbHY MHpopMauuio o Windows 7 ¢ moMolpto (yHKUMN
CnpaBka U nogaepxka.

3amnyck anemenToB u3 Menio 'Ilyck'

Ilns 3anycka 31eMeHToB U3 MeHIo 'Tlyck':

1. B nanenu 3agay Windows Haxmurte kxonky ITyck B

2. BriGepute anemeHT s 3amycka B MeHto Tlyck'.

% Bbi MozkeTe BbIGpaTh porpammbl, oToopaskaemble B MeHto Tlyck'. [Tofpo6Hyto uHopMarLiio cMoTpuTe
- B pasyiene Jlo6asaenne nporpammsl B MeHIo IIyck Mim naHeb 3a7a4 B 9T rase.

HUcnons3osanue nynkta Hauano padorst

Iynkr mento Hawamo paGortsl B meHro 'TIyck' copepskuT MH(OPMALMIO O HEKOTOPBIX OCHOBHBIX
3aj1auax, Hanpumep nepcoHanuzauust Windows, 106aBieH1st HOBbIX T0OJb30BaTeNel 1 nepeaya (aiiios,
YTO MOXKET [IOMOYb BaM 03HaKOMHUTBCS ¢ Mcnofib3oBanieM Windows 7.

Jlns1 nenonp3osanus nynkta Hauamo paGoTsr:

=
1. B nanesm 3aau Windows Haxkmure KHonky ITyck L JuIst OTKpbITHS MeHto Tlyck'.
2. Briepure Hauano pa6oTsl. [losiBUTCs CIMCOK OCTYMHBIX 3aa4.

3. BoiGepute Hy:xHyl0 3ajauy.

HWcnonp3oBanue naHean 3aja4

[lanens 3ajau MO3BOJSIET 3amycKaTb U YNPAaBISITh NPOTPAMMAaMil, YCTAaHOBJIEHHbIMM Ha Baurem
KOMITbIOTEpE.

3amyck nporpamMm U3 maHelH 3aa4y
Jls1 3anmycKa nporpamMMel M3 NaHeNn 3a1aq:
. B nmanenm 3ajau Windows 1enKHUTE MKOHKY /s 3amycka nporpammbl. Haxmute erue pa3 ans

CKPbITHS IPOrpaMMBIL.

/ BbI MoskeTe BbIOpaTh IPOrpamMMbl, 0ToGpakaemble B nanem 3ajiay. [1oapo6Hyto nHbopmMariuio cMoTpute
B pazpiene [loGasnenne nporpammbl B MeHio IIyck i naness 3a7a4 B 9T0if ri1ase.
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3al(pe1me}me JIEMEHTOB B CIIUCKE MEpexoaa

le/l LIETIKE l'lp’d.BOI;'l KHOTMIKOW HA WKOHKE B MaHEIn 3ala4 3alyCKaeTCsd CHUCOK IMEPEXONOB,
Hpe}IOCTaB.ﬂﬂ}OU_U/[ﬁ GLICpr]ﬁ JIOCTYII K NporpaMMam WJIn dJIEMEHTaM. Boi MokeTe 3aKpEeNUTDb SJIEMEHTDI
B CIIUCKE NEPEX0fa, Hanpumep TI0OUMBbIe C&ﬁTbI, YacTo MOCCIAEMbIC NMANKW WA TUCKHU, U HEJABHO
BOCIIPOU3BOIUMbBIE Me;ma(baﬁm,l.

[lns 3aKpenieHus 371eMEHTA B CIUCKe Mepexofa:
1. B nanenu 3aj1a4 1ENKHUTE NPABOil KHOMKOI UKOHKY.

2. B cnmcke nepexopa, 1ENKHUTE MPaBOil KHOMKON Ha 371eMeHTe, KOTOpblii Bbl XoTHTe 3akpenuts,
3arTeM BblOepHTe 3aKPeNMUuTh B CHICKE.

N3bsaTHE 37IeMeHTa U3 CIMCKA nepexoaa
[Inst M3BATHSA IEMEHTA U3 CIUCKA Nepexoaa:
1. B nanenu 3aiay WENKHUTE MPABOil KHOMKOI UKOHKY.

2. B cnucke nepexopa, ENKHUTE NPaBOii KHOMKON HA 3/EeMEHTe, KOTOPbIil Bbl X0THTE H3BATS,
3areM Bbibepute M3baTh U3 CIUCKA.

3aernJ1eHue NnporpamMmbl B MEHIO HyCK WJIK HA NTAHEIH 3a1a4
[lns 3akpensienust nporpammbl B MeH1o IIyck nim Ha naHenu 3apay:

1. B nanenu 3agay Windows naxmure kxonky ITyck ﬂ JUIst OTKpbITHS MeHto TIyck'.

2. IllenkHuTE IPABOIl KHOMKOII Ha 37IeMeHTe, KOTOpbIil Bbl xoTuTe 3akpenuTh B MeHto ITyck umi Ha
TNaHeN! 3a/jau.

3. Bribepute 3akpenuTh Ha NaHexH 3a7a4 Wi 3akpenuTs B MeHI0 'Tlyck'.

% Be1 MoxxeTe Takke HIENKHYTh npaﬁoﬂ KHOTIKOI Ha MKOHKE 3any1_uel-u-10171 NporpaMMhbl B ITAHEN 3a/jadl,

- 3aTeM BbIOpaTh 3aKPenuTh 3Ty MPOrpaMMy Ha MaHeIH 3a/1a4.

N3bsaTne nporpammel u3 Menio Iyck

Jlns m3psiTHS nporpamMmsl w3 MeHio ITyck:
1. B nasenm 3ajau Windows maxmure knonky ITyck & st oTKpbITHS Merto Tlyck'.

2. B Mento Ilyck wienkHuTe npaBoii KHOMKOI MO MPOrpaMMe, KOTOPYIO HYXHO U3BSTh, 3aTeM
BbIOEpHTE YAQIUTH U3 3TOrO CIUCKA.

N3bsTHE NpOrpaMMbl U3 NAHEJH 32124

IIJIH U3BATUA MPOrPAMMBbI M3 NMAHEIH 3a1a4:

1. Ha nanenm 3afiay 1/ IKHUTE IPaBOil KHOMKOI1 Ha IPOTrpaMMe, KOTOPYIO HY>KHO H3bsITh U3 AHEI
3ajad, 3aTeM BblbepuTe M3bATh 9Ty HporpamMmy U3 naHesu 3aadq.
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HNcnonb3oBanue 001acTH yBeAOMIIEHUI

o YMOJTYaHHUIo, B obnacti yBe}lOMJIeHPIﬁ TIOKa3aHbl 3TU TPU UKOHKUA

Yeenomnenusi Ilentpa nogaepkkn

Haxmute 9Ty MKOHKY /st OTOOPaKeHHs BCeX COOGLICHMIT/yBEJOMIECHHUII 1 3alyCKa LEHTpa
TOYIEPXKKHU.

Cerepoe TOAK/IIYEeHHe

3ra MKOHKa 0TOOPAKACT COCTOSTHHE MOJIK/TIOYEHHS! M MOILIHOCTb CHTHATIA TPOBOJIHOTO 1JTH GECTIPOBOJTHOrO
TIOJIKJTFOYCHHSA.

I'pomkoctn

HaxxmuTe 3Ty HKOHKY [UISl PeryIMPOBKI 'POMKOCTH.

ITpocmoTp yBemomeHmit
JIns npocMoTpa yBeaoMIeHust:

. HaxxmuTe MKOHKY yBelOMIEHNUS n, 3aTeM LIENKHUTE MO COOOILEHHIO /TS €T0 OTKPBITHS.
/ ToppoGuyto nHpopmanto cmorpute B pasiene Menons3oBanme llentpa nopmepxkn Windows
A 9TOIi IMIaBbl.

Hactpoiika MKOHOK M yBeOMJIeHHI

Bl MoxeTe Bblﬁpa']‘b 0T06pa)KeH]/lC WA CKPBITUE HUKOHOK 1 yBeJIOMJIeHVH?] B ITAHEJI 3a]1a4 WA B ob6uactu

YBEJIOMIICHHUIA.

JI1st HaCTPOVMKM MKOHOK H YBeIOMJICHNIT:

1. B ob6nacty yBejomseHnil HaXMuTe UKOHKY CTPENIKU E

2. Haxmure Hactpoiika.

3. B BbImaarowem crmcke BbiGepuTe NOBENICHNE J7Isl NKOHOK UJIM MYHKTOB, KOTOpble Bbl XoTHTE
HACTPOUTb.

Ynpasnenue (aiiiamu U nankamu

HNcnoas3osanue IIposognnka Windows

ITposoprnk Windows no3BosnseT IpocMaTpUBaTh U YIPABIATH (pailiaMi 1 NanKamu.

3anyck [Iposonnuka Windows
Jlns 3anycka IIpoBopuuka Windows:

=
1. B nmanemm 3aau Windows Haxkmure KHonky ITyck h st oTKpbITHS Merto Tlyck'.

2. s 3anycka Iposopauka Windows Haxkmure Komnbrorep.
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IIpocmoTp ¢aitnos u mamok
Ilns npocmoTpa (aiiios 1 nanok:

1. Banycrure [Tpooguuk Windows.
2. B naHemm HaBUTALW¥ MJIM IPOCMOTPA HAMUTE pacrosiokeHue Baimx faHHbIX.
3. B naHemu HaBUTALVM HAXXMHTE CTPEJNKY T OTOOPAsKeHHs COIEPKMUMOTO JINCKA HITH TAIKH.

Hacrpoiika oroopaxenus gaiiios/manox
Jlns HacTpoiKH oToOpaxkeHus (hailIoB/manok:

1. Bamycrure [IpoBoank Windows.

2 B o6nacTy HaBurauyy BbIGEpUTE pacnosioskenne Baimx faHHbIX.

3. B naHenm MHCTPYMEHTOB HaXMHTE UKOHKY Bujy = =,

4 B mento 'Buy' nepemecTiTe MOM3YHOK 171t BBIGOpA MPOCcMOTPa (hailtos/marnoxk.

% BbI MoskeTe TaksKe IIeKHYTh MPaBoil KHOMKOI B 00J1aCTH IPOCMOTPA 1 BbIOpaTh Bup, 3aTeM BbIGpaTh
- THIT IPOCMOTPA.

Opranu3anua aiinos
Jlns1 opranusauum paiinos:

1. Bamycrure [IpoBounk Windows.
2. Haxwmure none YnopsixouuThb MO 15 0TOOPASKEHNS BBIMAAIOMIEro CITHCKA.
3. BoibepuTe THIT pa3MeLLeHHisL.

CoprupoBka ¢aiinos
st copTHpoBKH haiinos:

1. Banycrure [IpoBounk Windows.

2. IllenknuTe NpaBoil KHOMKON B 06GNAcTH MpocMoTpa, Bbibepute Bup, 3areM BbiOepure THn
POCMOTPA.

3. B nosBuBiemcs MeHto BbibepuTe COPTHPOBATSH 10, 3aTeM BbIOEPUTE TUII COPTHPOBKU.

I'pynnupoBanue ¢aiinos
Jlns1 rpynnupoBaHus (aiiios:

1. 3amycrure IIposomrik Windows.

2. lllenknure mpaBoil KHOMKOI B OOGJAcCTH MpOcMOTpa, BeiOepuTe Bmp, 3arem BbiGepute THI
POCMOTPA.

3. B nosBuBmeMcs MeHI0 BbIGepuTe I'pynnupoBats 1o, 3aTeM BbIOGEpHTE THIT IPYIIIPOBKIL
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JloGaBjieHre HOBOM NMANKHU
Tlnst noGaBIeHNsl HOBOW NMANKU:

1. 3anycture [IpoBoHuk Windows.

2. B nauenu uncTpymenToB Haxkmute HoBast manka.

3. BBaejure uMst 117151 HOBOW MANKM.

/ Bbl MoxeTe Takke LIEJKHYTh NPaBOil KHOMKOIl B 061acTi mpocMoTpa 1 Bbibpath Co3pats >
Manky.

ApxuBauus ¢aiinos

Hacrposika apxusauyuu
Jlna apxuBauum:
=3
1. Haxmure ﬂ > [Iporpammsl > OGcnykuBaHue > ApXUBaLys M BOCCTAHOBIIEHHE.
2 Haxwure Hactpoiika apxusanun. Haxxvure [Tanee.
3. Bribepure myTs st apxuBauun. Haxxwmure Jamnee.
4 Brioepure IlpemocraBute BbIGop Windows (pekomenpyercs) nin IIpemocraButs MHe
BBIOOD.
% Ipu Bui6ope Ipenoctasuts BoIGOP Windows, Windows He GypeT apxusnposaTh Baiun nporpammbl,
/- haitbl Ha pasnenax FAT, daiinbl B Kop3uHe win BpeMeHHble (aitibl pasmepom 1 I'B u Gosee.

5. CrepyitTe HHCTPYKLYSIM Ha 9KPaHe [Isl 3aBePLUEHIS POLIECCa.

Copoc K HaCTpOMKaM Mo YMOJTYAHUIO

Boccranosrenne cuctembl Windows CO3JAa€T TOYKKU BOCCTAHOBJICHUSA C HaCTpOﬁKaMH CUCTEMBI
COXPaHCHHBIMU B ONPEICTICHHBIE BPEMS U J1aTy. IT0 NMO3BOJISIET BOCCTAHOBUTH MJI OTMEHUTD M3MCHEHHS
B CUCTEME, HE 3aTparuBas Baum nunbie JTAHHBIC.

HJIH BOCCTAHOBJIEHUSI CUCTEMBI:

1. 3akpoiiTe BCE 3aMyLLEHHbIEC PHIOXKEHHS.

=3
2. Haxmure 0 > [Iporpammsl > Cranpaprusie > CiyxeGHble > BoccTaHoB/IeHHE CHCTEMBI.
3. CrieptyiiTe MHCTPYKLWSIM Ha 9KpaHe [I71st 3aBePILISHNs polecca.
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3amuTa KoMNbIOTEpa

HUcnons3oBanne Lentpa monmepxku Windows 7

Lenrp nopmepskkn Windows 7 TmpefocTaBnseT YBEOMICHHUS, MH(OpPMAUMi0 O Oe30MacHOCTH,
nH(OpMaLIo 06 00CITyKUBAHUN CHCTEMbI il BO3MOXKHOCTb ABTOMATHYECKOTO yCTPAHEHNST HEKOTOPBIX
HauboJIee YaCTO BCTPEUAIOLIMXCS MPOOIEM C KOMITBIOTEPOM.

% Bui MoskeTe HacTpouTb yBeomenust. JlononsuTensHyto nHopmauuto cmorpure B pasyiene Hacrpoiika
MKOHOK M YBEIOMJIEHHI 3TOIT TTIaBbL.

3anyck Llenrpa nopaepxku Windows 7
Ilns 3anycka Lentpa nopaep:kku Windows 7:

1. Jnst 3amycka Llenrtpa nognepsxkn Windows 7 HaXMHUTEe MKOHKY B 00J1acTH yBeHOMneHMﬁp 5
3ateM Haxmute OTKPBITh HEHTP NOAePKKH.

2. Boi6epute HysxHyto 3aauy B LleHTpe nopyiepxki.

HUcnons3oBanue Lentpa ooHoiennit Windows

LleHTp oGHoBsiennit Windows mo3Bosisier NPOBEPATL U YCTAHAB/IMBATL IOCJEIHAE OOHOBJICHUS Ui
TOBbIILIEHUS 6E30MACHOCTH 1 NPOU3BOJIUTEJIbHOCTU Bauero KOMIbIOTEPA.

3anyck lentpa oonosrennit Windows
s 3anmycka Lentpa ooHoBnennii Windows:

1. B nanenu 3anay Windows Haxkxmute kxonky ITyck ﬂ st OTKpbITUs MeHto TIyck'.
2. Briepute IIporpammser > Llentp oGHoBaennst Windows.
3. BoiGepute HyxHyto 3aia4y B LleHTpe 0OHOBNEHMIL.

Cosnalme y'lETHOﬁ 3alMUCH MOJIb30BaTE/IA U NAPOJis

Bl MO3KeTE CO3AaTh yUETHBIE 3AMCH N10JTb30BaTE]IeH M MAPOJIN TSl OfIEH, KOTOpbIe OY/Ly T HCTIONB30BATH
Bam komnbioTep.

Co3pganne yueTHOW 3aMHMCH MOJIb30BATENs
I[Hﬂ CO31aHuA y'-leTHOil 3alUCH NMOJIb30BaTeJIst:

=]
1. B masenu 3agau Windows Haxkmure £ > [Ipucrynas k pagore > [106aBUTH HOBOrO
0/1b30BATEJIS.

BeiGepure YnpasiieHne Apyroi y4eTHOI 3aMiChIO.
Bribepute Co3naTh HOBYIO YYETHYIO 3aMHUCh.
BaepuTe 1Mst HOBOTO NONB30BATENS.

Bri6epute OOBIYHBIN JOCTYN WM AMUHHCTPATOP KaK THI NONB30BATEs.

S ok v

Korpa 3akoHunTe Haxxmure COS}IHTI) YYE€THYI0 3anuCh.
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33)13““(3 apoJis moJjib30BaTesa
s 3apanus napoJis noJjib30BarteJisi:

1. BriGeprTe MoIB30BaTENsA, 7St KOTOPOTO HYKHO YCTAHOBUTE TAPOJTh.
2 Brioepure Co3naTh mapods.

3. BaepuTe naposis 1 MOATBepKTe €ro. BeeuTe moackasky K mapoito.
4 Korpa 3akonunre, Haxxmure Co31aTh napossb.

AKTﬂBalll/lﬂ AHTUBUPYCHOT'0 NMPOrpamMMHOro odecrneyeHnst

[punoxkernue Trend Micro Internet Security yxe ycraHoBmeHo Ha Bamem kommbloTepe. JTO
nporpaMMHoe obecrieyenne odecreyrBaeT 3aluTy KOMIbIOTepa OT BUPYCHbIX aTak. ITpuoGperaercs
otaensHo. [Tocie akTiBamyum Bbl MoxxeTe ncnonb3oBaTh ero 30 gHeit.

IInsa aktusauuu Trend Micro Internet Security:

1. 3amycrure npunoxenue Trend Micro Internet Security.

2 Tpounraiite mmuen3nonHoe cornmamenne. Haxmure Agree & Activate.

3. Baepure ajipec aneKTpoHHOI NOYTHI 1 BbiGepuTe cBoil perno. Haxmure [Tanee.
4 Haxwmute [0TOBO /17151 3aBEpLLICHNST aKTHBALH.

Ilonyuenne cnpasku u noagepxkn Windows

CripaBka ¥ TOJIepXKA MPEOCTABISIET MHCTPYKIMH M OTBETHI MO WCMOJBb30BAHMIO MPUIOXEHMI B
Windows 7.

[="]
st 3amycka cnpaBky 1 nofyiep>kku Windows Haxkmute ﬂ > CripaBKa 1 NoJyIepKKa.

/ st nosyyeHust nocnejiHeit Bepcuu crpasku yoeurech, 4to Bol nojkitouetsl K ceti MHTepHer.

122 T'naga 2: Ucnons3opanue Windows 7



HOI[KJIIO‘IEHI/IC YCTPOﬁCTB K KOMIIbIOTEPY

Iopkmouenne USB-nakonurens

Oror HactombHblil [TIK ocHamen nopramu USB 2.0/1.1 n USB 3.0 Ha nepeeii u 3ajseit nanemsix. K
USB-noptam MoxHo nopximodats USB-ycTpoiicTsa.

s nopkmoyenusi USB-Hakonureneii:

. TNopxmounte USB-HakonuTens K KOMIBIOTEDY.

)

o=
=
<
3]
3]
>
=%

Iepenusist nanens 3anuss naHesb

Nns orkmoyenns USB-nakonureneii:

1. Haxmure ! B oOnacTy yBefiomienuniit Windows, 3ateM BbiGepute
Eject USB2.0 FlashDisk wm Eject USB3.0 FlashDisk npy | @ren Drvices and Fristen
ucnosb3oBanny USB3.0 -coBvMecTiMOro yctporicTsa. s EpectirSE20 Pl

2. Ipu nosiBneruu coobwerns Safe to Remove Hardware
orkimounte USB-Hakonurenb ot KoMIbloTEpa. @ 531 To Remove Hardwars A
The L35 blasi erage Diere devida 2im mow be Loty

remarard frem he sampan

/ HE u3snexaitte USB-Hakonurens Bo BpeMs nepeaayn JaHHbIX. DTO MOXKET MPUBECTH K NOTEPE JAHHBIX
[ \ niu nospeskieruto USB-Hakonuresst.
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ITopkmoyenre MUKPO(hOHA U KOJTOHOK

ror HacronbHbIil [TK ocHaleH pasbeMamit JUIsl IOAKIFOYEHNS] MUKPO(OHA M KOJIOHOK Ha TepejHeli 1
3ajIHel MAHEeIsIX. Ay/IHOPa3beMbl, PACTIONIOKEHHbIE HA 3a/JHEll MAHENHN TO3BOJISIOT MOAKIIIOUnTD 2/4/6/8-
KaHJTbHbIE aKyCTHYECKHE CHCTEMBbI.

HOJIK.TII()‘{QHHQ HAYIIHUKOB 1 M“Kqu)OHa
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Monkaoyenne 4-KaHATBHON AKYCTHYECKOH CHCTEMBI

o=
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o
>

=5

b S

Ionkmoyenne 6-KaHATBHON aKyCTHYECKOH CHCTEMBI
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IMoakmouenne §-KaHATBHON aKyCTHYECKOIH CHCTEMBI

o [ | EI_"' ® - _—:TD
i | & |'i1 ’:_}_I

" V— ™
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HonKmoqe}me HECKOJIbKUX MOHUTOPOB

Hacronbhblii ITK Moxer 6biTh ocHaten VGA, HDMI, DVI pazbemamut, 4To N03BOJISET NOAKIIOYUTD
HECKOJIbKO MOHHTOPOB.

R Korpa B Baur komnbroTep ycTaHOBNEHA BUACOKAPTA, MOJKIIOYMTE MOHUTOPbI K BBIXOJly BUJIEOKAPTBI.

Hactpoiika HeCKOJIbKHX MOHUTOPOB

Ilpn WCTONB30BAHMM HECKOIBKMX MOHHTOPOB BBl MOXeTe YCTaHOBUTH pa3NMUHbIE PEKIMBI
0TOOpaxkeHus. Bbl MoxkeTe HCNONb30BaTh JONONHUTE bHbI MOHUTOP /151 1y OIUPOBAHNUS U306pakeHus
Ha OCHOBHOM MOHHUTOpE WM st paciumperus Bamero pa6ouero crona Windows.

[l HACTPOHKHM HECKOILKMX MOHUTOPOB:
1. Boikimounte KomnbioTep.

2. Tlopkirounte [IBa MOHMTOPA K KOMIIBIOTEPY M MCTOYHMKY mutanmst. [ogpoGuyio HHpopMaLiio
0 MOAKIIIOYEHNN MOHHTOPA K KOMIIbIOTEPY cmotpute B pasaene IlogroroBka KommbloTepa K
padore B riase 1.

TIns HekoTopbix Bufeokapt 3kpaH BIOS POST nosiBnseTcst TonbKO Ha OCHOBHOM MoHHMTOpe. [IBa
MOHHUTOpa padoTatot TonbKo nojy Windows.
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3. BximounTe KommbroTEp.
4. Tnst oTKpbITUS SKEaHa Pa3pemenne 3kpaHa BBINOMHUTE OJIHO U3 CIIEyIOLIMX AACTBHIL:

*  Haxwmure > I1anennb ynpasienust > Ogopmienne u nepconaansanus > Jucniei >
H3meHenne mapamMeTpoB uCILIES.

o lllenknure npaBoil KHOMKON Ha CBOOOAHOM Mecte paboyero crosa. Ilpu nosiBieHuu
BCIbIBatoLero MeHto Haxkmute [lepconanu3auus > Jucnieii > 3meHenne napameTpos
JucIIest.

5. Bri6epute peskiM 0ToGpaskeHNst 13 BbIMajjatoero cnricka Heckobko aKpaHoB:.

+  Jlyonmposath 3TH 3KpaHbI : BbiGepute 31y omupo jms AyOnMpoBaHns M300paxeHns
Bauiero 0CHOBHOro MOHMTOpA.

«  Pacmmputh 3TH 3KpaHbl: BbIOEpHUTE 3Ty OMNIMIO JUIS PaclIMpeHnst pabodyero crona Ha
OCHOBHOM MOHMTOPE. DTO yBEIHYMUT PabOumil CTOM.

*  OroGpaxats padoumii cToi TonbKO Ha 1/ 2: BbiGepute 3Ty OMIO [71st OTOOPaXKEHNS
pabouero cTosia ToNbKO Ha MOHMTOpE 1 1 MOHUTOPE 2.

e YpamuThb 3TOT MOHHTOP: BbiGepute 3Ty Onuio /st yfianeHust BbIGPAaHHOrO MOHUTOPA.

6. Haxxmure Ipuvennts nm OK. 3atem Haskvute COXpaHHTB M3MEHEHHSI JUIs TIOJITBEPSK/ICHISL.

Dicplay Setbngs Eﬂ

I'I-.-:..

u want 1o keep these display settings?

Ko chongs

| Reverting to previews saplay sethings in & seconds,
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Iopkmouenne HDTV

Mopkmounte TB Boicokoit yetkoctn (HDTV) k HDMI pazbemy KoMibroTepa.

/ o Jlna nopxkmouenns HDTV k komnsrotepy norpeGyercs HDMI ka6ens. HDMI kaGenb npuobpetaetcst
OT/IENLHO.

«  JIng obecnieyenns Haumy el Mpou3BOAUTENLHOCTH yoeuTech, yto fymHa HDMI kabens cocrapnseT
MeHee 15 MeTpos.
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Hcnonb3oBanne KoMNbIOTEpa

HpaBI/IJII)HaH 1Mno3a Npu UCnojJb30BaHNA HACTOJBHOI'0 KOMIIBIOTEPA

Ipu ucnonb3oBanun HactonbHOro 1K, HEOGXOAMMO COXPAHSITH MPABMIILHOE MONOKEHHE BO M30eKaHNe
fechopmaLyn 3ansicThsl, PyK M JAPYTMX CYCTABOB M Mbilll. B aTOM pasjene copmep:arcst COBeTbI [iist
n30eXKaHmsT (PU3MYECKOro MCKOM(OPTA 1 BO3MOKHBIX TPABM TPH HCITOJb30BaHNH HACTOIbHOTO [TK.

Eye level to the top of
the monitor screen

)

o=
=
<
3]
3]
>
=%

Foot rest 90" angles

I[.T[Sl COXpaHeHus l'lpaBPlJ'll:HOfl OCaHKH:

. JIns ynoGHo#1 meyaT yCTaHOBUTE CTYJI TaK, YTOObI Bali 10KTH OblM Ha YPOBHE UM Uy Th BbILLE
KIIaBUATYPbL.

. [ns paccnaGnenns Genep OTPEryIMpyiiTe BBICOTY CTYJA TaK, 4ToObI Baum KoneHu Obu uyTh
BblLIe MHUK Geniep. Ecim Heo6X0auMo, NCoNb3yiiTe NOACTABKY s HOT.

. Otpery/mpyiiTe CIMHKY CTyJa TaK, YToObl OHA MOJJEPXKUBAA OCHOBAHME MO3BOHOYHUKA U
HEMHOTO HaKJIOHSIACh Ha3ajl.

. CsijipTe TSIMO, KOJIEHH, JIOKTH 1 Gefipa JIOMKHbI HAXO[IUTBCS TOJ| yrioM npuvepHo 90°.

. YcTaHoBUTE MOHUTOP MPSIMO Nepej| co60it Tak, YTOObI BEPXHSIS YaCTh 9KpaHa MOHUTOPA Obla Ha

YPOBHE Ij1a3 UJI1 HEMHOI'O HIXKE.

. Jlepxure Mblllb 6;1M3KO K KIIaBUATYype, MPU HEOOXOANMOCTH, HCTIONb3YilTe MOJICTABKY VIS PyK
JUIS yMEHBLLCHNS [JABJICHNS Ha 3aIsICThst IPH HA0Ope TeKCTa.

. Hcnons3yiire HactonbHeni ITIK B KoMopTaGenbHOM OCBEIIEHHOM MECTE M Pa3MecTUTE ero
Tojia/iblie OT UCTOYHMKOB APKOTO CBETA, HAMPUMED OKHA M COJTHEYHOTO CBETA.

. [Ipu ucoNb30BaHUN KOMITBIOTEPA JelaliTe Pery IspHbIe IepepbIBbL
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HAcnons3oBanue Kapapuaepa

Iucppoble Kamepsl U [pyrue LU(poBble YCTPOHCTBA UCHOMB3YIOT KApThl MAMSITH [l XPAHEeHUs
cororpacdmit ¥ npounx cpaiinoB. BeTpoeHHbll Kapipuiep Ha nepeiHeil MaHeau Mmo3onsieT Bam
TPOM3BOUTD UTEHHE 1 3aIICh HA PA3NTUUHbIE KAPTHI MAMSTL

IIJIH HMCMOJIb30BAHUA KAPThI MaMATH:

1. BcrasbTe KapTy B COOTBETCTBYIOLLINMIA CIIOT.

. KapTa MMaMATHA UMEET BbIPE3, CJIEI0BATEIbHO €€ MOXKHO BCTABUTH TOJILKO B OTHOM TOJIO>KEHUH. Bo
u3bexaHue TOBPEXKICHN KapThl, HE HpMMSHﬂﬁTC UPE3MEPHBIE YCUITHUA NPU YCTAHOBKE €€ B CJIOT.

* Bbl MoxeTe YCTAHOBUTL OIHY MIIM HECKOJIBKO KapT B Pa3JIMYHBIE CJIOTBHI U UCMOIB30BATH MX
He3aBrchMo. [TomeltaitTe B KaXK[blil CIIOT TONBKO OJIHY KapTy nmaMsTH.

2. B okHe aBro3amycka BbIOepHTe IPOrpaMMy Al JOCTYIA K haiiiam.
/ + Ecmu aBrosamyck BBIKIIOUEH, JUIsl JOCTYIA K JAHHBIM Ha KapTe IaMsTi Haxmute KHOIKy Iyck,
- BbI6Cpl/lTC KOMIBIOTEP, 3aTEM JIBAXK]IbI LLIEIKHUTE 110 UKOHKE KapThl MAMSATH.

+  Kaxplit cot nMeet coGcTBeHHYIO GYKBY M MKOHKY, 0TOOpakaeMyto B okHe Mol KoMnbioTep.

. I/IHI[MKﬂTOp Kapapuiepa MUTAET NPU YTECHUH UK 3aNUCH TAHHBIX HAa KapTy MaMATH.

3. Korpa 3akoHunTe, 1eJIKHUTE NPaBoii KHONKOI HA UKOHKE KapThl IaMsATH 1 BbibepuTe M3Bneys,
3aTeM U3BJIEKNUTE KapTy.

R Huxkorya He u3BreKaitre KapThl Cpasy N0CHE YTEHIS, KOMMPOBaHKs, (GOPMATHPOBAHIS M yATICHHS
JIaHHBIX, MTHA4€ JJAHHLIE HAa KapTe MOryT ObITh TNOBPEXK/CHBI.

E\ JIns mpefoTBpAIeHnst IOTepH JaHHBIX Tepejf| M3BIeYeHneM KapThl ucnonb3yiite besomacHoe
u3BlIeYeHne ycTpoiicTa B 061acTu yBeomennii Windows.
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Ucnonb3oBanue onTHYECKOro NnpuBoJa

YcranoBka onTHYeCKOTO IMCKa

Jlnst ycTaHOBKH ONTHYECKOTO AMCKA:

1. IIpu BKIIHOUEHHON cucTeme Hakmute KHonky PUSH.
HaxmuTe KHONKY M3BIICUEHHUS IOTKA.

IMomecTuTe IUCK B ONTHYECKHUIl IPUBOJ| ITUKETKON BBEPX.

Haxwmute notox NPpUBOJA I €r0 3aKPbITUSA.

A A

B okHe aBTo3amycka BbIoepuTe IporpaMMy Ans A0CTYIA K aiiiam.

Ecmm aBrosanyck BbIKJIHOUEH, it foctyna K aanHbiM Ha CD/DVD-mucke Haxmure kuorky ITyck,
BbIOEPUTE KOMIBIOTEP, 3aTeM JBAXK/IbI LEIKHKUTE 10 HKoHKe CD/DVD-pucka .

W3Bneyenne onTu4eCKOro JAUCKa
51 M3BJIeYeHUsI ONTHYECKOTO UCKA:

1. 17151 u3BIEUeHNS JIOTKA BBINOMHUTE JII060€ U3 CEAYIOIMX IeHCTBHII ©

. Haxmure KHOMKY U3BJICYCHUS JIOTKA.

«  Ilenkuure mpasoii KHorkoil Ha mkoHKe CD/DVD-mucka B okee Kommblorep, 3arem
Hakmute U3Bieus.

2. OCTOpO)KHO BO3bBMUTE JTIUCK 3a Kpast N U3BJIEKUTE €T0.
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HUcnonn3oBanue kaasuatypbl ASUS ROG UIN

Hacromehbiit I[TIK ASUS Essentio nocrasnsiercst B Kommiekte ¢ urposoit Kiasuarypoit ASUS ROG
UIN.

/ Komnekr nocrakn ASUS GX900 cmorpure B pasjiesnie KommnekT mocraBku.

Installing the ASUS ROG U9N Gaming Keyboard

1.  Jns nmopkmoueHust urposoit knapuatypsl K USB nopry Bamero xommbrotepa ucmosb3yiite
TIOCTaBJISIeMbIiT B KOMIUIEKTe niepexofHnk PS/2->USB.

2. CoBmecTuTe M BCTaBbTE NMOJCTABKY MOJ| 3aMSICThSI B COOTBETCTBYIOLIMII CIIOT KJaBuatypbl (A).
HapiaBute Ha nopicTaKy G0JIbIIMMI IATILLAMM IOKA OHA He BCTAHeT Ha MecTo (B).
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3. Mepesarpysure kommbiotep. Windows aBTOMATHUYECKH YCTAHOBUT BCE HEOOXOMMMBIE NpaiiBepa
W15t Baueit kmaBuaTypel.
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Ncnoas3zosanue mpimu ASUS GX900

Hacrombhbiii [IK ASUS Essentio mocrasisiercst B Kommiekte ¢ urposoil Mpimbio ASUS GX900.

% Kowmmnexr nocraBkn ASUS GX900 cmorpure B paspiene Komniekt nocraBku.

ASUS GX900 ocHauiesa 7neBoil W MpaBoil KHOMKAMH, KOJECHKOM MPOKPYTKH, ABYMSI GOKOBBIME
kHonKamu, DPI nepekmtouatesnem, a Takske KHOMKOIA 7St epeKIIFoueHnst poduIiert.

Onucanne Onucanne
1 JleBast KHOMIKa 7 Jorotun GX900
2 ITpaBast KHOMKa 8 Knorka IE Bnepen
3 Kornecuko npokpyTkn 9 Knorka IE nazan
4 DPI nepexmouareis 10 Hoxxka MbIm
5 Kronka nepekmouenns npocueit/ 11 Hoxxa MbIli 1 1a3epHblil faTank Twin-Eye
MrpukaTop npocpus®
DPI unpukarop™* OcHoBaHue ¢ perympyembiM BecoM (5
6 12 P,
I'PY3HKOB 10 4,51) ***

**%% Bpl MOXKETE OTPEryIMPOBATh BEC MBILLH, I00aBUB I Y/IAJMB IPY3UKN U3 KOMIUIEKTA MOCTABKH.
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*Wupukarop npoduis

IIBer 3nauenne
HMHIMKATOpa

Her Hopwmanbhbii npochuis
3eneHblit Tpodpus 1

KpacHblit Tpoduis 2

OpaHxeBblil Tpocpub 3

Mupnkarop DPI
et 3navenne
MHAMKaTOpa
2 DPI yposens 1
4 DPI yposenn 2

3anyck nporpamMmsI

Jns ncnone3oBanus Beex (yHkumit GX900 HEOOXOMMO yCTAHOBUTB NPOTPAMMBI C MOCTABISEMOrO
KOMNAKT-/UCKa. BcTaBbTe AMCK B ONTHYECKUIT IPUBOJ 1 CIIE[yliTe HHCTPYKLUSIM Ha 3KPaHe [I7Is 3a1ycKa
MPOrpamMMBbl.

Ecmn aBrosamyck BbIKmoueH, Haijgute Ha aucke ¢aitn GX900.exe . [Baxbl wenkunTe Ha haitne
GX900.exe fi71s1 3amycKa MPOrpammbl.

Hacrpoiika nazepnoii mpimm ASUS GX900

Y6enurech, uto Mblb nogkmoyeHa Kk USB-nopry kommnbiotepa. IIporpaMma aBTOMaTndecKkn
0OHAPYKUT MbIllIb ¥ 0TOGPA3UT IVIABHOE MEHIO.
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I'naBHOe MeHIO
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Iyuktel Onucanmne

1 |Kaxpas BKyIajKa 0TOOpaXkaeT MEHIO BEIOPAHHOTO MPOCHIISL.

OtobpakeHue MKOHKM NPOuIsl, KOTOpasi HACTPAUBAETCS B MEHIO Npoduiei
1~3.

Hazxmure 715t c6poca DPI HacTpoek K COXpaHEHHbIM B IPOLLIIbII pa3.
IlepemecTute non3yHok st perymposku DPI 3Hauenns s Kaxjioro ypoBHs.
Haxmure g cGpoca HACTPOEK KHOMKM K COXPAHEHHBIM B MPOILIbI pa3

Haxmure Ans 0ToGpaskeHNs! IBETOBbIX MHAMKATOPOB PA3MHUHbIX Npocthusiell 1
VX COCTOSIHUSL.

Haxxmure st 3arpy3Ki B MBIIIb COXPAHEHHOTO MPOMISL.
HaxxmuTe 71711 COXpaHeHns: HACTPOEK Ha SKECTKMUIA JIUCK.

oI N AW N

HaxxmuTe 7151 c6poca Bcex HACTPOEK MBIIIM K 3aBOJICKUM HACTPONKaM.

—
>

Haxmure 71l npUMeHEHNs! HACTPOEK.

11 |Haxxmure juist COXpaHEHHs! HACTPOEK U BBIXOJA U3 POrPaMMBbL.

* Kaxxpplit ipochnins nveet fia yposHst DPI. [IBa ropsimmx DPI mHaukatopa o3HavaoT yposeHb 1, a
YETBIPE - YPOBEHD 2.
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Meno npoduis

(]

2 BaepuTe kenaemoe uMs PO

Haxxmure 7151 movcka n300paxkeHus, KOTopblit Bbl XoTute MCnonb30BaTh A71s npohuis.
BoiGeprie (pyHKIMIO 17151 KAK[[0i KHONKH/IEHCTBHSI M3 BBIMAAIOIIErO CIHCKA.

* TloppoGHy0 MH(OPMALMEO CMOTPUTE B TAOINIE HITKE.

ITyHkTHI Omncanne

1 IllenxHuTE A7 OTKPBITHSI MEHIO PeJAKTUPOBAHISL, KOTOPOE NIO3BOJSET H3MEHHUTh HA3BaHUE
TpoHIIs ¥ HKOHKY.

JleBasi KHONKa
IIpaBas kKHoOnKa

CpenHsisi KHONKa

IE nazan

IE Bnepen

138

DyHkuun Onucanne

JleBast KHOMKA MbILIH

ITpaBast KHOMKa MbILIN

CpejiHsist KHOMKA MbILLIH

Krorka IE Hazaji. Korjia BbIOpaHO, HaxkaThe KHOMKM NPUBOJUT K TEPEXOfy Ha
TpefbIIYLLYI0 CTPAHHLLY.

Knonka IE Bnepep. Korjia BbiGpaHo, HaxkaTue KHONKHM TIPUBOJIUT K NMEPEXOly Ha
CIIEYIOLLYIO CTPAHHLL.
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DyHKRUMH Omucanne

Knasuarypa

Makpoc

Cxkpunrtsi #1-6

DPI [+]

DPI [-]

DPI yposenn 1/2
IlepexmouaTens
npoduien
HopmansHblit
npoguib
Ilonb30BaTenbekmit
npocus 1/2/3

Konecuko (Bneso/
BIIPABO)

Rapid Fire [Mbimb]
Rapid Fire
[knaBumal
Bpaysep

E-mail

Media Player

Bocnpoussenenne/
Iay3a

Cron
Cnenywoumas
HAOPOXKKA
Ipeppiaymas
TOPOKKA
YBeauunts/
YMEHBUINTH
TPOMKOCTH
OTKIIOYHTD 3BYK

HaxaTune KHONKM NPUBOAUT K SMYJIALIMHA HAKATHUA 0}1}[017] KJTaBUIIA WA
TIOCJICTIOBATEIbHOCTH KJTaBHIII.

Haskare KHOIKM NPUBOJIUT K BBIMOITHEHNIO KOMaH/IbI WJTH
TIOCTIE/IOBATEIILHOCTH KOMaHJ|, KOTOPYIO MOXKHO PEfJaKTHPOBATh B MEHIO
"N3mennts Makpoc". Tloppo6Hyto uHopMatmto cMotpute B "VI3MeHUTH
Makpoc".

HaxxaTyie KHOIKY IIPUBOJIUT K 3aITyCKy CKPUNTA, KOTOPbI MOXKHO
penakTHpoBaTh B MeHI0 "M3menuTs ckpunt”. IlogpoGHyto nH(opMariio
cmotpure B "M3MeHUTH cKpHNT".

HazxaTue KHONKY NPUBOANT K YBEIMYEHNUIO 3HauyeHust DPL

HaxxkaTue KHOMKY NPUBOUT K yMEHbILIEHNIO 3HaueHust DPL.

Haxarue KHOMKY NPUBOIUT K NepekiioyeHnio yposHst DPL.

KHorka jyns nepexmoyenus npopueii.
HaxxaTne KHOTKY IPUBOJNT K TIEPEKITFOUSHAIO HA HOPMAITBHBIIT IPO(HITb.

HaxxaTie KHOTKY IPUBOJINT K TiepeKITroyeHnto npocuneit 1/2/3.

Hakuio Konecka NpUBOAKT K MPOKPYTKE BIIEBO/BIPABO.

7

Ora dyHKums paboTaeT TonbKo B mpunoxkennsx Microsoft Office o
OC Windows 7/Vista.

Haxarue xHonku NPUBOAUT K TPEXKPATHOMY HAKATUIO JIeBOIl KHOTIKY MBIIIIH.

Haxarue KHonku NPUBOAUT K TPEXKPATHOMY HAKATHIO npo6cna.

HaxkaTue KHOMKY NPUBOJKT K 3arycKy Opay3epa 1o YMONYaHUIO.
Hasxartue KHOTIKM IIPUBOJUT K 3amycky Batieit mouToBofi mporpammsi.

HaxaTue kHONK® NPUBOAUT K 3alyCKYy MEAUA-NIPOUTPLIBATEIA IO
YMOJTHAHHUIO.

ITH KHOTKY CTAHOBSTCS KHOTKAMI ynpaBJICHUS aKTUBHBIM METUATITIECPOM.

Haskarue kHomKM NPUBOAUT K yBe!II/I‘{eHI/IlO/ YMEHBIIEHUIO TPOMKOCTH.

Haxarue xHonku MPUBOAUT K BKITFOUCHHIO | OTKITFOYEHHUIO 3ByKa.

Kanbkynsrop Haskatue KHOMKY NPUBOUT K 3aMyCKY NPUIIOXKEHNS "KalbKyIsTop" .
My Computer Hasxatue KHOMKY NPUBOJUT K OTKPBITHIO OKHA "Moil KoMmbroTep".
Disabled BoiGepute 3TOT MYHKT 7151 OTKIFOUYEHHS! BLIOPAHHON KHOMKMY.
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Menio "U3menuts Makpoc"

Onucanne

N3menutn \ |
IlenknuTe 17151 OTKPbITUS MEHIO "MI3MeHUTb Makpoc".
MaKpoc
Taitvmnr YcraHoBuTe (hIaXKOK [ITIs 3aMUCH BPEMEHH MEX/y HaxKaTheM 1 OTIYCKaHHeM

kuonku. (TTo ymomyanmio 12 mc)

IIpu ycTaHoBeHHOM (haxKKe HOBasi MHCTPYKIYs OYAeT BCTaBleHa nepey
Bcrasurh BbIOPAHHOI MHCTPYKLMEil. B mpOTUBHOM cilyyae HOBast MHCTPYKLMS JI0JKHA
106aBATLCS TIOCNIE paHee BBEICHHO .

Crapt* Haxxmure 1151 HaYaa 3aiCcy HAXKATUI KJIABKIL ¥ / WM A€ACTBUI MbIILIH.
Cron HaxxmuTe [j1s OCTAHOBKY 3aNMCH HAXKATHIl KJIABULI W / UK IEACTBII MBIILIN.
Ouncruts Haxmure 17ist OYNCTKH BCEX COXPAHEHHBIX HHCTPYKIIHIL.

Tlepevemenne Haskmure 1715t nepeMelieHnst BBEpX / BHU3 BbIOPAHHbI HHCTPYKLUN,
BBepXx/BHI3 '
apepxkka . . .
ey Korpa ¢aaxok Timing cOpoLieH, BpeMeHeM 3aJiep>KKH JIst BCeX JefCTBUi
KoMaHzaMH Oy/eT 3HaueHue, BbIOPAHHOE U3 BbINAJAIOLLEro CIUCKA.

Hukn 3aryckaer Makpoc MpH MEPBOM ILETUYKE U OCTAHABIMBACT MPK BTOPOM.
OroHb 3anyckaeT Makpoc NMPH OJHOM IIEUKE.

Ynepxusatb 3anyckaeT MakpoC NMPH HAXKATHUN KHOTIKH W OCTAHABIIMBAET TP OTITYCKAHIN
OrOHb KHOTKH.

IKenopT Haxmure Jjist COXpaHEHNs TEKYIIEr0 MAKPOCA Ha KECTKHIA TUCK.

HNmnopr Haxmnre Ji7ist 3arpy3Ki Makpoca ¢ KEeCTKOTO JIHCKA.
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Memio "V3mennts ckpunt"

Iy
W3menutn
CKpUNT

KThI

Taimunr

Bcrasuth

ITyck
Cron
OuncTuth

Iepememenue
BBEpX/BHU3
3apepxkka
MexXy
KOMaHamMu

ukn
Oronp

YnepxuBath
OTOHB

IKcnopT

Nmnopr

HCaHue

lenkHuTe s OTKpeITHS MeHiO "W3MernTs cKpunT".

YcranoBuTe (hriaxkoK s 3aIUCH BPEMEHH ME3K/TY HaKATHEM U OTITYCKAHIEM
kHonku. (ITo ymomyanuto 12 mc)

IIpu ycTaHOBIEHHOM (hiiaskke HOBast MHCTPYKLs OY/IeT BCTaBJIeHa nepeyy
BbIOPAHHOIT MHCTPYKIWeil. B pOTHBHOM cilyuae HOBast HHCTPYKIMS JIOJKHA
JI0OABIIATHCS MOCE PAHEe BBEJICHHON .

Haxwure 717151 Havas1a 3anmucy HaxkaThil KJaBuLl 1 | nm HeﬁCTBHﬁ MBILIH.
Haxmure JUISl OCTAHOBKH 3aMKMCH HAXKATUI KJTaBUIL 1 [ um NEACTBUI MBILIN.
Haxwmure JUIL OYMCTKHU BCEX COXPAHEHHBIX HHCprKL[V]f;L

Haxkmure st nepemertieHnst BBepx / BHU3 BHIOPAHHbII MHCTPYKLHA.

Korpa ¢naxok Timing cOpolueH, BpeMeHeM 3a1epKK1 1715 BceX AeHcTBUi
Oy/eT 3HayeHue, BbIOPAHHOE U3 BBINAJAOIIEro CIMCKaA.

3a.HyCKB.CT CKPHIIT NPU NEPBOM IIETUKE 1 OCTAHABIMBAET IPU BTOPOM.
3a.HyCKB.CT CKPHIIT MPU OTHOM LIECTIKE.

HOBTOpeHI/Ie CKpHUIITA MPYA HAKATUKM HA KHOIIKY U U OCTAHOBKA NMPU OTITYCKaHUN
KHOIIKH!.

Haxmure s coXpaHeHus TEKYILEro CKPUNTA Ha KECTKUI JINCK.

Haxxmure 7151 3arpy3Kil CKpUIITa C KECTKOTO JIICKA.
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HOIIK.T[IO‘ICHI/IC K C€TH I/IHTepHeT

IIpoBosiHOE MoK TIOYEHNE

C momompio ceTeBoro Kabenst mopkmounte Bamr kommbtorep K DSL/kaGenbHomy MopeMy mim
JIOKAJIbHOM CETH.

=
=
>
Iopknouenne yepe3 DSL/kaGenbHbIit MogeM o
Inst mopkmoyenus yepe3 DSL/kaGenbHbiit Mozem: A~
1. Hacrpoitre DSL/kaberbHbIi MOEM.
% st momyydennst nHopMarun oGpaTUTeCh K JJOKYMEHTALMH, NOCTaBseMoil B Kommiekte ¢ DSL/
- KaOeJbHbIM MOJIEMOM.

2. Topkmounre ofuH KoHel, ceTesoro kabens kK LAN nopry Ha 3ajiHeit nanesu Baero komnbrorepa,
a pyroit korer| Kk DSL/kabensHOMY MofeMy.

3. Bxuounte DSL/kaGenbHblit MofieM 1 Bai kommbroTep.

4. CkoHurypupyiite napaMmeTpbl s NOAKMOYEHHS K ceT IHTepHeT.

/ st nomyuennst noapoGHOi MHGOPMALMHI MM NTOMOLIM B CO3[JaHUK MOAKIIOUeHNst K cetn MHTepHeT
- o6parurech Kk Bawemy nposaiinepy (ISP).
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Iopkmouenne yepe3 gokanpHyI0 ceTh (LAN)
Jlnst nopkroueHus yepes JokanabHyio ceth (LAN):

1. Topkmounte ofuH Kokel cereoro kabdens kK LAN nopty Ha 3ajiHeii naHenn Barero komnbrorepa,
a JIPyroii KOHell K JIOKAJIbHOI CeTH.

2. BximounTe KoMIbIOTED.

3. CkoHcpurypupyiite mapameTpbl s NOAKIOYEHUS K ceTu IHTepHeT.

/ H.Tlﬂ ToTyYeHUs ITO}Ip06HO]7[ ]/IHq;)OpMaLU/H/I WA MIOMOUIX B CO3/1IaHUH TOAKIOYEHNUSA K CETU I/IHTCPHCT
/ 06paTHTECh K CCTEBOMY IMIHICTPATOPY.

144 I'naga 5: ITopkmoyenne K cetnn MHTEpHET



BecnpoBoHoe nogkioveHne (TOJIbKO HA HEKOTOPbIX MOJIEISX)

TNopxmounTe KoMnbioTep K ceTd MIHTepHET uepe3 NPOBOAHOE NMOAKIIOUEHNE.

R Jnst ucnonb30BaHKs GECIPOBOJHOTO MOAKIKOYEHNS, Bam HyXXHO MOJKITIOUMTBLCS K GECIpOBOJHOI
Touke fjoctyna (AP).

Jlns ycraHoBKM GeCPOBOIHOIO TMOJKIIOYEHNSI BOCHOAB3YNTECH OJHAM M3 CJIEYIOMMX
CIoco0oB:

nim

ASUS CG8580
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/ *  Jlna ynyuenus 6ecnpoBOHON CBsA3M nojKkmounTe Bremnye anteHHbl K ASUS WLAN Card.
+ TloMecTuTe aHTEHHbI HA BEPXHIOIO YaCTh KOPITYCa KOMITBIOTEPa .

* BHelHKe aHTEHHDI SBIISIOTCS JIOTOJIHUTEIbHBIMU aKCECCyapaMu.

Jlnst nofKI0YeHus! K GeCpOBOHOI ceTH:

1. Haxmure HKOHKY CeTH u B 0071aCTH yBE[JOMIICHHII 7l IPOCMOTPA AOCTYIHBIX GeCTPOBOHBIX
ceTeil.

2. Boibepure GecnpoBofHyio ceTb, K KOTOpoil Bbl emaeTe MOAKMIOUNTBLCS M HAXMUTE
IopkmounTs.

3. Ipu focTyne K 3aliyiieHHoi 6eCIpOBOAHON CETH BBEAUTE NAPOJIb HIIM CETEBOM KITIOY 1 HAXMUTE
OK.

4. JloxauTech NOAKIOYEHNS K GECTIPOBOJIHO CETH.

5. BecnpoBoHoe MOAKIIOUEHNE YCTAHOBIEHO. DTa HKOHKA 0TOOPaKAeT COCTOSHIE MOJKMOUSHUS U

MOIIHOCTH CUTHAJIa MPOBOTHOT'O UJTA 6CCHp0BOJIHOI‘0 TIOAKJTFOYCHNS| craryc.
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Ucnoan3oBaHue yYTniauT

Support DVD n DVD-BoccTaHoBIeHYst MOTYT ObITh He BKIIOUEHb] B KOMILIEKT MOCTABKHU. [171s co3nanus
Support DVD 1 DVD-BoccTaHOB/IEHMs MOXHO MCTIONB30BaTh Pasjien BoccTaHoB/eHus. lofpobHyro
nHOPMALMIO CMOTpHTE B pa3jielic BoccTaHOBIEHHe CHCTEMBI 3TOIT IVaBbI.

ASUS AI Suite IT

ASUS AI Suite II sBnsiercst yoOHbIM HHTEPGENICOM, KOTOPbII 00benHseT Heckolbko ASUS yTumur u
TI03BOJISIET UCTIONB30BATD 3TH YTHINTHI OTHOBPEMEHHO.

Hcnoas3oBanne Al Suite 11

Al Suite IT aBromatnuecku 3amyckaercst npu Bxope B OC Windows. Vkouka Al Suite II nosiBnsercs B
obnactu yBegomnennii Windows. Haxkmurre HKOHKY Anst OTKpbITHS TTaBHOTo MeHto Al Suite I1.
Hcnonb3yiiTe KHONKY 1St BLIOOPA M 3aMyCcKa YTUIUTI, /171l MOHUTOPUHTA cUcTeMbl, 00HoBNeHns BIOS
MAaTepHHCKOI1 IIAThI, 0TOOpaXKeHUs CHCTeMHOI MH(opManuy, a Takxke st HacTpoiiku Al Suite I1.

Haxmnre st nozydenns
nupopmaumn 06 ASUS

Haxmure s
oGHosennst BIOS
MAaTepHHCKOI IIaThl

Haxwmure 151 BBIGOpa
YTHINTBI

HaxmuTe 2151 MOHHTOPHHTA Haxmure poist Haxmure nuist
JaTYMKOB WJIM 4aCTOThI oTOGpaKeHust H3MEHEHNs! HACTPOEK
npoueccopa HH(OPMALNH 0 CHCTeMe nHrepdeiica

R « HaGop npunozxenuii B MeHto Tool MOXKET OTIIMYATBCS B 3aBUCUMOCTH OT MOJIEITH.

« W3o6paxenus Al Suite IT npuBejieHbI B 03HAKOMUTEIBHBIX LESIX.

ASUS CG8580
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Menio Tool
Metto Tool Bkmouaer nanesu System Level Up, Probe II, Sensor Recorder n Ai Charger+.
System Level Up

System Level Up nossomster pasronsits cuctemy B8 OC Windows ¢ MOMOIIIBIO HACTPOEK MPOIIISL.
s 3anmycka System Level Up naskmure Tool > System Level Up B rmasnom mento Al Suite I1.

B HacTpoiikax (hyHKUMM Ha3HaubTe ropsiuMe KIABMILUM JiIs MepeKioueHus npocuneil. Bbl Moxere
Ha3HA4YuTb ropsiume KiaBuiM BpyuHyto. ITofpoOHyto nH(OpMaLo CMOTPUTE Ha PUCYHKE HILKE.

=
=

HJIﬂ pasroHa CUCTEMBI CYLIECTBYET JIBa croco6a:

BIOS

B BIOS Setup soi6epure AI Tweaker> System Level Up, 3atem BbiGepute HyKHYIO OMIMIO.

Kuonka OC

Haxxmure kronky OC B BepXHeM JIeBOM YIITy NepefHeil aHeu.
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3anyck u KoHurypamus Probe II

Probe II - yTunuta, KoTopas CIIEUT 32 KU3HEHHO BaKHBIMU KOMIIOHEHTAMU KOMIBIOTEPA i COOBIIAeT
Bam 0 11106bIX po6remMax cBsi3aHHbIX ¢ HUMH. Probe II KoHTponmpyeT ckopocTb BpallieH!st BEHTUIISTOPOB,
TeMnepaTypy MpoLEeccopa, HanpsKeHue B cucTeMe U MHoroe fipyroe. C MOMOILIBIO 3TOl YTHIUTBI Bbl
MoKeTe ObITh YBepeHsI, UTo Bar koMmbioTep Beerna HaxORUTCst B paboueM COCTOSHITH.

Ilns 3anycka Probe II:

. Haxwmmure Tool > Probe II B rimaBiom mento Al Suite 11

[lns kondurypauuu Probe II:

. BeiGepure Briasiky Voltage/Temperature/Fan Speed fiist aktiBauui JaT4nKoB Win HACTPOHKH
NIOPOrOBbIX 3HAYEHUIT JaTUMKA.

. Ha Bknajike Preference MoXHO HACTPOUTBH BPEMEHHOI MHTEPBAN NIPEAYNPEKIEHUI AATYNKA UITH
M3MEHUTD EIHULb! U3MEPEHNs TEMIEPATYPb.

Coxpanenne
KOHcpurypanmn
‘YcranoBKa noporosbix I .
3arpyska no y a
COXPaHEHHOI JUIs1 KQXK0T0 JaTYMKA
KOH(urypaumun
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3anyck u Kongurypauus Sensor Recorder
Sensor Recorder mno3BossieT OTCNEKMBATh W3MEHEHUsI HalpsKEHus, TEMNEpPATypbl U CKOPOCTH

BEHTHIIITOPA, & TAKXKE 3AIHCHIBATS NX.
IIns 3anycka Sensor Recorder:

. Haxwmnre Tool > Sensor Recorder B rmasaom mento Al Suite I1.

IIns kondurypauuu Sensor Recorder:

. Bei6epure Bknagky Voltage/Temperature/Fan Speed u BbiGepuTe AaT4nKu /i MOHUTOPHHTA.

. Ha Bxnanke History Record MoskHO 3amichIBaTh N3MeHEHHs! BBIOPAHHBIX JATUNKOB.

BriGepurea
s MOHMTOPI’IHI‘a

Tleperamure

1S IPOCMOTpa
COCTOSIHUS

B TeYeHHe
Onpefie/IeHHOro
nepHoja BpeMeHn

Haxmure st
MacuTagupoBaHus No
Haxwure st ocn Y
MacITagupOBAHMs MO
ocu X

Haxmure st
BO3BPATAC B PEXUM
0 YMOTYAHHIO
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3amyck u Hacrporika Ai Charger+

Ai Charger+ nossonser 3apsxatb USB-ycTpolicTBa, coBMecTHMble co cnienudukanueii Battery
Charging Version 1.1*, B Tpu pa3a 6bicTpee™*.

R . * TIposepeTe, uTo Bame Mo6unbHOe USB-ycTpoiicTBO, OTHOCTBIO MIOAAEPKUBACT (DYHKIIO
BC1.1.

e *¥ QakTHyecKas CKOPOCTb 3apsyIKi MOXKET M3MEHSThCS B 3aBHCHMOCTH OT coctostmst USB-
YCTpOIICTBA.

e Tocne Bkmouennst mam otkmouernst Ai Charger+ oTkmounte 1 cHoBa nopkiounte USB-
YCTPOICTBO.

Ins 3anycka Ai Charger+ naxxmure Tool > Ai Charger+ B riaBHom meHto Al Suite I1.
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Menio Monitor

Menio Monitor Bkirovaer B ceGst manenan Sensor u CPU
Frequency.

3amyck Sensor

ITanennb faTUMKOB OTOOPaXKAET TeKyllee 3HaYeHNEe CUCTEMHbIX JATYMKOB, HAPUMEP CKOPOCTD BPAILEHUs!
BEHTWIATOPOB, TEMNEPATYpa NPOLECCOPa U HANPSPKEHUE MATAHUA.
Jlns 3amycka Sensor:

. Haxwmure Monitor > Sensor B riasHom mento Al Suite I1.

3anyck CPU Frequency

[TaHestb YacTOTBI MpoLeccopa 0TOGPaXKAET YaCTOTy M YPOBEHb 3arpy3KH MPOLEccopa B MPOLEHTAX.

Ias 3anycka CPU frequency:

. Haxmure Monitor > CPU Frequency B riaBHom Metto Al Suite I1.
Pesnpent Ha npagoii nanesn (061acTh HH(OPMALKH 0 CHCTEMe) Manens Taness yacToThI
JATYHKOB nponeccopa
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Memnto Update

Mento Update no3sosisiet 0GHOBIATE BIOS MaTepuHCKO# MiaThl 1 10roT

ASUS Update

ASUS Update - yrunura, nosponstomasi Bam coxpansts 1 o6HoBnsTs BIOS MatepuHcKoii niathbl B
Windows. Ytumra ASUS Update nosponsier o6HoBnsATs BIOS HenocpenctBenHo u3 cetn MuTepHer,
cKkaunBaTh mocnefHio Bepcnto BIOS u3 cetu Wutepuer, o6HoBnsTh BIOS u3 chaiina, coxpausrb
Tekyuwit BIOS B ¢aiin u cMotpeTs nHopmaumio o epcun BIOS.

O6uosnenne BIOS yepe3 Mnrepuer
st o6HoBNnenust BIOS yepe3 UnrepHer:

1. Ha skpane ASUS Update sbiGepure Update BIOS from file, 3aTem naxxmure Next.

s

2. [lnst yMeHblueHNst ceTeBOro Tpaguka
BbiOepute 6maxaiiumit ASUS FTP cepsep.

YcraHouTe (hIIaXKH €CIM XOTUTE BKIHOYUTD
ynkuum BIOS downgradable n Auto-BIOS
backup.

3. Bri6epute Bepcuto BIOS pist 3arpysku,
3ateM Haxmute Next.

Ecnu HoBast Bepcust He oGHapy>KeHa,
TIOSBUTCS COOTBETCTBYIOLIEE COOOLIEHHE.
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4. Haxvure Yes, ecim XOTHTE H3MEHHTDH
JOTOTHN,  OTOOpaXKaeMblil  BO  BpeMs
camorectuposanmst (POST). B nporuHoM
caryyae, Haxmire No.

5. CrnenyiiTe MHCTpYKLMSIM Ha 9KpaHe ms
3aBeplLeHNs] IIpoLiecca OOHOBNIEHNS.

O6Hosnenue BIOS u3 daitna
st ooHoBenust BIOS u3 ¢aiina:

1. Ha skpane ASUS Update BbiGepute Update
BIOS from file, 3atem naxkmure Next.

2. B otkpbiBiuemcst okxe Haiigure aiin BIOS,
Haxkmure Open, 3aTem Haxkmute Next.

3. Haxxmure Yes, ecnu XoTuTe N3MEHUTH
JIOrOTHI, 0TOOpaskaeMblil BO BpeMmst
camorectuposanust (POST). B mpoTuBHOM
ciyyae, Haxmute No.

4. CrieptyiiTe HHCTPYKLWSIM Ha 9KpaHe Anst
3aBepLIEHUs IIpoLecca OGHOBCHNS.
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Ikpan System Information

Skpan System Information oTo6paxaeT MH(OPMALIIO O MATEPUHCKOI
T1aTe, NPOLECCOPE U COTAX NaMsTH.

. BoiGepure Bknagky MB n1s npocmoTpa
noApo6HOI MH(opMaLUK 06 U3rOTOBUTENE
MAaTePUHCKO M1AThI, HA3BAHUH MIPOJYKTA,
Bepcuu 1 BIOS.

. Bri6epute Bkiagky CPU ans npocmotpa
TIo/IpoGHOIT MH(pOPMALH O TpoLeccope 1
K3llle.

. BriGepute Bkiajgky Memory, 3atem
BbIOEPUTE CIOT MAMSITHU 7St POCMOTpa
noapo6HOil MH(OPMALUK 00 YCTAHOBIECHHOM
B 3TOT CJIOT MOJyJIe NaMSITH.
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. BroiGepute Bkiaky JMCK, 3aTeM BbIGEpUTe
JWICK 17151 IOy YeHNsi OAPoGHOI MH(popMaLmn
0 HeM.

Ikpan Support

Ha akpane nopiep>xki oTo6paskaercst HHpOpMaLyst
o caitrax ASUS u KoHTaKkTHast nH(OpMALKs.

IkpaH Settings

Ha skpane Settings MOXHO HACTPOUTE IAPAMETPBI IVIABHOTO MEHIO
¥ BUJL MHTepdherica

. Application no3onsieT BIOPaTh NCMONb3YEMbIE PUITOKEHHS.

. Bar no3BosseT H3MEHHTb HACTPOHKH TTAHEH

. Skin TO3BONSET HACTPOMTH KOHTPACTHOCTb, SIPKOCTb, HACHILIEHHOCTb, LBET M TaMMy
uHrepdeiica.
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ASUS AI Manager

ASUS Al Manager - yTuiuTa, NpefoCTaBisiolias OBbICTPbIA JOCTYN K YacTO MCMOJIb3yEeMbIM
TIPUIIOKEHHSIM.

3anyck Al Manager
Jlns 3amycka Al Manager naxmure Ilyck > Ilporpammsr > ASUS > AI Manager 1.xx.xx > Al
Manager. Ha paGouem cTosie nosiBUTCS Manesb ObicTporo 3amycka Al Manager.

IllenxkHute mpaBoii KHOMKOM MO MKOHKE YIS MEPEKIIOUEHUs] MEXy
TaHeJbio ObICTPOro 3arycka M TJIaBHbIM OKHOM, & Tak:Ke Jijist Bbloopa
cnocoba 3anycka Al Manager.

Switch to Quick Bar
Switch to Main Window

Start at Quick Bar
v Start at ToolBar

Exit
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Al Manager naseJpb ObICTPOro 3amycka

IMauens 6eicTporo 3amycka Al Manager no3sonser Bam 3amyckate ASUS yTHINTEI Wi 0TOGpaXKaTh
cHcTeMHyto nHpopmauyto. [ oToGpaxkeHust CoepXKUMoro BbibepuTe BKIajKy ['naHasi, M36patHoe,
Topnepsxka nm uHopMaLys.

Boixon

-PazsepHyTh

Topnepxka

W36pannoe Mndopmanus

Haxvure knonky PassepryTs [l /1151 NEpeKITIOUeHHs MEX]Ty MAHEIbIO0 GLICTPOrO 3aMTyCKA 1 IMABHBIM
okHom. Haxmure kronky Crepryts JEl [Tns ceeproiBanms Al Manager B manesb 3ariau. Haxwmire
KHOTKY 3aKpbITh [kl 7111 BbIX0fia 13 Al Manager.

Main

B rnasrom mento Haxopurest Tpu yrumaTsl: Al Disk, AI Security u AI Boosting. [ BiGopa yTémuTb
HaXMUTE CTPEIIKY B TIPABOM HUKHEM YTiTy.

i O @ &

Haxmure ansa OTKpblTﬂﬂ

Al Disk

Al Disk nosponsier Bam yjanmts BpeMeHHbIe (hailiibl, KyKu, HCTOpHIo, ajipeca IE nm ouncTuts
kop3uny. lllenkuure no nkonke Al Disk st oto6paskenus oksa Al Disk u BbiGopa mapameTpos.
Koryia 3akonunre, Haxkmure [IpumMeHnTS.

&9

@ foae | [ MBI

| | P W i s i
e

| [ Chun! P £ Fin [ Sma: B UL History
L
- || ches 0 cockies [ chean F vasion
[ Shew Mesrcie B [ Chea Receriis Opessd Fes
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Al Security no3sonsier Bam ycranosuTs napons jiist 3ammrsl Bammix ycrpoiicts, Hanpiumep USB,
CD/ DVD-[CKOB OT HECAHKIMOHHPOBAHHOTO IOCTYTA.

Jlnst GIOKMPOBKM YCTPOVICTBA BBINMOJIHUTE CIIe/yIomIee:

1. Tlpu mepsom 3amycke Al Security Bam mpeioar ycTaHOBHTH Mapoib. Beeute mapoib,
copepkatmit o 20 asncpaBiTHO-1MPOBBIX CUMBOIIOB.

TopTreepauTe Mapodb.
Bsepire nopickasky (pekomeHfyeTcs).

4. Korya 3akonunre, Haxkmure OK.

1| oy ranpse e oo o e s o i
[ S—
gl b el i g 4 T P
[e— !
= g s aa pap T

Pl raw s paed brd

BoiGepute ycTpoitcTBo 1151 6110KMpoBKY 1 Haxkmute [IpuMeHnTs.

6. Baepure ycraHOBICHHBII Maposb, 3aTeM Haxkmute OK.

U et o e g e o i b
[— st
‘ t— T — |

)
i;

[TV T— e

Jlns1 pa30I0KMPOBKM yCTPOVCTBA:
1. Cuumure hriaxok ¢ 3a6JI0KHPOBAHHOTO YCTPOCTBA, 3aTeM Haxkmute [IpumMeHuTs.
2. Baejure ycTaHOBJIEHHBII Mapodb, 3ateM Haxmure OK.

Jlns u3MeHeHus napos:

+  Haxymre Change Password, 3aTeM crefyiiTe MHCTPYKUUSIM Ha 3KpaHe [ISI CMEHBI
naporns.
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Al Booting no3posnsieT Bam ycTaHOBUTB IPUOPUTET YCTPOHCTB NPH 3arpysKe.
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H.Tli[ M3MEHEHHMs NMPUOPUTETA 3arpy3KH BBINOJTHUTE CIeAyloLiee:

1. BsiGepure ycTpOMCTBO, 3aT€M HAXXMUTE KHOTIKY BIPABO/BIEBO /7Sl CMEHbI IPHOPUTETA
TpH 3arpys3Ke.

2.

Korpa 3akonunre, Haxxmure [IpuMeHnTS.

HN36pannoe

M36panHoe no3sossier Bam J06aBUTD YaCcTO HCTONB3yeMble IPHIIOXKEHHS], TO3BOJISIS CAKOHOMHTb BPEMst
Ha MX TIOUCK.

HJ’lﬂ JIOGHBI[QHP[H NPUJIOKEHUSA BBIMOJHHUTE CIIEAYIoLee:

1. Haxwure [l06aBuTh, 3aT€M HAiITE NPUIOXKEHNE, KOTOpOe BbI X0THTE 106ABUTH B
N36pannoe.

2. Hasxmure Open B okHe noucka. [Ipunoskenue fo6asnexo B Fi36panHoe.

IllenKHUTe NPaBOil KHOMKOIL 10 MKOHKE IPUIIOXKEHHS ISl 3aIlycKa, yAaNeHus], IepenMeHOBAHMSI
BbIOPAHHOTO NPUIIOXKeHUs. [IBOHOM LIETYOK MPUBEMIET K 3aMyCKy BHIOPAHHOTO MPUIIOXKEHNS.
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Ioppepxka

Illemyox no mo6oii ceblke B okHe Support npuseneT Bac Ha caiiT Texumueckoil nogaepxku ASUS u
TIOKaKEeT KOHTAKTHYIO HH(POPMALIHIO.
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Nndopmanus

Haxmnre Bkiaaky B okne MHopmanus st mpocmoTpa nopo6Hoil nHgopmamm o Barmeit cucteme,
MaTtepUHCKOI1 niate, npoteccope, BIOS, ycTaHOBNEHHBIX YCTPONCTBAX U MAMSITH.

—

O~ favakEyd
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Nero 9

Nero 9 no3BoJisieT CO3[aBaTh, KONMPOBATD, 3ANMUCHIBATD, PEAKTHPOBATH K OOHOBISITH PA3THYHbIC BH/IbI
TaHHBIX.

b tashks quickly
and easily

d
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et
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B et~ =
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Ycranoska Nero 9
Jlns yeranosku Nero 9:

1. Bcrasbre Nero 9 DVD B onTiueckuii piBojI.

2. Ecau aBT03amycK BKIIIOYEH, TIOSBUTCS MEHIO YCTAHOBKH.
Ecam aBTo3amyck He BKITIOUEH, ABAXK/bI LIEIKHATE 1O (haiimy setup.exe, HAXOMAIIEMYCSl B KOPHEBOIT
jmpekropun Nero 9 DVD.

3. B rnasHom mento Haxxmute Nero 9 Essentials.
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4. Bri6epuTe s3bIK, HCONb3yeMblil B MacTepe ycTanoBku. Haxvure [lanee.

5. Haxxmure [lanee 15 pojloJKeHust.

Flewin snle o teviel mandes ko den  Tyarirlals

R AR LM I TR AR o

[T Er—

Wt P e e R b 1 e
L A e e e i iy
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7. Bri6epute Typical, 3aTem naxxmute Next.
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Ycranosute ¢hnakok Yes, I want to help by sending anonymous application data to Nero,
3ateM Haxkmute Next.

[T N —

W e e e o8

9. Korya 3akonunre, Haxmure Exit.

P
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3anuce (aiinos
Jlns1 3anmcn cpaiinos:

1. B riassom menio Haxxmute Data Burning > Add.
rm - it || S L T e
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2. BriGepute daitbl A 3ammcu. Korpa 3akonunre, Haskmute Add.
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3. Iocne BbiGopa haiinos Haxxmute Burn st 3anicy ¢aitnos Ha UCK.

B PR PR R S I 5%~ | ¢ |

- f:J_ B f:_i s -

% HOHOHHMT@ILH}/IO I/lH(bOPMaI.[MIO TI0 MCTIONb30BaHuo Nero 9 CMOTpUTE HA caitre Nero Ha Www.nero.
com
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BoccTanosiienme cucTeMbl

HUcnoab3oBanne pasaejia BOCCTaHOBJICHUS

Pa3sienn BOCCTaHOBIIEHNS! MpEJOCTABISIET BO3MOXHOCTb OBICTPOrO BOCCTAHOBIIEHUs! MPOTrPAMMHOTO
ofecrneyeHust Ha KOMIbIOTEPE B €10 OpUTrMHANbHOE pabouee cocTosHue. [lepest uenomb30BaHueM pasjiena
BOCCTAHOBJIEHUs cKomupyiite Bamm janHble Ha USB-Hakomurtenb umm ceTeBOll JIUCK M 3amuMILATE
napameTpbl KOHUrypauui (Hanpumep ceTeBble apamMeTphbi).

O pasnenie BOCCTaHOBJIEHHSI

Pa3uen BOCCTAHOBJIEHUA - 3ape3€pBMPOBAHHOE MECTO Ha 2KECTKOM JIUCKE, HCNOJB3yeMOE i
BOCCTAHOBJICHUS CUCTEMBI, yCTaHOB.TICHHOﬁ Ha 3aBOJiC.

R He ypansiite pasjen ¢ Ha3BaHHEM
RECOVERY. Pa3jien BOCCTAaHOBNCHUS ©u sip rewass
CO3/IaH Ha 3aBOJIC U TIPH Y/IAICHUH HE MOKET = r==_
GbITh BOCCTAHOBJIEH ToMb30BaTeneM. Ecrn y
Bac npoGuieMb! ¢ MpoLieccoM BOCCTAHOBMEHHUS,
ornecure Bar nactonsubiit [TK B cepBrcHbIi
neHTp ASUS.

Hcnonb3oBanue pasaesia BOCCTAaHOBJICHUA:

1. Haxkmure <F9> npu 3arpy3ke.

2. Haxwmure <Enter> jyist Boi6opa Windows Setup [EMS Enabled).

3. Boi6epute oiHy U3 CleyIOMX ONLHIL.
System Recovery:
Ora (yHKUMS MO3BOJISET BOCCTAHOBUTB CUCTEMY K 3aBOJICKMM HACTPONKAM IO YMOTYAHHUIO.

System Image Backup:

Ora (pyHKLWS NO3BOMISET 3amicaTh 00pa3 cucTeMbl Ha DVD-1uicK, KOTopblii B JaIbHEILEM MOXHO
Oy/ieT HCNOIb30BAT 17151 BOCCTAHOBIIEHHUS! CHCTEMBI.

System DVD Backup:
Ora (hyHKUMs MO3BOJISIET CIENATh Pe3epBHY!o Koo support DVD.

4. CrepyiiTe MHCTPYKISIM Ha 3KpaHe JUIsl 3aBepIICHUs PoLecca.

% st 0oGHOBNEHus ipaiiBepoB 1 yTint nocetute caiit ASUS www.asus.com.
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HUcnons3osanne DVD-BoccTaHoBIeHNUs (HA HEKOTOPBIX MOJIENISX)

% st cospannst DVD-BoccTaHoBIeHNs TIOAroTOBbTe 1~3 uncThIX 3anmchbiBaeMbix DVD-muicka.

Hepen BOCCTaHOBJIEHHEM CHCTEMbI OTKITFOUNTE BHEILTHWIT KECTKHUI JIUCK. BeiMokeTe TIOTEPATH Ba2XKHbIE
JanHble npy ycraHoke Windows Ha ipyroit ek niu hopMaTUpOBaHUM pasjiela.

Ilast ucnonb3osanusi DVD-BoccTaHoBIeHHST:

1. Berasbre DVD-BoccTaHOBIEHMS B onTiyeckuil puBojl. Bai HactoubHblit 1K fomkeH ObITh
BKJIFOUEH.

2. Tepesarpysure Hacronbhbli [TK, mpu 3arpyske Haskmute <F8> n BbiGepuTe onTudecKuit puBoj
(mMoxer 6bITh 0603HaueH kak “CD/DVD”), 3atem Haxmure <Enter> jisi 3arpysku ¢ DVD-
BOCCTAHOBJICHHSI.

3. Boibepure OK jnst 3amycka npouecca BOCCTaHOBIICHHS.

4. Bri6epute OK 7151 TOATBEPXKACHUS] BOCCTAHOBIICHHS CHCTEMBL.

HPOHCCC BOCCTAHOBJIEHHA YAJIUT BCE TAHHLIC HA 2KECTKOM JIUCKE. HCPC)] BBINOJITHEHUEM BOCCTAHOBJICHUSA
CUCTEMBI, y6e;1mect>, 4TO BCE BAXKHBIC IaHHbIE COXPAHEHBI HA BHEIIIHUX HOCUTENIAX.

5. CrneptyitTe HHCTPYKLMSM Ha 9KpaHe JIs 3aBepLLUeHus poLecca.

He u3Bnexaiire jiick BOCCTAHOBIICHHs! (MacTep BOCCTAHOBIICHUS! HE TOMPOCKT 3TO CAENATb) BO BPEMSI
TpoLecca BOCCTAaHOBJIEHUS, NHAUEe Bam paznen 6y)]€T HCTIOPUCH.

% st oGHOBNEHUs ApaiiBepoB 1 yTuauT nocetute caiiT ASUS www.asus.com.
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YcrpaHeHne HeMCIPaBHOCTEH

YcTpaHeHue HercnipaBHOCTEN

B 37011 rmaBe npeficTaBieHbl HEKOTOPbIE MPOOJIEMBI, KOTOPbIE MOIYT BOHUKHYTH U BO3MOXHBIE MYyTH
X pelleHus.

=
? Mori komnboTep He BKII0YAE€TCS H HHIHKATOP MHTAHAS HA MePeJHEH NaHeTH E
He ropur 5]
>
. ITpoBepbTe MPaBUILHOCTD NOJKITIOYEHKs Balero KoMnbroTepa. A
. IIpoBepbTe po3eTKY.
. IIpoBepbTe, uTo 610K MUTaHKS BKIOYeH. [TofpoOHyto nHopMaLyo cMoTpuTe B

pasjene Bkiouenune/oTKI0ueHue KOMIMBIOTEPA B I1aBe 1.

?  Moii komnsiotep 3agucaer.

. J17151 3aKpBITHS IPOTrPaMM, KOTOPbIE HE OTBEYAIOT BBINONHUTE CICYIOLUE CHCTBIS:

1. OpmoBpemenHo Haxkmute Kiasuim <Alt> + <Ctrl> + <Delete>, 3aTeM HaxkmuTe
3amycTnThb [UCTeTYep 3a8aY.

2. Buibepure Bkiaaxy Ipunoxenns.

3. BsiGepure nporpamMmy, KOTOpasi He OTBEYAET, 3aTeM HaxkmuTe CHATH 3apa4y.

. Ecm knaBnarypa se otBeyaet. Haxxmure u ynepKiBaiiTe KHOMKY MUTaHNS Ha
BEpXHell YaCTH KOpITyca, MOKa KOMIIBIOTEp HE BBIKJIOUMTCS. 3aTeM HAKMHUTE KHOIMKY
TTMTAHNS [I7Is1 €70 BKIFOUCHHIS.

? A1 He Mory MOIK.TIOYATHCA K OecripoBogHoH ceTH ¢ momousio ASUS WLAN

Card (To.15K0 Ha HEKOTOPBIX MOJETAX)?

. Y6enurech, uTo Bbl BBeM NpaBUITbHBIN KITIOY 1715 IOAK/IIOUEHHS K 6€CTIPOBOAHOM
ceTH.

. st yayuiuennst GecrpoBOJHOI CBSI3U MOJKITIOYMTE BHELIHUE AHTEHHBI (IOCTABIISIIOTCS
onmuoranbHO) K ASUS WLAN Card 1 pacrionoskute IX Ha BepXHeil 4acTi Kopryca
KOMIIbIOTEpa.

9 He paGoralor KAaBHiH co CTpeIKaMH Ha HH(POBOH KJIABHATYPe.

Y6emurech, uro unukarop Number Lock e ropur. Korna nngukarop Number Lock
TOPUT, KIIABUILN Ha LI(pPOBOIl KIABHATYPE HCMONB3YETCs TOMBKO /ISl BBOAA YHCENL.
Eciu Bol X0THTE HCIIOMB30BATH KIIABKIII CO CTPEJKAMI Ha IpPOBOIT KITABHATYpE,
Haxxmure Knapuuty Number Lock s BBIKIIOYSHHS MHMKATOPA.
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Her n300pakeHHsr HA MOHHTOPE.

. Y6eaurech, YTO MOHUTOP BKITIOUEH.

. Y6enurech, 4TO MOHUTOP MPABUIILHO MOJIKIIOUEH K BUIEOBbIXOy Batero
KOMIBIOTEpA.

. Ecnm Baur komnbioTep ocHalleH IMCKPETHOI BUCOKApTOi, yoeauTeck, uto Bl
TMOAKTIOYNII MOHUTOP K BUIEOBBIXOJTY IMCKPETHON BUIEOKAPThI.

. ITposepbTe, HE N30rHYTHI JIM KOHTAKTHI HA pasbeMe. [1pyu 0OHapyKeHU! MOTHYy ThIX
KOHTAKTOB 3aMEHHTE KaOellb.

. Y6epurech, YTO MOHUTOP NMPABUIIBHO MOJKJIFOYEH K MCTOYHUKY MUTAHMS.

. JononuurenbHyto MHGOPMALHMIO O YCTPAHEHUIO HEUCTIPABHOCTE! CMOTPUTE B

JIOKYMEHTAlH, TIOCTABJISIEMOIA C MOHUTOPOM.

? Ipn nenoJb30BaHAN HECKOJIBKHX MOHHTOPOB H300PaXKeHHE TOJIBKO HA 0JHOM
MOHHTOpE.
. Y6enurech, uTo 062 MOHUTOPA BKITIOUEHDI.
. Bo Bpemst POST, u3o6paxkeHne uMeeTcst TolbKO Ha MOHITOPE, NOJKITFOUEHHOM K
VGA pazbemy. [IBa MoHUTOpa paboTatoT ToibKo nof Windows.
. IIpu HamUuwY UICKPETHOH BUAEOKAPTI, YOEUTECh, YTO MOHUTOPLI MOJKIIIOUEHDI K ee
BBIXOfTY.
. ITpoBepbTe NPaBUILHOCTb HACTPOEK Il HECKOMBKUX AucieeB. [logpobHyio
nH(opmanuio cMorpute B pasfiele IlofkmoueHne HeCKOIBKHX MOHHTOPOB I71aBbI 3.
? Moii komnproTep He moxer ooHapyxuth USB-Hakonnre.1s.
. Ipu nopxmoyeru USB-HakommuTens K KoMmbtotepy, Windows aBToMaTHyecku
ycTaHaBIMBaeT 715 Hero fipaiiBep. HemHoro moposkauTe 1 oTkpoitte Moit KoMnbioTep
n y6equrech, yto USB-Hakonmurenb oGHapyskeH.
. Topkmounre USB-HakonmuTeNb K IpyroMy KOMIbIOTEPY 1 yOEAUTECh, 4TO OH
JICTIPaBeH.
? A1 X049y BOCCTAHOBUTH HJTH OTMEHHTb H3MEHEHHS B CHCTEME He 3aTParnBas

MOHX (aiiI0B H JaHHBIX.

Boccranosnenne cuctembl Windows mo3BoisieT BOCCTaHOBUTD MM OTMEHHUTD
M3MEHEHUs B CUCTEME, He 3aTparuBasi Balli JaHHbIe, HAPUMEp JOKYMEHTbI U
cpororpachun. IToppoGuyto MHpopmarmio cMoTpuTe B pasnerne Bocecranosienne
CHCTEMBI [71aBbI 2.
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9P Hckaxeno nzoopaxenne na HDTYV,

. 10 06YCNOBIEHO pa3HbIM paspeieHreM Baiero moruropa u HDTV. Hactpoiite
paspeluenye akpana B cootsercTru ¢ HDTV. [Ins usmenenns paspelienns skpaa:

1. [lns oTkpbiTHs 3KpaHa Pa3pelenne 3KpaHa BbINOIHUTE OJIHO U3 CIE/yHOLIMX

JeficTBIiL: * Haxwure g > ITanens ynpasnenns > Ogopmienue u
nepcoHanu3auus > [{ucnueit > N3meneHue napameTpos
JHCIUIes.

+ IllenkHuTE NIPaBOil KHOMKON HAa CBOOOJHOM MecTe paboyero croda. [Tpn
TIOSIBJIEHNN BCIUIbIBatoero MeHto Haxxmure Iepconammsanus > Jucneit >
H3meHeHne napamMeTpoB ANCILIES.

2. Hacrpoiire pa3pemenne. O6paTurech K foKyMeHTauuu npunaraemoii K HDTV.

3. Haxwmure IIpumennts mwm OK. 3arem Haxkmure CoxpaHuTb H3MEHEHHST U151
TIONTBEPKACHISL.

? Her 3Byka n3 KOJIOHOK.
. Y6enurech, uTo Bbl OAKIFOUMIN KOJOHKH K JIMHENHOMY BBIXOJY (cana’rosmﬁ) Ha
nepeHelt Wi 3ajiHeil naHesm.
. Y6enurech, 4To KOMOHKH NOAKIIOUYEHBI K MICTOUYHUKY MUTAHKS M BKIFOUEHBI.
. OtperysmpyiiTe rpOMKOCTb 3BYKa B KOJIOHKAX.
. Y6equrech, YTO B KOMIBIOTEPE 3BYK BKIIHOUEH.
¢ Ecam oTKII0YEH, NKOHKA TPOMKOCTH OTOOPAKAeTCs B BUIE m . Onst
BKJIFOUEHMSI 3ByKa HAKMUTE m B o6m'm yBejiomsieHnit Windows u HOXKMUTE | #s
e Ecim He BBIKJTIOUEH, HAKMUTE U IEPEMECTHTE TIOJI3YHOK JIIsl PETYIMPOBKI
IPOMKOCTH.
. TloakmounTe KOJIOHKY K IPYTOMY KOMIIBIOTEPY U YOSUTECh, UTO OHM HCTIPABHBI.
? DVD npuBojq He MoxkeT IPOYHTATH JHCK.
. ITpoBepbTe, YTO IUCK BCTABJICH STHKETKOIl BBEPX.
. Y6emuTech, 4To AUCK HAXOJUTCS B LEHTPE JIOTKA, 0COOSHHO JITIsl UCKOB
HECTAaHJAPTHBIX PA3MEPOB WK (DOPMBI.
. Y6enureck, 4To AMCK He NOLAPAIIaH 1 He TOBPE3KJICH.
? He ¢yyukuynonnpyer KHonka n3p/ie4eHns JHCKA.
1. Haskmire 6 > Komnsiotep.
2. [lenkryTe NMPaBOIT KHONKOM , ke = <=+, 3aTeM B MEHIO HaxmuTe M3B1eup.
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IInranue

TpoGema

Her nuranust

[asi NPHYHHA

HeraBI/IJII)HOG Harnpsi>KeHue

JeiicTBue

+ Ecnm xomnbtoTep ocHalleH
TMepeKJIF0YaTelIeM HaMpsKEHNsl,
YCTAHOBUTE €ro B COOTBETCTBHHU C
HanpsikeHueM B Baiuem peruone.

* OrperynupyiiTe HACTPOIKI
HanpsikeHust. Y 6e/IUTeCh, YTO LIHYp
MUTaHUS OTKITIOYEH OT PO3ETKHU.

(nnpmkarop HaxxmuTe KHONKY MIUTAHIS Ha TepefHeit
Ba komnbrorep He
NUTaHUS He NaHe/ U yoeauTeck, 4To Baul kommbroTep
BKITFOYEH.
ropur) BKJIIOYEH.
HenpaBuiibHo mofKMoOUeH * Y0enurech, 4TO LHYp NUTaHUSA
IIHYP MUTaHKs K TOAKIIIOYEH NPABUILHO.
KOMITBIOTEpY. * Vcnonb3yiiTe Apyroil MHYp MUTaHUS.
IMoxanyiicra, 06paTUTECh B CI1yKO!
Tpo6nema c 6;10K0M MUTAHUS YHCTE, OOP; yrOY
TEXHUYECKOI NOJVIEPXKKHU.
Hucnnei
IpoGrema NleiicTBue

Her nzo6paxenns
Ha 3KpaHe 1oce
BKITIOUEHHSI
KOMIIbIOTEpa
(uepHbIit 3KpaH)

CurHanbHbI Kabenb He
noakmoyeH Kk VGA pasbemy
Barero komnbroTepa.

o [loaKiouNTEe CUTHAJILHBIN Kabeb
K COOTBETCTBYIOLLEMY PazbeMy
(HTerpHpOBaHHast BHCOKAPTA W
JICKPETHAS! BUICOKAPTA).

« [Ipu ncnonb30BaHNN AMCKPETHOM
BUJICOKAPTbI, MOJIKITFOUUTE CUTHATIBHBII
Kabellb K ee pazbeMy.

Ipo6aema B cUrHaTILHOM
Kabene

TonpoGyiiTe NOAKMOYUTD PYTOit
MOHHTOP.
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LAN

Ipodnema

Bo3moxHas npuunHa

CereBoii Kabesb He
TIOJIKJIFOYEH.

JeiicTBie

TopxmounTe ceTeBoi Kabelb K
KOMIBIOTEPY.

TTpo6nema B ceteBoM Kalene

Y6euTech, YTO MHMKATOP CETEBOI
KapTbl roput. Eciu Het, nonpo6yiite
nipyroii ceTeBoii kaGenb. Ecym Bee e He
paboTaet, 00paTuTeCh B CEPBUC-LEHTP
ASUS

HeBo3moxHO
KommbloTep He IOAKIIOUEH K | Y 6euTech, YTO KOMIIbIOTEP NOAKIIIOUEH K
HOMRIIOMHTLCA K 0yTEpy UK Xab 0yTepy WK Xad
Wnrepter poyrepy Y- poyTepy Y-
. TMonyunre cetesble HacTpoliku y Baiero
Hacrpoiiku cetn N
nposaiiepa (ISP).
ITpo6nemsl, BbI3BaHHbIE 3aKpoiiTe aHTHBUPYCHOE NPOrPAMMHOE
anTuBUpycHbM [10 obecrneyeHue.
Tpo6nema c paitBepamu YcraHoBuTe apaiiBep
3ByK
IIpoGnema Bo3moxHast npuunHa MeiicTBie
+ PacnonozxeHue pazbeMoB CMOTpUTE
KonoHK1 1unm HayLIHNKY B PYKOBOJICTBE M0JIb30BaTENs JI/Is1
TNOJKJTIOYEHBI K HEMPABUILHBIM Bawero komnbiotepa.
ay[opazbemMam. ¢ OTKIMOYNTE ¥ 32HOBO MOAKITIOYNTE
KOIIOHKH K KOMIILIOTEpY.
KOnoHK1 1nm HayLUHNKY He ITonpoOGyitte UCnoNb30BaTh Apyrue
Her 3Byka

paboraror.

KOJIOHKM UJN HAYIIHUKH.

Aynmopa3beMbl Ha iepefiHeit i
3ajiHeli TaHeIsIX He PaboTaloT.

IMonpoGyitte 06a NepeHNX 1 3ajiHIX
ayauopasbema. Eciit ofii pasbeM He
paboraet, poBepbTE YCTAHOBJICH JIV OH B
MHOTOKQHAJIBHbI PEXKIM.

ITpo6nema ¢ paitBepamn

IMepeycranoBuTe ayauonpaiisep
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Cucrema

Tpodnema Bosmoxuas npuyunsa JleiicTBue
3anyIeHo CIMIKOM MHOTO o
3aKpoilTe HEKOTOPbIE MPOTPAMMBI.
MpOrpamM.
¢ Hcnonb3yiiTe aHTUBHPYCHOE
Cucrema paboraer 4 Py
CIILIKOM NpOrpaMMHOe obecreyeHne Ais
MEJLICHHO KowmnbtoTep arakoBaH CKAHNPOBAHKS HA HAMYKE BUPYCOB 1
BUDPYCOM BOCCTaHOBJICHUSI KOMITBIOTEPA.
+ [lepeycranoBuTE ONEPALIOHHYIO
CHCTEMY.
+ OrnpaBbTe NOBPE3KICHHBII JXECTKUI
TToBpesk/ieH XXeCTKuit JucK JWCK B cepBUCHBIA eHTp ASUS.
* 3aMeHUTE KECTKHIl JIUCK.
* 3aMeHuTe MaMsTh.
* V3BNekuTe JIOMOJTHUTEITLH
CucreMa 4acto [TpoGnemsl ¢ mamMsTbIO SBIICKUTC JIONONHUTEILHO .
YCTaHOBJICHHYO MaMsITh 1 NONpooyiiTe
3aBHCAET.
ele pas.
He nocratouso BeHTHIISII IMomecTure KOMMbIOTEp B MeCTO ¢ Golee
JI7IS1 KOMIIBIOTEpa. Jy4IIe BEHTUISILHUE.
IlepeycranoBuTe OnepanyoHHy0
Y CTaHOB/IEHO HECOBMECTUMOE pey pa Y
CHUCTEMY M YCTAHOBUTE COBMECTHMOE
MporpamMMHOe obecreueHye.
IporpaMMHoe oGecrneyeHume.
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IIpoueccop

IIpoGiuema

CmimkoM mymHO
T0CIIe BKITIOYEHNS!
KOMITBIOTEPA.

Bo3moxuas NpHYHHA

Baw xomnbtotep
3arpyXaeTcs.

IeiicrBue

310 HopMasbHO. [1py BKIIOUEeHNH
KOMMNbIOTEpA BEHTUJISITOP paboTaeT
Ha TONHO# cKopocTu. Benrunsrop
3amejirest noce 3arpy3sku OC.

Bblt M3MeHeHb! HacTPONKK
BIOS.

Boccranosure Hactpoiiki BIOS no
YMOITYAHHIO.

Crapas Bepcust BIOS

O6noBuTe BIOS Ha nocieHon0
Bepcuto. [locnepHioro Bepeuto BIOS
MOXHO cKauaTh ¢ caiita http://support.
asus.com.

Komnbiorep
CJIMILIKOM LIYMUT
TIPY HCTOJIb30BAHUIL

Bblt 3amMeHeH Kynep
Tporeccopa.

Y6enureck, yro Bbl ncnosnszyere
COBMECTHUMBIIT HIIH PEKOMEH/TYEMBIIT
ASUS «kynep.

He jjocTatouHo BEHTHIISILMI
TS KOMIIBIOTEpa.

Y6eurech, 4To KOMNbIOTEp paboTaeT B
MecTe C XOpoLLeil BEHTUIISLHEH.

CnuIIKOM BbICOKast
TEeMIIepaTypa CHCTEMBL.

» O6Hosute BIOS.

» Ecim Bbl 3HaeTe Kak ycTaHOBUTB
MAaTePUHCKYIO IIaTy, monpooyiire
OYMCTHTD BHYTPEHHEE POCTPAHCTBO
Kopryca.

7

Ecnu npo6niema Bee ke octanach, 00paTUTECh B CEPBUCHBIN LEHTP 32 MOMOLLBI0. CIIMCOK CEepPBUCHBIX

\ LIEHTPOB MOHO OCMOTPETH Ha caiire http:/support.asus.com.
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KonrakTHas ungopmanus ASUS

ASUSTeK COMPUTER INC.

Anpec 15 Li-Te Road, Peitou, Taipei, Taiwan 11259
Tenecou +886-2-2894-3447

dakc +886-2-2890-7798

E-mail info@asus.com.tw

Caitr WWW.asus.Com.tw

TexHn4eckas nojgepKKa

Tenecon +86-21-38429911

OmJtaiiH mojyIepxKa support.asus.com

ASUS COMPUTER INTERNATIONAL ( Amepuxka)
Anpec 800 Corporate Way, Fremont, CA 94539, USA
Tenegou +1-510-739-3777

dakc +1-510-608-4555

Caiir usa.asus.com

Texnuueckas mogaepkka

Tenedon +1-812-282-2787

dakc +1-812-284-0883

OnutaiiH nojyiepkKa support.asus.com

ASUS COMPUTER GmbH (I'epmanusi u Acrpusi)

Anpec Harkort Str. 21-23, D-40880 Ratingen, Germany
dakc +49-2102-959911

Caiir www.asus.de

OHaiiH KOHTaKT www.asus.de/sales

TexHuueckas noaaepxka

TeneoH (KOMIOHEHTbI) +49-1805-010923*

Tenedon (cucrema/noyroyk/Eee/LCD) +49-1805-010920%*

dakc +49-2102-9599-11

Ontaiin nojyiepkKa support.asus.com

*0.14 eBpo B MUHYTY 11 cTalOHAPHBIX TeleoHoB, EUR 0.42 eBpo B MUHYTY 7151 MOGHIIBHBIX
Tesne)OHOB.

Iponssopurens: ASUSTeK Computer Inc.
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MNepLe BupgaHHs
KBiTeHb 2012

KonipaiitT © 2012 ASUSTeK Computer Inc. Bci npaBa 3acTepexeHo.

>KopHa vacTuHa Lboro KepiBHULTBA, BKoYaroun onvcy Bupobis Ta M3 y Hild, He Moxxe 6yTu
BiATBOPEHA, NepeaHa, nepenucana, 36epexxeHa Ha NpucTpoi nam'aTi abo nepeknaaeHa iHWwow
MOBOIO >KOAHUM CTIOCOOOM i B XKOAHIN hopMi, KpiM Tiei fOKYMeHTaLil, siKky KopucTysay 36epirae ans
NOAanbLLIOro KOPUCTYBaHHs, 6e3 nncemoBsoi 3roan ASUSTeK Computer Inc. (“ASUS”).

["apaHTito Ha BMpi6 Ta 06CNyroByBaHHs He 6yae NPOAOBXKEHO, SAKLLO: (1) BMPIG peMOHTYBanu,
moandikysanu abo BUAO3MIHWAK, KPIM TUX BUNAAKIB, KON PEMOHT, MoaudikaList a6o BMAO3MIHW 6ynn
nncsMoBo cxsaneHi ASUS; a6o (2) cepiiiHnii Homep BMpo6y BuaaneHuii abo BiaCyTHil.

ASUS HAZIA€ LIE KEPIBHULITBO "SIK €", BE3 YXO[HWX MAPAHTIN, BUCIOBJIEHNX ABO
TAKUX, LLIO MAKOTbCA HA YBASI, BKITFOHAKOHM, AJIE HE OBMEXXYKO4YMCb TAPAHTIAMN

ABO YMOBAMW TOBAPHOI MPUAATHOCTI ABO BIAMOBIAHOCTI MEBHIW LTI 3A XOAHUX
OBCTABMH ASUS, NOIrO AIMPEKTOPW, KEPIBHUKW, CITY>KBOBLI ABO ATEHTU HE HECYTb
BIANOBIAAJNIBHOCTI 3A BY[1b-AKI NPAMI, OCOBJIMBI, BUNMAKOBI ABO HACJ1IAKOBI
MOLKOAXEHHSA (BKJTKOYAKOYM BTPATY MNMPUBYTKY, BTPATY BISHECY, BTPATY
MPUOATHOCTI ABO JAHKX, NEPEPBY BISHECY TOLLIO), HABITb AKLLIO ASUS MOMEPE>KATI
MPO MOXJNBICTb BUHMKHEHHA TAKX NMOLUKOA>KEHb YEPE3 BYIb-AKUN EDEKT ABO
MOMWIIKY B LIbOMY KEPIBHNLITBI ABO BMUPOBI.

TEXHIYHI XAPAKTEPUCTUKN TA IHOOPMALIIA Y LIbOMY KEPIBHULTBI NOJAHI BUKJTKOYHO
AK 3ATANTbHA IHOOPMALIA | MOXXYTb 3MIHFOBATUCA BE3 MOMEPEPKEHHA. IXHE CNiA
PO3IMMALATU AK TAPATHIKO 3 BOKY ASUS. ASUS HE HECE >XO/IHOI BIANOBIAANbHOCTI
3A BYIb-AKI MOMUIIKN ABO HETOYHOCTI, AKI MOXXYTb TPAMUTUCA B KEPIBHULITBI,
BKJIKOYAIOYM OMUCAHI B HbOMY BUPOBM | 3.

HasBsu BMp6iB Ta Kopropauiii y LiboMy KePIBHULITBI MOXYTb sik 6yTW, TaK i He 6yTI 3apeecTpoBaHNMK
TOProBvMM Mapkamu abo KonipaniTamu BiAMOBIAHNX KOMMNAHIN | BUKOPUCTOBYHOTLCS NALLE ANs
no3Ha4YeHHs abo NOSICHEHHS HA KOPUCTb TXHOrO BNACHMKa, 6e3 Hamipy NOpYLIMTYK aBTOPCbKi Npasa.
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MpuMiTkK
REACH

3rigHo i3 HacTaHosamun REACH (peecTpauis, ouiHka, cepTudikauis, 06MexeHHs
BUKOPUCTAHHS XUMIYHNX PEYOBMH) MW ONPUMOAHIOEMO BMICT XiMIYHUX PEYOBUH Y HALLMX
Bupobax Ha caiTti ASUS REACH

http://green.asus.com/english/REACH.htm

3assa ®epepansHol KoMicii 38'aaky (CLLUA)

Lle npucTpii Bignosigae Bumoram YacTtunm 15 Mpasun OepepanbHoi Komicii 38's3ky
(CLUA). ExcnnyaTauis nignsrae BUKOHaHHIO HACTYMHWX ABOX YMOB:

+  Llei npucTpiii He MO>XKE BUKNMKATH LLKIANUBY iHTEPdEPEHLit0 Ta

+  [pucTpiid MycuTb NpuitMaTi 6yAb-sIKy OTPUMYBaAHY iHTEPMEPEHLIto, BKIOUaoUn Ty,
AKa MO>Ke BUKNNKATW HebaxxaHe (YHKLIOHYBaHHS.

O6napHaHHs 6yno nNepeBipeHo i BU3HAHO TakuM, 06 Npautoe B Mexxax HOpM Ans
undposux npuctpois Knacy B 3rigHo YacTtunu 15 Mpasun ®eaepanbHoi Komicii
3s'a3ky (CLUA). Lli HopMu CTBOpPEHI ANSt HAlaHHS AOCTATHBOrO 3aXMCTY Bif LWKiANNBOT
iHTepdepeHLii B xuTnosomy cektopi. O6nafiHaHHsS CTBOPHOE, BUKOPUCTOBYE | MOXE
BUNPOMIHIOBATY €Heprito pafio4acToT. SKLLO BOHO iHCTanb0BaHe i BUKOPUCTOBYETLCS
6e3 [OTPUMaHHS BKa3iBOK BUPOBHWKA, 06/1aAHAHHA MOXKE BUKNNKATK LLKIANNBY
iHTepdepeHLito i3 pagio3s'sa3koM. [poTe Hema rapaHTii, Wo iHTepdepeHList He BUHUKHE
npu NeBHIN iHcTansAuii. AKLWO NPUCTPIN BUKNMKAE LWKIANUBY iHTEPdEPEHLtO i3 NpUiioMOM
pagio- a6o TenecurHany, Lo MOXHa BU3HAYUTH, BUMKHYBLLM i MOBTOPHO YBIMKHYBLLIN
o6nagHaHHa, pagMMo KOpUCTyBavesi cnpobyBaTv CaMOCTIMHO BUNPaBUTY iHTepdepeHLito
0AHWM abo 6inbLue i3 HACTYNHWX Cnoco6iB:

«  TlepeoipieHTyinTe a60 NEPEMICTITb aHTEHY.

+  36inbLWiTb BiACTaHb Mi>XX 06MaAHAHHAM | NPUAMAYEM.

+  TigkntodiTe 06nagHaHHs 4o iHWKMX po3eTku abo eNeKTPOMEPEXKI, HIXX Ta, A0 SKOT
MiAKIFYEHO NpuiiMay.

+  [opapbTecs i3 po3noscloKysayeM abo A0CBIAYEHUM PaAio/TeNe-TEXHIKOM.
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[ns notpumants Hopm OepepansHoi Komicii 3s's3ky (CLLIA) cnig kopucTyBaTtucs

R eKpaHOBaHUMM KabensM Ans nifKnYeHHs MOHITOpa Ao rpadivHoi kapTu. 3miHn abo
Moamdikauii NpucTpoto, He cxBaneHi B NUCbMOBI (DOpMi CTOPOHOHO, BifNOBIAANBHOKO
3a JOTPUMaHHS HOPM, MOXXYTb CMIPUYMHUTM 0 BTPaTV Npasa KopucTyBaTucs
obnagHaHHsIM.

181



<
B
o,
=
o
v
P
o

182

Monepea>xeHHs Npo BNNUB paAiovacToT

Lle o6nagHaHHs cnif iHCTantoBaTvt i ekcnnyaTtyBaTth 3rifHO 3 IHCTPYKUiSiMU. AHTEHY (1)
AN nepefasaya cnif iHCTanioBaTH Ha BiACTaHi LwoHaimMeHw 20 cM Bif yCix oci6 i He cnig
PO3MilLlyBaTVt Ta EKCMyaTyBaTy NopyH i3 6yAb-SKOHO iHLLIOK aHTEHO abo nepeasaqem.
KiHuesi KopucTyBaui Ta paxisui 3 iHCTansALii MycsTb AOTPUMYBATUCS BKA3iBOK LLOJO
iHCTanAuii aHTeHw | yMOB ekcnnyarauii nepefasaya, o6 3abesneqnT 3axucT Bij
pagio4acToT.

3asBa [lenapTameHTy 3B'A3Ky KaHagu

Lle umdposuii npucTpiit He nepesuLlye Hopmmn Knacy B ans pagio-Luymis undpposux
npucTpois, BCcTaHosneHi y Hopmax PagioiHTepdepenuii JenaptameHTy 3's3ky Kanaaw.
Llein uncbposmii npuctpiii Knacy B signosinae kaHaacekomy ICES-003.

Mpumitka npo Bupi6 Macrovision Corporation

Lle# BMpi6 MiCTUTb TEXHOONiO 3aXMCTY aBTOPCHKUX NPaB, Sika MAE 3asBKW Ha AesKi
nateHTn CLUA Ta iHwWwy iHTenekTyanbHy BnacHicTb Macrovision Corporation Ta iHLwmnx
BNIACHUKIB aBTOPCbKMX npas. KopuCTyBaHHS TEXHONOTIE0 3aXMCTY aBTOPCbKUX Npas
cnip 6yt ceptudpikosannm Macrovision Corporation i npu3HayeHi Ans AOMallHLOro Ta
iHLLIOrO 06MeXXeHOro nokasy oKpiM Bunaakis, asTopusoBaHux Macrovision Corporation.
3abopoHeHo po36bupaTy i BiATBOPIOBATU MPUCTPI.

IMonepeaxeHHs npo niTiii-ioHHy 6aTapelo

OBEPEXHO: 3arposa ubyxy, ko 6aTapeto HenpasuibHO BCTaBUTK. 3amiHoiiTe
nnLLIe Ha NOAI6HMIA abo Takuii Camuii TUM, PEKOMEHA0BaHUI BUPDOOGHUKOM.
YTunidyinTe BuKopucTaHi 6atapei 3rifHo iHCTPYKLiA BUPOOHMKA.

Mocnyru nepepo6ky i npuitioMy cnpauboBaHux BUpo6is ASUS

B ocHoBi nporpamu nepepobkm i npuitoMy cnpauboBaHux Bupo6is ASUS - nparHeHHs
AOCAITY HAMBULLIMX CTaHAAPTIB 3axX1CTy AOBKINNA. My nepexoHaHi, Lo MoXeMo
3a6e3neunTyn Bac cnocobamm BifnoBifansHO NepepobnsaTh BUpobu, 6atapei Ta iHLwi
KOMMOHEHTH, @ TaKoX i nakyBanbHi MaTepiany. [letansHa iHdopmadis LWoAo Nnepepobkmn y
pi3HWX perioHax noaaHa TyT: http://csr.asus.com/english/Takeback.htm.




3axoau 6e3neku

BifkntodiTh XXMBNEHHS 3MIHHOTO CTPYMY Ta nepudepiiiHi NPUCTPOI NEPEA YMLLEHHAM.

R MpoTvpaiite cTauioHapHuii MK yncToro Lentono3Hot rybkoto abo 3amMLLEto, 3MOYEHOKO
CYMILLLLIO Heabpa3nBHOr0 PO34MHHMKA i KiNbKOX Kpanenb Tennoi Boau, a NoTiM 3HiMiTb
HaJIMLLIOK BOJIOTM CYXO0 TKAHWHO.

+ HE PO3MILLYWTE Ha HepisHiii a6o HecTiiikiil noepxHi. 3BepTaiiteck no
06CnyroByBaHHs, SKLLO 6Y10 MOLUKOAXKEHO KOPMYC.

+ HE KOPVIC"TWITECFI npucTpoeM TaM, Ae 6arato 6pyay a6o nuny. HE
KOPUCTYUTECA TK nig yac BuTiky raay.

+ HE CTABTE | HE BMYCKAWTE npeameTy aropu Ha MK i He BCTaBnsiiTe CTOPOHHI
npeameTyn Ao ctauioHapHoro MK.

+ HE MIAOABAMTE JIf cunbHnx MarHiTHUX a6o enekTpudHNX Nonis.

+ HE KOPUCTYMTECS nopyu i3 piavHamu abo Bonoroto, nig gowlem. HE
KOPUCTYWTECS moaemom nig 4ac rposm.

+ MpumiTka npo 6eaneky 6atapei: HE KUWJAWTE 6atapeto y BoroHs. HE SAMUKAMTE
koHTakTu 6aTapei. HE PO3BUPAMTE 6atapeto.

+ Kopuctyitecs y cepenosuLui i3 Temnepatypoto Bia 0°C (32°F) po 35°C (95°F).

+  HE 3AKPUBAWTE senTunsviiiHi oTBOpu cTauioHapHoro K, wo6 cucTema He
neperpisanacs.

+ HE KOPUCTYMTECS NOLIKOAXEHMMM LIHYPAMI KMBAEHHS, aKCecyapamu Ta iHLLMMAN
nepucepinHIMmU NPUCTPOSIMMU.

+ o6 yHUKHY TV yparkeHHs eNeKTPOCTPYMOM, BUMKHITb LLIHYP XXMBMEHHS 3 PO3ETKM
MepLL HiXK NepeMiLLlyBaTit CUCTEMY.

+  3BepHIiTbCA NO NPodeCiiiHy LOMOMOry nepes KOPUCTYBaHHAM aaantepoM abo
nofoBsxysa4em. Lli npucTpoi MoXyTb nepepsaTh CTPYM 3a3eMIEHHS.

+ [lepekoHaiiTecs, WO AXKepesio XWBMEeHHs BCTAHOBIIEHe Ha npasuibHy, Ana Baworo

perioHy, Hanpyry. AkLo Bu He BneBHeHi B TOMy, Sika Hanpyra B po3eTLi, Koo Bu
KOPUCTYETECS, 3BEPHITLCS A0 MICLIEBOT CNY>X6M eHepro3abesneyeHHs.
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+ SIKWO A>Kepeno >XWUBNEHHS HeCnpaBHe, He HaMmaraiTecs nonaroanTH oro
CaMOCTIHO. 3BEPHITbCA [0 KBaNi(hikoBAHOr0O TexHika abo PO3MoBCIOAXKYBaYa.
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Mo3HayeHHs, siKi BAKOPUCTOBYIOTLCS B K@PiBHULTBI

LLlo6 npaBunbHO BUKOHYBaTV NEBHI Aii, 3BEPHITb yBary Ha HaCTYyMHi CUMBOSN y
KepiBHUUTBI.
é HEBE3MNEKA/OBEPEXXHO: Sk yHUKHYTM TpaBMyBaHHS nif, 4ac BUKOHAHHS
3apavi.

' YBATA: §IK yHUKHY T MOLUKOAXKEHHS KOMMOHEHTIB NifJj YaC BUKOHAHHS 3afavi.
L]

R BAXKJIMBO: IHcTpykuii, siki HEOBXIAHO BrkoHyBaTw, 06 BUKOHATW 3aaaqdy.

/ MPUMITKA: Migkasku Ta gopaTtkosa iHopmauis, sika LJONOMOXXEe BUKOHATM
3ajady.

[le 3HaiiTv Ginble iHdpopmauit
[Hopatkosy iHdopmauito npo BaockoHaneHHs 3 Ta Bupoby Bu 3Haingete TyT.
Caiitn ASUS

Caiit ASUS Hapae noHoBneHy iHgopMauito Npo anapaTHe 3abeaneyeHHs i 13
ASUS. Bigsigaiite caiit ASUS www.asus.com.

MicueBsa TexHiuna niaTpumka ASUS

BigsinaiTe cait ASUS http:/support.asus.com/contact , 106 OTpUMaT KOHTaKTK
Yepro.oro iHXeHepa TEeXHIYHOI NiATPUMKM.
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http://support.asus.com/contact
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Crauionaphuii MK ASUS | KomnnekT irpoBoi knasiaTypu |  KomnnekT irpoBoi MuLwi
Essentio ASUS ROG U9N x1 ASUS GX900 x1

Tnstalaion Sude

E<d

LLIHyp »vBneHHs x 1 KepiBHNUTBO 3 iHCTanAUil

x1
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["apaHTiiHWiA TanoH x 1 DVD BigHoBfIEHHS X1

(momaTtkoBo)
ABO
Kinbuesa pyxoma aHteHa Wi-Fi x 1 AnTeHa (pofaTtkoso) x 1
+ ko 6yab-KWiA i3 BKA3aHNX BULLE NPEAMETIB MOLIKOAKEHWA a60 BiACYTHIi,
3BEPHITLCS A0 PO3MOBCIOAKYBaYa.

+ 306pakeHHs NpeaMeTiB NOAaHi NuLe sik 3aranbHa iHhopmauis. TexHiuHi
XapaKTepuUCTUKN BUPOBY MOXXYTb BiAPI3HATUACS Bif BKA3aHUX 3aeXHO BiA MOAEnNi.

LLlo6 oTpumaTy poknagHitly iHhopmaLito WOAO BUKOPUCTAHHS CTaHAAPTHUX
KnasiaTypu Ta MULLI, NepernsHbTe po3ainu BukopuctanHs irposoi knasiatypu ASUS
ROG i BukopucTanHs irposoi muLi ASUS GX900.
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[naBa 1

Jlackaso npocumo!

[saxyemo 3a npuabaHHs cravioHapHoro MK ASUS Essentio CG8580!

Crauionapruii MK ASUS Essentio CG8580 Bia3Ha4aeTbca haHTaCTUYHUMM POBOUNMU
XapakTepucT1KaMu, HENOXUTHOK HALIMHICTIO Ta yTURITaMu, SKi NpaLtoroTb, y NepLuy
yepry, Ang kopucTyeaya. Bci ui xapakTepucTuku 3ibpaHi y CTUNbHOMY Oy TYpUCTUHHOMY
KOpMyci cucTeMu.

R MpounTaitte rapanTitHniA Tanon ASUS nepLu Hixx HanawTosysaTy ctauionapHuin MK
ASUS.

3HaioMCTBO 3 KOMN'IOTEPOM

IntocTpauii HaaaHi nuLe sk 3aranbHa iHdopmadis. MopTy Ta ixHe po3TallyBaHHs, a
TaKOo> KOJlip KOpnycy MOXYTb BifiPI3HATUCS 3aneXeHo Bif MOAEi.
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MepeaHs naHenb
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10.

11.
12.

KHonka >XMBNeHHs. HaTucHITb Lto KHOMKY, W06 YBIMKHYTW KOMM'tOTep.

OTBip Secure Digital™ / MultiMediaCard. BctasTe y ueii 0TBip kapTky Secure
Digital™ / MultiMediaCard.

Bincik onTuuHOro AuckoBoAy. Y BifCiKy € ONTUYHWIA AUCKOBOA.

Biacik rapsi4oi 3aMmiHu (nopoXHiid). [lo3Bonsie BCTAHOBUTM AOAATKOBUIA XXOPCTKMIA
[VCK Y Lieid BiACIK.

Caitnopion XusneHHs. Lleii ceiTnogion 3aropseTbes, konm Bu BMuKkaeTe komn’ioTep.

OTBip kapTkn Memory Stick™ / Memory Stick Pro™. BcTasTe y Leid 0TBip KapTky
Memory Stick™ / Memory Stick Pro™.

OTBip kapTkn CompactFlash®/ Microdrive™. BctasTe B Lieii 0TBip KapTky
CompactFlash® / Microdrive ™.

Knonka OC. Lis kHonka HanawTosye Npodinb NiAHATTS CUCTEMU KOMM'toTepa.

Moptu USB 3.0. Lli nopTu yHiBepcansHoi cepiitHoi wiHm 3.0 - USB 3.0
niAKnoYaTbesa A0 Takux npuctpois USB 3.0 sk muwa, NnpuHTep, ckaHep, kamepa,
KIMK Ta iHwi.

HE NIAKJKOYAITE knasiaTypy/muLy Ao 6yas-akoro 3 nopTis USB 3.0 nig vac
iHcTanauii OC Windows®.

Yepes o6MexxeHHst KoHTponepa USB 3.0 npuctpoi USB 3.0 MoXyTb
BuKopucTosysaTucs nuiwe B OC Windows® i nicns incTansiuii paiisepa USB 3.0.

MpucTpoi USB 3.0 Mo>kHa BUKOPUCTOBYBATH NULLIE SIK NPUCTPOT nam'saTi.

+ Hanonernuso paavmo niakntoyatn npuctpoi USB 3.0 ao noptis USB 3.0, wo6 Bawi
npucTpoi USB 3.0 kpate i LUBKALLIE NpaLoBany.

Moptu USB 2.0. L|i nopTu yHiBEpcanbHoi cepiitHoi wiuHm 2.0 - USB 2.0
MiAKNYaTLCA A0 Takux NpucTpois USB 2.0 siK Muwwa, npuHTep, ckaHep, kamepa,
KIMK Ta iHLwi.

MopT mikpochoHy (poxxeBwuit). Lie nopT Ans nigknioueHHs MikpodoHa.

MopT HaBywWwHKKIB (3eneHui). Lleii nopT cnyrye ans nigKnoYeHHs HaByLUHUKIB abo
AvHamika.

'naBa 1: Movatok ekcnnyatauii
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1. Noptu USB 3.0, nintpumka ASUS USB 3.0, pexxum Boost UASP (Migcunenns
UASP). Lli nopTu yHiBEpcanbHoi cepiitHoi lwinHm 3.0 - USB 3.0 nigkntoyatoTbes A0
Takux npuctpois USB 3.0 sik Muwa, npuHTep, ckaHep, kamepa, KMNK Ta iHwwi.

+ MMopTn USB 3.0 nigtpumytoTb nuwe Windows® 7 i Hoiwi sepcii. CtanpapT UASP
niaTpumye amwe Windows® 8..

HE NIAKNKOYATE knasiatypy/Muwy Ao 6yab-akoro 3 noptis USB 3.0 nig yac
iHcTansuii OC Windows®.

+ Yepes o6MedxxeHHst KoHTponepa USB 3.0 npucTpoi USB 3.0 MoxyTb
BukopucToByBaTucs nuie B OC Windows® i nicns iHcTansiii gpaiieepa USB 3.0.

MpucTpoi USB 3.0 MoXXHa BUKOPUCTOBYBATY NULLE SIK MPUCTPOT nam'aTi.

Hanonernuso paaumo nigxntoyatv npuctpoi USB 3.0 fo noptis USB 3.0, wo6 Batwi
npucTpoi USB 3.0 kpalwe i WsnaLle npauosani.

2. Moptn USB 2.0. Lli nopTu yHiBepcanbHoi cepiitHoi wuHmn 2.0 - USB 2.0

nigKno4aoTbes A0 Takmx npuctpois USB 2.0 sk muwa, npuHTEp, CKaHep, kamepa,
KMNK Ta iHLwi.

ASUS CG8580
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3.  Kaprtka ASUS Wi-Fi GO! (Wi-Fi 802.11). MigkntouiTh kinbueBy pyxoMmy Wi-Fi aHTeHy

* Moka3wu ceitnoaioais Wi-Fi

BuMkHeHO Hema 3B’a3ky

3eneHuii 3B’530K

KapTtka ASUS Wi-Fi GO! aBTOMaTn4HO BCTaHOBNIOE HA AOCTYNHI B KpaiHi Wi-Fi kananu.

7

A0 UbOro nopTy.
4.  DisplayPort. This port connects a display monitor or a home-theater system.

MopT Aavcnnero. [Jo LbOro NOPTY MiAKNHYAETLCSA MOHITOP AXCNNE0 ab0 AOMALLIHiN
KiHoTeaTp.

6. Moptu USB 3.0, niaTpumka ASUS USB 3.0, pexxum Boost UASP (MigcuneHHs
UASP). HuxHiii nopT niatpumye USB BIOS Flashback.

7.  Topt Buxoay 6okoBoro auHamika (cipui). MopT cnyrye Ans nigKMto4eHHs 60KOBUX
HaBYLLIHUKIB Y KOHCirypadlii 8-kaHansHoro aygio.

8.  loprt BMXOAY 3aAHLOrO AUHAMIKa (HYOPHMIA). [TopT cnyrye Ans nigKNHOYEHHS 3afHiX
HaBYLLHUKIB y KOHApirypauii 4, 6 i 8-kaHanbHoro ayaio.
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9.  Nopt LienTtp/Ca6Bydep (opaHxeswuit). [1o LbOro NopTy MiaKMYaATLCS LEHTPanbH
HaByLLUHWKW/cabBydep.

10. TMopt MikpodboHy (po>keBuid). Lle nopT ans niaknoYeHHs MikpooHa.

11.  Mopt Buxopy niHiT (3eneHui). Liein nopT cnyrye ans nigkito4YeHHS HaBYLUHMKIB
a60 avHamika. Y KoHdirypauii 3 4, 6 a60 8 kaHanis Lei NopT Npautoe Ans BUXoQy
nepeaHboro AMHaMika.

12.  Topt Bxoay niHil (6nakuTHMA). MopT ANS NiAKIIOYEHHS A0 KACETHOTO MArHiTOCHOHY,
nporpasaya CD a6o DVD Ta iHLumMx Axepen aygio.

Min yac koHdirypauii ayaio kopucTyiTecs Tabnuueto, fie BKasaHo yHKLUii nopTis ayaio
ans 2, 4, 6 abo 8 kaHanis.

KoHdirypalis 2, 4, 6 a6o 8-kaHanbHoro ayaio

HaBywHuku

190

Mopt e 4-kaHanbHi 6-kaHanbHi 8-kaHanbHi
Bnakuthuii Bxin niuii Bxig nini Bxin ninii Bxig ninii
Senenmii Biig nikii Buxig nepeaHboro Buxip nepeaHboro Buxin nepeaHboro
HaByLUHMKA HaByLIHMKA HaByLUHMKA
- Bxin N - L
Poxeswuii MikpochoHa Bxin MikpochoHa Bxig mikpochoHa Bxin MikpochoHa
OpaHxeBuit - - Llentp/Cabaydep Llentp/CabBydep
YopHuii _ Bwuxig 3aaHbOro Buxia 3aaHb0ro Bwuxig 3aaHbOro
p [AMHamika IvHaMika [IMHamika
Cipwit _ _ _ Buxin 60K_osoro
MHamika

'naBa 1: Movatok ekcnnyatauii




13. BeHTunAUiiHi oTBOpPU. Yepes Li 0TBOPM 3AINCHIOELCS BEHTUNALLS.

HE 3AKPUBAWTE BeHTUNSILiiAi OTBOPY Ha KOPNYCi.

14. Mepemukay xusneHHs. BMUKAE/BUMUKAE xuBneHHs komn'toTepa.
15. Cnony4yBay )XMBNeHHS. (iHTeHCMBHICTb Bxogy: 100~120/200~240Vac, 60/50Hz,
10/5A). BcTaBTe LUHYP XXVWBAIEHHS A0 LbOro CroflydyBaya.

16. Kom6iHoBaHuii nopt knasiaTtypa PS/2 / Muwa (ioneTosui). Liei nopT npusHaveHuii
Aans knasiatypu PS/2 a6o muwi.

17.  Mopt onTnyHoro Buxoay S/PDIF_OUT. Llei nopT - Ans nifK/to4YeHHs 30BHiLLHLOIO
NPUCTPOIO BUXOZY ayfio Yeped onTuyHwii kabenb S/PDIF.

18. Mopt HDMI. Llein nopT npuaHayenuin ans cnonyyysada High-Definition Multimedia
Interface (HDMI) i € cymicHim i3 HDCP ans siaTeopeHHst HD DVD, Blu-ray Ta iHworo
3aXMLLEHOr0 3MICTY.

19. Mopt VGA. Lleii nopT - ans cymicHux i3 VGA npucTpoiB, Takux sk MoHiTop VGA.

20. Mopt LAN (RJ-45). Lleit nopT Hafae MOXMBICTb rirabiTHOro NiAKNHOYEHHs A0
nokanbHoi Mepexxi (LAN) yepes xab mepexi.

. N cBITnoaio
CsitnopiogHi nokaxcumku nopty LAN ais angc-r'c'l, cBiTnoaion

393Ky WBMAKOCTI

CaiTnogioa AiANbHOCTI/3B'A3KY CaiTnopioA WBMAKOCTI
BUMK. Hewma 38'a3ky BUMK. MigkntouerHs 10 M6/cek. -

OPAHYKEBWI ‘ TiAKI04EHO ‘ OPAHYKEBWI ‘ MiakmtoueHHs 100 M6/cex.

MEPEXTUTb

[LisinbHicTb 3ENEHUN MigkntoyeHHs 1 M6/cek.
NaHNX

21.  MopTu 3BYyKOBOT KapTH (3HiMHI). Lli nopTv nig’enHytoTLCS 4O BaWMX NPUCTPOIB
BUBEAEHHS, SIK-OT MIKPOGIOH, HABYLUHUKN Ta AUHAMIKK.

22. KpoHLTeH 0TBOPY PO3LUMPEHHS (AOAATKOBO). IHCTaNO0UM KapTy PO3LUMPEHHS,
3HIMITb KPOHLUTEH 0TBOPY PO3LLNPEHHS.

23. Kapra Wi-Fi ASUS (nuwe Ha okpemux Mogensix). [lopatkosa kapta Wi-Fi Hanae
KOMM'tOTepy MOXXIMBICTb MiAKNHOHATACS A0 6€3APOTOBOI MEPEXI.

ASUS CG8580
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HanawTyBaHHs koMn'l0Tepa

Lis cexuist po3noBicTb NPO NiAKMIOYEHHS A0 KOMM'IOTepa OCHOBHMX anapaTHuX 3acobis,
TakuX SiK 30BHILLHIi MOHITOP, KNasiaTypa, MULLA i LIHYP >KUBIEHHS.

MiaknioYeHHs 30BHILHLOrO MOHITOPA

KopucTyBaHHs rpadivHoto kapToio ASUS (nuiie Ha OKpeMux Moaensx)
[MiaknrYiTE MOHITOP 0 NOPTY BUXOAY AUCMNNEH0 HA BHYTPILUHIA rpadiuHii kapTi ASUS.
LLIo6 nigkniounTK 30BHILWHIA MOHITOP 3a Aonomoroto rpadiyHol kaptn ASUS:

1. Tligkno4iTe MOHITOP A0 NOPTY BUXOAY AMCNAEto Ha rpadidHiin kapTi ASUS.

2. YBIMKHITb MOHITOP A0 AXXepena >XUBMIEHHS.

% MopTtu BMXx0Ay Avcnneto Ha rpadiuHii kapTi ASUS 3anexars Bif Moaeni.
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KopucTyBaHHS nopTamMu BUXOAy AUCNNelo Ha nnari
[MiaKNHOYiITE MOHITOP A0 MOPTY BUXOAY AMUCIIIEIO HA NAaTi.

LLo6 niaxniounTH 30BHILLHI/ MOHITOP A0 MOPTIB BUXOAY AUCNIEI0 Ha NnarTi:

1. Migkntoyite moriTop VGA ao nopty VGA, a6o mowiTop DVI-D go nopty DVI-D, a6o
moHiTop HDMI fio nopty HDMI Ha 3aaHiii naHeni komntoTepa.

2. YBIMKHiTb MOHITOP [0 AXKepena XWUBIEHHS.
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+ Skwo Baw koMn'toTep ocHalleHui rpadiyHoro kapToto, rpadivHa kapta ASUS
BKa3aHs Ik OCHOBHWIA NpucTpiii nokasy B BIOS. ToMy niakntouiTe MOHITOP A0 NOPTY
BMXOAY AMCMNE0 Ha rpaddiuHiii KapTi.

Sk NigKNHYNTM feKinbka 30BHILLHIX MOHITOPIB 0 KOMM'tOTEpa, AeTanbHO PO3KasaHo y
Mipknio4YeHHs AeKinbKoX 30BHILIHIX MOHITOPIB y NaBi 3 Lboro KepiBHULTBA.

ASUS CG8580 193
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MigknioyeHHs knasiatypu USB Ta muwi USB
Migxntouite knasiatypy USB Ta muwy USB po noptis USB Ha 3aaHiii naHeni komn'totepa.

[lo nonepefHbO IHCTaNbOBAHO! yTUAITM HANALWTYBaHHA AN NOEAHAHOI B napy irpoBoi
muwi ASUS GX900 MOXKHa YBIiATH, NiLLe NiAKMOHMBLUM MULLY [0 KOMM'tOTepa A0

- 3anycky Windows® 7 nepefi nepLUMM KOPUCTYBaHHSAM. Y MPOTUNEXHOMY BUNaaKy Bam
3HaA06MTbCS BPYYHY BCTaHOBMOBATW yTUAITY 3 DVD nigTpumku. Moapobuui avs. y
po3pini Kopuctysanhs irposoto muieto ASUS GX900 y Mnasi 4.
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MiaknoyeHHs WHypa XXMBREHHS

MigKnoYiTh OAMH KiHeUb LUHYpa XXMBREHHS O CNONyYyBaYa XXUBNEHHS Ha 3afHii naHeni
KOMM'toTepa, a iHLWWiA KiHeLb - A0 AXKepena >XUBEHHS.
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YBIMKHEHHSA/BUMKHEHHS komn'toTepa

Llein po3ain onucye yBIMKHEHHS/BUMKHEHHS KOMM'IOTEPA MICAs Oro HanaluTyBaHHs.

YBIMKHEHHSA komn'loTepa
LLlo6 YBIMKHYTU komn'toTep:

1. YBIMKHITb moHiTop.

2. YBIMKHITb BUMMKAY €N1EKTPOXXMUBEHHS, @ NOTIM HATUCHITb KHOMKY XXUBIEHHSA HA
CBOEMY KOMIMT'IOTEPI.

KHonka >XuBneHHs
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3. MNouekaite, noku onepauiﬁHa CuCcTeMa aBTOMaTU4HO 3aBaHTaXXUTbCA.

Ak BUMKHYTU komn'iotep
LLlo6 BUMKHYTU komn'toTep:

1. 3akpwuiiTe BCi npavtotoyi 3aaavi.
2. Knaunite rﬁ Ha po6oyomy ctoni Windows®.
3. KnauHitb no [EMESEULN| 11106 BUMKHYTY OnepauiiiHy cuctemy.
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[‘naBa 2

MepLumii 3anyck cuctemu

Konu Bu BnepLLie BMUKaeTe CUCTEMY KOMM'IOTEPA, 3'ABNISIETLCA Cepist eKpaHis, ska
cynposoa>KyBaTuMe Bac y KoHirypaLii 0CHOBHUX HanawTysaHb onepauiiHoi cuctemu
Windows® 7.

LLlo6 BMKOHATH NepLuKii 3anyck CUCTOMM:

1. VYBiMKHITL KOMM'tOTep. MouekaiiTe Aekinbka XBUAWH, NoKu 3'aB1TbCS ekpaH Set Up
Windows (HanawTtysanhs Windows).

BubepiTb MOBY 3 BunagHoro cnvcky. Knaunite no Next (dani).

3 BunagHux cnuckis BubepiT Country or region (KpaiHa a6o perion), Time and
currency (Yac i Baniota) Ta Keyboard layout (Posknaaka knasiatypu). KnauHits no
Next (Aani).

4. Beegitb opuriHanbHi iMeHa Anst user name (iM's KopucTyBaya) Ta computer name
(HasBa komMn'toTepa). KnauHite no Next (dani).
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5. BsepiTb He0OXiaHY iHpopMaLito, 06 BCTAHOBMTY Naponb, a NoTiM knauHiTe no Next
(Aani). Takoxx MoxkHa knauHyTv no Next ([ani), wWo6 nponycTuTu Ueid eTan i He
BBOAMTM iHchopMaLlito.

SAkwo Bu 6axxaeTe nisHilLe BCTAHOBUTM Napofib A1 06M1IKOBOro 3anucy, AvB. po3gin
HanawTyBaHHsi 06nikoBOro 3anucy KopucTysaya i naponto y Liii rnasi.

6.  YBaXKHO npouuTanTe yMOBMK NiLEH3IAHOT yroau. MNocTasTe no3Hauky nopyd i3 |
accept the license terms (51 noroaxytocsi 3 ymoBamu yroam) i knauHite no Next
(Aani).

7.  Bubepitb Use recommended settings (BukopuctosysaTti pekoMeHA0BaHi
HanawTyBaHHs) a6o Install important updates only (IHcTanioBati nuwe Baxnuei
NOHOBNEHHS), LLO6 BCTAHOBUTM HanawTyBaHHs 6e3nekn ansg komn'totepa. LLlo6
nponycTuTY Leii eTan, Bu6epitb Ask me later (Cnutatu nisHiwe).

8.  lepernsnyTv HanawTysaHHs Yacy i aatu. Knauwite no Next (fani). Cuctema
3aBaHTaXXye HOBI HANALLTYBaHHS i NepecTapToBye. Tenep MoXHa novatu
KOPMCTYBATMCS KOMM'HOTEPOM.
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KopucTyBaHHs cTauioHapHuM komn'totepoM Windows © 7

KnauiTe no niktorpami Start (ﬁ)T) > Help and Support (flonomora i nigTpumka),
106 oTpumaTu GinbLue indopmadii npo Windows® 7.

KopucTyBaHHs CTapTOBUM MEHIO

Start menu (CtapToBe MeHI0) HaAae [OCTYN A0 NPOrpam, yTUmIT Ta iHWKUX KOPUCHWX
yHKui Ha Bawwomy komn'toTepi. BoHo Takox Haaae 6inbLue indopmadii npo Windows 7
yepes xapakTtepuctuky Help and Support ([lonomora i niaTpumka).

3anyck nporpam i3 Start menu (CtapToBe MeHI0)
LLlo6 sanycTuti nporpamu i3 Start menu (CtaptoBe Memo)ﬁ

1. Ha naHneni 3agay Windows® knauHitb no niktorpami Start (CtapT)

2. Y Start menu (CTapToBe MeHI0) BUOEPITL NYHKT, KW 6axkaeTe 3anyCcTuTu.

(CTtapToBe MeHto). [leTanbHille Npo Ue — y po3aini 3akpinneHHs nporpaM y cTapToBOMy
e MeHIo a6o Ha naHeni 3afau y Uil rnasi.

% Bu mo>xxeTe 3akpinuTi nporpamu, siki NOTPIGHO NOCTIHO nokadysaTu y Start menu
KopuctyBaHHs nyHkToM Getting Started (MouaTok ekcnnyatauii)
MynkT Getting Started (MoyaTtok ekcnnyaTtauif) y Start menu (CTapToBe MeH0) MiCTUTb

iHpopMaUito Npo Aesiki OCHOBHI 3aaavi: sk nepcoHanizysaTtv Windows®, foaaBat HOBUX
KopucTyBauiB, nepefasaTu caiinu ans 3Haiiomctsa i3 Windows® 7.
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LLIo6 kopucTyBaTucs nyHktom Getting Started (MouyaTok elﬁiyaTaui'l'):
1. Ha naneni 3apay4 Windows® knauHitb no niktorpami Start (CtapT)  , Wwo6
3anyctuTn meHio Start (CtapT).

2. Bubepitb Getting Started (MouyaTok excnnyatauil). 3'IBASETLCA CNMCOK JOCTYMHUX
3apad.

3. Bubepitb 3apady, siky Bu 6a>kaeTe BUKOHATM.

KopucTyBaHHs naHennio 3apad

Marenb 3apay Hagae MOXXIMBICTb 3amnycKaTy iHCTanboBaHi Ha KOM'MoTep nporpamu abo
yHKUIT | KepyBaTh HUMW.

3anyck nporpam 3 naHeni 3ajay
LLIo6 3anycTuTH nporpamy 3 naHesi sapav:

. Ha naHeni 3agay Windows® knauyHiTb no nikTorpami, o6 3anycTuTu nporpamy.
KnauwiTe no niktorpami 3HOBY, 06 NpuxoBaTtu Nporpamy.

Bu Mo>xeTe 3akpinuTy nporpamu, siki NOTPi6HO NOCTIAHO NokadyBaTu Ha naHeni 3ajay.
[eTanbHiwe npo ue — y po3gini 3akpinneHHs nporpaM y CTapToBOMY MeHI0 a6o Ha
naHeni 3agau y Liii rnasi.

198 nasa 2: KopuctysanHs Windows® 7



3akpinneHHs NyHKTIB y TAMYaCOBMX CrUCKAX

Konu Bu npasoto KHOMKOO KnauaeTe no naHeni 3aaad, 3anyckaeTbCst TUMYACOBUA CMIUCOK,
AKWIA HAAAE LWBMAKWIA AOCTYN A0 Nporpam abo noBs3aHuX i3 pyHKUisiMM nocunaHb. MoxxHa
3aKPINUTW y TUMHYACOBOMY CNMCKY yNto6neHi canTy, nanku abo NOrivHi ANCKK, IKUMKM HaCTo
KopucTyeTecsi, abo aiinv megia, ki HeAaBHO NPOrpaBanucs.

LLlo6 3aKpinUTK NYHKTH Y TAMYACOBOMY CrUCKY:
1. Ha naHeni 3aaay npasoro KHOMKOK MULLI KNALHITb NO NiKTOrpami.

2. Y TMM4YacoBOMY CNMCKY MPaBO0 KHOMKOK KNALHITh MO MyHKTY, skuii 6axxaeTe
3akpinuTK, a noTim Bu6epiTh Pin to this list (3akpinuTh y uboMmy cnucky).

BiakpinneHHs NyHKTIB TUM4YACOBOro CAMCKY
LLlo6 BiaKpiNUTH NYHKTH TUM4ACOBOIO CMUCKY:
1. Ha naHeni 3aaay npaBoro KHOMKOK MULLi KNAUHITb MO NiKTOrpami.

2. Y TMMHYacoBOMy CMWCKY NPaBOO KHOMKO KNAUHIThb MO MyHKTY, SKuii 6axaeTte
3akpinuTu, a noTim BubepiTs Unpin from this list (BiakpinuTy 3 Lboro cnucky).

3akpinneHHs nporpaM y CTapToBOoMy MeHI0 a6o Ha naHeni 3apay

LLlo6 3akpinuTh nporpamu y CTapToBe MeHIo a6o Ha naHeni 3aaay:

1. Ha naneni 3agay Windows® knauHiTb no niktorpami SQ(CTapT) , o6
3anyctunTun meHto Start (CtapT).

2. [lpaBoto KHOMKOK MWULLI KNALHITL MO NYHKTY, AKuid 6axaeTe 3akpinuTi y Start menu
(CtapToBe MeHt0) abo Ha naHeni 3agav.

3. Bu6epith Pin to Taskbar (3akpinutu Ha naHeni 3aga4) a6o Pin to Start menu
(3aKpinuTi y CTapTOBOMY MEHIO).

Tako> MO>XXHa KraLHy TV NpaBoto KHOMKOK MULLI MO NIKTOrpami npaLitoro4ol nporpamu
Ha naHeni 3apay, a notiM BubpaTu Pin this program to taskbar (3akpinutu uio
nporpamy Ha naseni 3aapau).

BiakpinneHHs nporpam 3i CTapTOBOro MeHIo

LLio6 BiaKpinMTK Nporpamu 3i CTapTOBOro MEHIO:

1. Ha naHeni 3apgay Windows® knauHiTb no niktorpami SQ(CTapT) , o6
3anyctuTn meHto Start (CTapr).

2. Y TMMYacoBOMy CMMCKY NMPaBO KHOMKOHK KNAUHITb N0 MyHKTY, SKuii 6axxaeTe
3akpinnuTu, a noTimM Bu6epiTb Remove from this list (Buaanuty 3 uboro cnueky).

BiakpinneHHs nporpam 3 naHeni sapad
LLlo6 BiakpinuTK NporpaMu 3 naHesni 3apav:

1. Ha naHeni 3anay npaBoto KHOMKOHO KNALHITh MO MyHKTY, ik 6aXKaeTe BMAANUTY
3 naHeni 3agay, a notiM BubepiTb Unpin this program from taskbar (Biakpinutu 3
naHeni sagav).
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KopucTyBaHHS AiNAHKO NOBIAOMIIEHb
3a 3aMOoBYaHHAM AinsHKa NoBiAOMNEHb NOKA3ye Li TP NiKTOrpamu:

MoBigoMneHHs LeHTPy Ail

H i KnauHiTb no wiA niktorpami, o6 nokasysaTi nonepeaKeHHs/NoBifoOMNEHHs | 3anyckaTu
Windows® Action Center (LleHTp aiii Windows®).

Mepe>xeBe NiAKNIOYEHHs

dﬂ Lis nikTorpama nokasye cratyc niAKMo4eHHs i cuny curiany Apotosoi abo 6e3apoToBOI
Mepexi.

[(I’J:] FyuHicTb

KnauHiTb no wiid nikTorpami, LWo6 perynoBaTy ry4HicTb.

MNoka3 nonepeKeHHs
LLlo6 nokasaTu nonepeaXKeHHs:

. KnauHiTe no mikTorpami noBifOMAEHHS FJ NOTIM KNaUHiTb MO NOBIOMAEHHHO, 106
BiAKPUTY 0T 0.

[eTanbHitue npo Le po3nosigaeTtscs y po3aini Using Windows® Action Center
(KopucTyBaHHs ueHTpoM Aii Windows®) y Liii rnasi.

Oco6ucTe HanawTyBaHH NiKTOrpam i NoBigoMNeHb

Mo>xHa nokasysatut a60 NpuxoByBaTW MIKTOrpamu i NOBIAOMIIEHHS Ha NaHeni 3aaad abo y
LiNsHUi NOBiAOMIIEHb.

LLlo6 3po6uTh ocobucTe HanawTyBaHH NikTorpam i Noe E| NeHb:

1. Y pinsHUi NOBIAOMMEHb KNALHITb MO MIKTOrpami 3i CTPINKOK
2. KnauHitb no Customize (MpucrocysaTth).

3. Y BunagHomy cnvcky BM6epiTh "MoBeAiHKy" nikTorpam Ta yHKLUii, ski baxaete
npucTocyBaTyh Ans cBoix noTpeo.

YnpasniHHA dainamu i nankamu

KopuctyBaHHs Windows® Explorer

Windows® Explorer Haaae MOXMBICTb NepernsaaTv opraHiaosysaTyi chainm i nankv Ta
KepyBaTn HUMMU.

Banyck Windows® Explorer _—
LLlo6 3anyctut Windows Explorer: L2

1. Ha nawneni 3apa4 Windows® knauHite no nikrorpami Start (Ctapt)  , wo6
3anycTutn meHio Start (Ctapr).

2. KnauHite no Computer (Komn'totep), wo6 3anyctut Windows Explorer.

nasa 2: KopuctysanHs Windows® 7



Mepernspa chaiinis Ta nanok

LLIo6 nepernsiHyTH hainu Ta nanku:

1. 3anyctite Windows Explorer.

2. Ha naHeni HaBirauii abo nepernsigy 3HaingiTb po3tawlyBaHHs faHuX.
3. Y psaky Hasirauii KnauHite no cTpinui, Wob nokasaTty 3MIiCT ANCKY a60 nanku.
Oco6ucTi HanawTyBaHHs nepernsgy dainy/nanku

LLlo6 3po6uTH 0cobucTi HanawTyBaHHA nepernsay dainy/nanku:

1. Banyctitb Windows Explorer.

2 Ha naHeni Hasirauii BU6epiTb po3TallyBaHHsS AaHMX.

3. Ha naHeni iHCTpymMeHTIB knauHiTb no niktorpami View (Mepernsa)

4

Y meHto View (Mepernsia) nepecyHbTe NoB3yH, W06 B..L,,:rw cnoci6 nepernsigy

dhaiiny/nankum.
Tako>k MO>KHa NPaBO0 KHOMKOK MWL KNauHyTv 6y ab-Ae Ha naneni View (Mepernsag),
KnauHyTv no View (Mepernsa) i Bubpati 6axxaHnii Tun nepernspy.
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PosTawyBaHHs daiinis
LLIo6 posTawoByBaTyu (ainu:

1. 3anyctite Windows Explorer.

2. KnauwiTe no nonto Arrange by (PoaTtawysaty 3a), 1406 nokasaTy BUNAAHWIA CIMCOK.

3. BubepiTb yntobneHuin TMN po3TaLlyBaHHs.

CopTyBaHHs ¢aiinis

LLio6 copTyBaTh dainu:

1. 3anyctite Windows Explorer.

2. [NpaBoto KHOMKOM KNauHiTb Byab-ae Ha naxeni View (Mepernsg).

3. Y MeHIo, ske 39BUTbCS, BMGepiTb Sort by (CopTyBaTy 3a), noTiM BU6EpITb TUN
COPTYBaHHs, IKOMY BiaaaeTe nepesary.

Posnogin cbaiinis Ha rpynu

LLIo6 posnopinaTu daitnm Ha rpynu:

1. Banyctitb Windows Explorer.

2. [MpaBoto KHOMKOW KnauHiTb 6yab-ae Ha naHeni View (Mepernsg).

3. Y MeHio, sike 39BUTbCS, BUOEpiTL Group by (PoanoainsTi Ha rpynu), noTiM BUGEPITH
TN COPTYBaHHS, SKOMY BiafaeTe nepesary.

ASUS CG8580 201



[opatu HoBy nanky

LLlo6 gopaTtu HOBY nanky:

1. 3anyctite Windows Explorer.

2. Ha naHeni 3agay knauHite no New folder (HoBa nanka).

3. BsegaiTb Ha3By HOBOI Nanku.

Tako>X MO>KHa NPaBOo KHOMKOK MULLI KNauHyTv 6y ab-Ae Ha naneni View (Mepernsa),
noTiM knauHyTu no New (Hose) > Folder (Manka).

Pe3sepBHe KonitloBaHHs ¢aiinis

MnaHyBaHHS pe3epBHOro KONiloBaHHS
LLlo6 cnnaHyBaTi pe3epBHe KONilOBaHHS:

1. Knaunite rﬂ > All Programs (Bci nporpamu) > Maintenance (KepysaHHs) >
Backup and Restore (Pe3epBHa konisi i BiZHOBNEHHS).

2. KnauHiTe no Set up backup (CnnaHysaTi pesepsHe konitoBaHHs). KnauHiTb no Next
(Aani).

3. BubepiTb Micue npusHaveHHs pedepBHoi konii. KnauHiTe no Next (Aani).

4. Bubepits Let Windows choose (recommended) (Bubupae Windows -

pekoMeHAoBaHo) abo Let me choose as your backup mode (Hapatu MeHi npaso
BMOMpATK BalUMM PEXXMMOM PE3epPBHOrO KOMilOBaHHS).
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SAkwo subpatu Let Windows choose (Bu6npae Windows), Windows He po6butume
pesepBHMX konii Bawmx nporpam, dainis dopmaty FAT, cbaiinis Kowumka Ans CMiTTs
a60 Tumyacosux daiinis 1 M6 abo GinbLue.

5. BukoHyiTe iHCTPYKLUIi Ha expaHi, o6 3aKkiH4MTK npoLec.

BigHOBnNeHHs cucTeMu

Oco6nuBa xapakTepuctika Windows® System Restore (BinHosnerHs cuctemmn Windows®)
CTBOPIOE MyHKT BiATBOPEHHS, A 30epiratoTbCs HaNALWTYBaHHA CMCTEMU KOMM'IOTepa Ha
neBHWIA yac i Aaty. BoHa Hanae MOXXMBICTb BiAHOBMHOBATW CUCTEMY ab0 cKacoByBaTH
3MiHw B il HanawTyBaHHsx 63 BNAMBY Ha 0COBUCTI AaHi.

LLlo6 BigHOBUTHM cUCTEMY:

1. 3akpwuiiTe BCi npautotodi 3agaui.

2. Knaunitb rﬂ > All Programs (Bci nporpamu) > Accessories (Akcecyapm) >
System Tools (CucTtemHi iHcTpyMeHTH) > System Restore (BigHOBNEHHs cuctemu).

3. BwkoHyiiTe iHCTPYKUIT Ha ekpaHi, W06 3aBepLUnTy NpoLiec.
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3axucT Komn'loTepa

KopuctyBaHHs Windows® 7 Action Center (LleHTp giit Windows®7)

Windows® 7 Action Center (LleHTp ain Windows®7) Haaae nonepeakeHHs, iHhopmaLito npo
6e3neky, NiATPUMKY CUCTEMM Ta OMLit0, ika aBTOMATUYHO YCYBa€e AesiKi PO3NOBCIOAKEHI
npo6niemMu Komn'totepa.

Mo>xHa 3po6uTi 0COBUCTI HanaLTyBaHHS NoBifOMIEHb. [leTanbHille npo ue y po3aini
Oco6ucTe HanawTyBaHHA NiKTOrpaM i nonepesXXeHs y Lii rnasi.

3anyck Windows® 7 Action Center (LlenTp aiii Windows® 7)

LLio6 3anyctut Windows® 7 Action Center (LleHTp aiii Windows® 7):

1. LLlo6 3anyctut Windows 7 Action Center (LieHTp aiii Windows 7), knauHiTb no
niktorpami Notification (lMonepea>xenHs)  , a noTiM KnauHiTe no Open Action
Center (Bip,val:‘-J| LIeHTP AiiA).

2. Y Windows 7 Action Center (LlenTp giii Windows 7) knauHiTb no 3agadi, aky 6axaere
BUKOHATW.

KopuctyBanHa Windows® Update (BpockoHaneHHss Windows®)

Windows Update (BaockoraneHHst Windows) Haaae MOXNMBICTb NePeBIpsATU HAsBHICTb
BAOCKOHANEHb | BCTAHOBIIOBATY iX, LIO6 MIACUIUTY 3aXMCT | pOBOYi XapakTepUCTUKu
KoMm'toTepa.
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3anyck Windows® Update (BaockoHaneHHs Windows®)
LLlo6 3anyctut Windows® Update (BaockoHanenus Windows®):

1. Ha naHneni 3apay Windows® knauHiTb no niktorpami Sﬂ(CTapT) , o6
3anycTutn MeHto Start (Ctapr).

2. Bubepitb All Programs (Bci nporpamu) > Windows Update (BaockoHaneHHs
Windows).

3. Haekpani Windows Update (BaockoHnanenHs Windows) KnauHiTe no 3aaadi, siky
6axaeTe BUKOHATH.

HanawTyBaHHs 06niKoBOro 3anucy KopUcTyBaya i naponio

Mo>xHa cTBOptoBaTV 06MIKOBI 3anvcu | Naponi KOPUCTyBaYiB ANs OCi6, SKi
KOPUCTYBATUMYTHCH KOMM'IOTEPOM.

HanawTyBaHHs 0671iKOBOro 3anucyg<apucTyBaya

LLlo6 HanawTyBaTh 06MiKOBUIA 3an1c KOPUCTYBava:

1. Ha nanreni 3apay Windows® knauhits no > Getting Started (Mo4aTok
ekcnnyarauii) > Add new users ( > [logaT HOBUX KOPUCTYBaYiIB).

Bubepitb Manage another account (KepyBaTy iHWUMM 06NIKOBUM 3an1coM).
BubepiTb Create a new account (CTBOpUTH HOBMI 06NiKOBUA 3anuc).

BBegiTb iM' HOBOIO KOPUCTYBaYa.

o > 0D

BubepiTb Tvnom KopucTysaya Standard user (CTaHaapTHUiA KopucTyBauy) abo
Administrator (AamiHicTpaTop).

6. BukonasLum, knaHiTe no Create Account (CTBopuTH 06NiKOBMIA 3aNKC).
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HanawTyBaHHs naposiio KopucTyBa4a

LLlo6 HanawTyBaTK Naposb KOpUCTyBaua:

1. BubepiTb KopucTyBaya, ANs AKOro 6akaete BCTAHOBUTW Naposb.
2 Bubepitb Create a password (CTBOpuTH Naponb).

3. BeeaiTb naponb i NiATBEPAITL oro. BeepiTh niaKasky naponto.

4

BukoHasLum, knawiTe no Create password (CTBOpuTH Naponb).

AxTuBadis M3 aHTMBIpYyCYy

Ha Baw komn'toTep nonepeaHLo BcTaHoBneHO Trend Micro Internet Security. Lle
M3 aHTuBIpyCy TPETLOI CTOPOHHU, Sike 3axuiuae Baww Komn'toTep BiA aTak BipyCis.
Moro kynytoTb okpemo. Micns akTusawii Bam HanaHo 60-aeHHuii nepion Npo6Horo
KOPUCTYBaHHS.

LLlo6 akTuByBatu Trend Micro Internet Security:
1. 3anycTiTb 3aaady Trend Micro Internet Security.

2. YBaXKHO npouuTaiiTe yMoBM JNiLeHsiiHoT yroan. Knaunite no Agree & Activate
(MoroauTHcs | aKTUBYBATH).

3. BseaiTb aapecy enekTpOHHOI NOLWTY | BU6epiTb po3TallyBaHHs. KnauHite no Next

(Aani).

4. KnauHiTb no Finish (3akiHunTn), Wob 3aBepLunTyn akTuBaLito.
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Sk otpumatn Windows® Help and Support ([lonomora i
nigtpumka Windows®)

Windows® Help and Support ([Jonomora i nigtpumka Windows®) Hafae nigTpUMKY i
BiANOBIAI LLOAO KOpUCTyBaHHS 3aaadamu nnatcopmm Windows® 7. ﬂ

LLlo6 3anyctutn Windows® Help and Support (Jonomora i niatpumka Windows®), knauHits
no > Help and Support ([lonomora i nigTpuMKa).

MepekoHaitTecs, Wwo Bu nmigknoumnmcs oo IHTepHeT, Wwob oTpuMaTtit BAOCKOHANEHY
niaTpumky Windows® oH-naH.
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['naBa 3

MiaknioyeHHs npucTpoto nam'ati USB

Ha 3aaHiit i nepeaHiin naHensx crauionaproro MK e noptu USB 3.0/2.0/1.1. MopTn USB
Ha[at0Tb MOXIMBICTL NiaKMo4aTn npucTpoi USB, Taki sik npucTpoi nam'aTi.

LLlo6 nipxntounTi NpucTpiii nam'aTi USB:

+  BcrasTe npucTpiit npucTpiit nam'ati USB fo komn'toTepa.

YKpaiHcbka

MepenHs naHens 3aaHs naHenb

LLlo6 3HATM npucTpii nam'aTi USB:

1. Hatuchite B 06nacTi cnosiwenHs Windows Ha cBoemy
KoMmn’toTepi, noTiM HaTucHiTL Eject USB2.0 FlashDisk W Open Drvices and Pristers
(Butsartu USB2.0 FlashDisk) a6o Eject USB3.0 o Eject USE20 FleshDech
FlashDisk (Butsirtn USB3.0 FlashDisk), sikiiio Bu 1
BuKopucTosyeTe dnew-nam’stb USB3.0 a6o npucTpiid,
CyMicHuiA 3 TexHonorieto USB3.0.

2. Konu 3'sButbCs nosigomnexHs Safe to :
Remove Hardware (BeaneuHo 3HsATH [ oo rom the corputs
anapatHe 3a6e3ne4eHHs), 3HiMiTb NPUCTPI m
nam'sTi USB 3 komn'toTepa. ]

e divii can Al et el

' HE 3HIMAWTE npucTpiii nam'ati USB, konm Tpusae nepeaqa aaxnx. Lie moxe
é CNPUYUHNTY BTPATY AaHUX abo NOLUKOAUTM NpUCTPiil nam'aTi USB.
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MiaknioyeHHs MikpodoHa i AMHaMIKIB

CrauioHaptwii MK mae nopTv Anst MikpohoHiIB i AMHaMIKIB HA NepeHil | 3aAHil naHensx.
MopTu I/O aypio, po3TalloBaHi Ha 3afHil NaHeni, HaaatTb MOXXIMBICTb NigknoyaT 2, 4, 6
i 8-kaHanbHi CTEPEO-ANHAMIKM.

MNiaknioYeHHs HaBYLWHKKA | MIKPOGOHY

BX90HeIA
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MigknioyeHHs 4-KaHaNbHUX AUHAMIKIB
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Migknio4YeHHs 8-KaHanbHUX AUHAMIKIB
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MigknioyeHHs 6araTbox 30BHiLHIX gucnneiB

CrauionapHuii MK moxxe 6yTu ocHawenuii noptamu VGA, HDMI Ta DVI i Hagae
MO>XKJIMBICTb NigKIH04aTH 6araTo 30BHILLHIX AMCNAEIB.

R Konu Ha komn'toTep iHCTanboBaHo rpadiyHy KapTy, NiaKMo4iTe MOHITOPK A0 NOPTIB
BUX0JY rpadpiuHoi KapTu.
HanawTysaHHsa 6araTbox gucnneis

Mig yac kopucTyBaHHsa 6aratbMa MOHITOpaMu By MOXKeTe HanalwToByBaTh peXxXnmm
avcnineto. MoXHa BUKOPUCTOBYBATH 0AATKOBUIA MOHITOP 5K Ay6MiKaT rof0BHOr0
avcnnero abo siK NOA0BXEHHS, sike 36inbLuUye cTauioHapHuin komm'toTep Windows.

LLlo6 HanawTyBaTk 6araTto gucnneis:
1. BuMKHITb KOMN'tOTEP.

2. MMigkntoyiTb ABa MOHITOPM 0 KOMM'tOTEPA i MiAKMIOYITh LUHYPW XXMBNEHHS [0
MOHiTOpIB. [leTanbHille Npo MiaKMoYeHHs MOHITOpa A0 KOMM'loTepa po3ka3aHo y
po3aini HanawTyBaHHs KoMn'loTepa [nasu 1.

M &4
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%f Y pesikux rpadivHux KapT nuLLe MOHITOP, BCTAHOBIIEHWIA SIK NEPBUHHUIA AnCINER, MOXe
nokasysaTy 306pa>keHHs nifg Yac POST. OyHkuis noABiliHOro nokasy npawtoe nuie y
Windows.
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3. YBiMKHiTb KOMM'tOTEP.

4, 3pob6iTb 6yab-LUO 3 HACTYMHOrO, W06 BIAKPUTK EKPaH HanawTyBaHHs Screen
Resolution (YiTkicTb expaHy):

+  KnauHite > Control Panel (KoHTponbHa naHens) > Appearance and
Personalization (Burnsaa i nepconanisadis) > Display ([ucnnei) > Change
display settings (3MiHUTM HanawTyBaHHA AMCNNeI0).

+  [lpaBoto KHOMKOM KNauHiTh Byab-ae Ha pobouomy ctoni Windows. Konn
35BUTbCS TMMYACOBE MeHHO, KnauHiTb no Personalize (Mepconanisysath)
> Display (Aucnneif) > Change display settings (3MiHUTH HanawTyBaHHs
avenneio).

5. Bubepitb pexxum nokasy 3 Multiple displays: (barato aucnneis:) - BunagHoro

CUCKY.

. MoaBsoity ui ancnner: BubepiTts Lo onuito, Wo6 KopUCTyBaTUCS LOAATKOBUM
MOHITOPOM $IK Ay6iKaToM rONIOBHOMO AUCMIIE.

+ PoswmpuTti Ui aucnnel: Bubepithb Lito onuito, 06 KOPUCTYBATUCA LOAATKOBUM
MOHITOPOM $IK ACreeM po3LwmperHs. Lie 36inbLuye nnoLly po6o4oro crony.

+  TMokasysatu po6ouuii cTin Tinbkn Ha 1/2: BnubepiTb Lito onLito, o6 nokasysaTu
po6oynii CTiN NnULe Ha MOHITopi 1 a6o MOHITOpI 2.

+  3HATH Uei aucnnei: BubepiTb Ui onuii, LLo6 3HATM BUOPAHWIA AMCNNEN.

W on G 1 favin bases

Dk L ARLMATT
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6.  Knaunitb no Apply (3actocysatu) abo OK. lNoTim knauniTe no Keep Changes
(36eperTyn aMiHK) y NOBIZOMNEHHI NiSTBEPAXKEHHS.

Dicplay Settngs H':h'

Do youw want (o keep these dplay settings?

Ko charge

| Reverting to previews saplay sethings in & seconds,
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MNigknioyeHHs HDTV

MNigkntovite TB Bucokoi vitkocTi (HDTV) go nopty HDMI Ha komn'toTepi.

+ [Ons nigkmovenns HDTV i komn'toTepa 3Hapobutbes kabens HDMI. Ka6ens HDMI
CIifi KynyBaTh OKPEMO.

LLlo6 oTpumaTh Haiikpatli po6oyi xapakTepuCTUKK, NepekoHanTecs, Lo [OBXMHA
kabento HDMI meHLwe 15 meTpib.
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['naBa 4

MpaBunbHa nocTasa nif Yac KOPUCTYBAHHS CTaLiOHAPHUM
nK

Mg vac kopucTyBaHHs cTauioHapHuM MK BaXXIMBO CTEXWTU 3a NPaBUILHOK NOCTABO,
06 YHWUKHYTW PO3TArHEHHS 3an'saCTb, KUCTEN PYK, TPABMYBaHHS Pi3HUX Cyrniobis Ta
M's3iB. Y LbOMY pO3Aini NoAaHo NifKasku, Ik YHUKHYTU (Di3UHHOr0 AMCKOMAOPTY i
MO>KJIMBUX TPaBM MifJ 4ac KOpUCTyBaHHs ctauioHapHum MK i oTpumyBaTh 3a80BONEHHSA
Bifl pO6OTY Ha HbOMY.

PiseHb oueit - Bepx

eKpaHy MoHiTopa 1
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OcriiH nig cTonu \ \

\Mﬂfm}lﬂm || St

LLIo6 cTeXxuTH 3a MpaB1bHOIO NOCTaBOIO:

. lNocTasTe cTineup Tak, Wo6 NiKTi 3HAXOANNUCS TPOXM BULLe KnasiaTypu i Bam 6yno
3py4HO ApyKyBaTu.

. Bigperyntoiite BUCOTY CTiNbLS TakK, 06 KOJiHA 3HAXOAWINCS TPOXM BULLE CTETOH,
i CTerHa He CMNbHO Hanpy>xyBanucs. Y pasi HeobXiAHOCTi MiACTaBTe nif CToNM
OCNiHYMK, 06 KOJiHA 3HAX0AWIINCS BULLIE.

. BigperyntoiiTe NONOXEHHS CMIMHKK CTiNbLs, WO6 3HM3y XpebeT HagiliHo i 3pyyHO
niATPMMYBABCS | AELLO BiAXMNSABCS Hasag.

. Cwaitb nepea MK npsamMo Tak, Wwo6 nikTi i KoniHa 6ynw 3irHyTi nig KyTom 90°, i cTerHa
6ynu TeXX Po3TaLLoBaHi Mif NPSMUM KYTOM MO BiAHOLLEHHIO A0 Tyny6a.

. PosTallyitte MOHITOpP NpsIMO Nepej Co60k0 | NOBEPHITb eKpaH MOHITopa Tak, LWo6
IMBUTUCS HA HBOTO TPOXYW 3ropy BHUS.

. TpumaiiTe MULLY NOpy\ i3 KNasiaTypoto i, B pasi HeobXiAHOCTI, KOPUCTYTECS
0ropoIo NS 3an'ACTS, W06 3MEHLMTM TUCK HA 3an'sCTS Mig Yac ApyKY.

. KopucTyiitecs ctauionapium MKy obpe ocBiTnEHOMY MiCLi, He po3TalLoByiTe
70ro Tak, o6 Ha expaH noTpannsanmv Biabanckm BiA BikHa abo NpsiMe COHSYHE
MPOMiHHS.

PerynspHo po6iTb KOPOTKi Nepepsu nif 1ac poboTn Ha cTavioHapHomy TK.
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KopucTyBaHHSl NPUCTPOEM YNTAHHS KapT

Linchbposi dhoToanapaty Ta iHLi LMdPOBI NPUCTPOT Ans rpadiuHmnx 3aBaaHb
BUKOPUCTOBYIOTb KapTK NaM'aTi Anst 36epexxeHHs LM posux 306paxKeHb abo MeAiitHnx
dpaiinis. B6ynosaHuii NpuCTpiin UNTaHH: KapT Nam'aTi Ha NepeaHin naHeni cucTemu Hafae
MOXIMBICTb YMTATM [iaHi 3 PI3HNX KapT Nam'sTi i 3anucysaTi Ha HAX AaHi.

A

LLIo6 KopucTyBaTMCSA KapTOIO Nam'sTi:

1. BcTasTe kapTy nam'siTi 40 0TBOPY KapTu.

S
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+ KapTa nam'sii Mae penbeHmit KOHTaKT, sIKUiA BXOAUTL IO OTBOPY NULLIE B OAHOMY
Hanpsimky. HE BCTABJTAUTE kapty CMJIOMILIb ao oTBOpY, W06 He NOWKOANUTY Ti.

+ Mo>Ha BCTaBAATM MO OIHOMY HOCIto B KOXEH i3 OTBOpIB NS KapT i KOPUCTYBATUCA
KOXHUM 3 H1X OKpemo. Po3TalLoByiiTe nuLle no OAHiA kapTi B 0AHOMY OTBOPI.

2. BubepiTb nporpamy 3 BikHa AutoPlay, 06 yBiiiTu 8o chaiinis.

(Crapr) Ha naHeni 3apay Windows® 7, knauHite no Computer (Komn'totep) i aBivi

% + Skuwo AutoPlay HE akTuBoBaHo Ha Balomy komn'toTepi, knauHit no kHonui Start
— KflauHiTb No nikTorpami kapT nam'sTi, LWo6 yBIATW 4O AAHWX Ha Hild.

+ KoxxeH oTBip KapT1 Mae BnacHy niktorpamy AMCKOBOAA, MoKa3aHy Ha ekpaHi
Computer (Komn'totep).

+ CBITNOAIOA NPUCTPOIO YNTAHHSA KaPTU NaMm'sTi 3aropseTbCs | MEPeXTUTL nia Yac
ynTaHHs abo 3anncy AaHnX Ha KapTi nam'aTi.

3. 3akiHuMBLLK, NPaBOO KHOMKO KNaLHiTh NO NIKTOrpami AMCKOBOAA KapTh NaMsTi Ha
ekpaHi Computer (Komn'totep), knauHits no Eject (BuBiNbHUTY), a NOTiM BUBINbHITH

Hikonu He BuiimMaiiTe kapTu NiA Yac konitoBaHHS, popmaTyBaHHs abo BUAANEHHS faHUX
Ha kapTi a6o 0Apasy no 3aKiH4eHHIO MPOLIECY - Lie 3arpo>Xye BTPATO AaHMX.

) LLlo6 3ano6irTv BTpaTi AaHuX, kopucTyiTecs Safely Remove Hardware and Eject Media
é (BeaneyHo BuAanMTK anapaTHi 3aco6M i BUBINbHWTY HOCIH) y AiNSHLI NOBIAOMNEHb
Windows, nepLu Hix BUAANUTY KapTy nam'ari.
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KopucTtyBaHHA ONTUYHUM AUCKOBOAOM

BcTaBuTH onTUYHKIA AUCK
LLlo6 BCTaBUTU ONTUYHUIA AUCK:

1. Konu Balla cucTema 3aBaHTaXXUTbCS, HATUCHITL KHOMKy PUSH.

2. HaTuCHITb KHOMKY BUTAraHHs HUXK4e Mif KPULLKOK ONTUYHOrO Npusoay, Wob
BiAKPUTU JTOTOK.

3 BcTtasTe avck Spnvkom Bropy A0 ONTUYHOIO ANCKOBOAY.
4 MpocyHbTE NOTOK, W06 BiH 3aKpuBCS.

5 Bubepitb nporpamy 3 BikHa AutoPlay, W06 yBiiTu fo caiinis.

SAkwo AutoPlay HE akTnBoBaHo Ha Baluomy komn'toTepi, knauHiTe no kHonui Start
(CtapT) Ha naHeni 3aga4 Windows®7, knauHitTe no Computer (Komn'iotep) i Agidi
- KnauHiTb o nikTorpami auckosody CD/DVD, wo6 yBiiAT1 A0 AaHUX HA HbOMY.

Bupanutn onTUYHMIA guck

LLlo6 BuaanuTi onTUYHUA AUCK:

1. Konu cuctema yBiMKHEHA, BUKOHATE 6y Ab-LL0 3 HACTYMHOrO, W06 BUBINBHUTH
NOTOK:

HaTuCHITL Ha KHOMKY BUBINIbHEHHS Nifi KPULLKOHO BIfCIKY ANCKOBOSY.

[MpaBoto KHOMKO KNauHiTb o nikTorpami avckosoga CD/DVD Ha ekpaHi
Computer (Komn'totep) i knauHiTe no Eject (BusinbHutH).

2. BuiiMiTb AUCK 3 AMCKOBOAY.

ASUS CG8580
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BukopucTaHHs irpoBoi knasiatypu ASUS ROG U9N

Y komnnekT Baworo komn’totepa CG8580 Essentio BxoanTs irposa knasiatypa ASUS
ROG U9N, sika € onTumanbHo Ans irop.

MepernsHbTe po3ain BMicT ynakosky, W06 Ai3HATUCS NPO BMICT KOMNAEKTY irpoBoi
knasiaTypn ASUS ROG U9N.

BeTaHoBneHHs irposol knasiatypu ASUS ROG U9N
1. CkopucTaitecs cTaHAapTHUM nepexifHnkom 3 PS/2 Ha USB, wo6 nig’enHaTn cBOKO
irpoBy KnasiaTypy A0 komn’toTepa Yepe3 nopT USB 2.0.

DD DODOOODDEEE 268
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2. BcrasTe niacTasky Ang 3an’sacTb B Na3w Ha knasiaTypi (A). O6oma BenMKumMu
nasnbLsMK HATUCHITL NiACTaBKy, JOKM BOHA HE BCTaHe Ha Micle (B).

3. TlMepesanycTitb komn'toTep. Windows® aBToMaT4HO BCTAHOBUTb YCi HEOOXiAHI
ApaiiBepu ANis BALLO| KnasiaTypw.
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BukopucTanHs irposoi Muwi ASUS GX900

Y komnnekT Baworo komn’totepa CG8580 Essentio BxoanTk irposa muwa ASUS GX900,
AKa 3abe3neqye MakcumarnbHWiA KOHTPOMb rpy.

% MepernsHbTe po3ain BMicT ynakosku, Wo6 Ai3HATUCS NPO BMICT KOMNAEKTY irpoBoi
knasiaTypn ASUS ROG U9N.

IrpoBa muwwa ASUS GX900 MicTUTb niBy Ta Npasy KHOMKW, KONECO MPOKPYTKK, ABi GOKOBI
KHoMKw, kHomky DPI Ta cnewiansHO CTBOPEHY KHOMKY NepeKntovaHHs npodinto.
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Knasiwi Onuc Onuc

1 JliBa kHOMKa 7 Jorotun GX900

2 lMpasa kHonka 8 KHorka «Bnepea» B |E

3 Koneco npokpyTku 9 KHonka «Ha3zapg» B IE

4 Mepemukay DPI 10 HW>XHS YacTuHa MU

5 Knonka NEPEMVKaHHS npodinto/ 1 HuxHs HVaCTI/IHa MULLI Ta NOABINHMIA
IHankaTop npodinto* NasepHuii ceHcop

6 CsiTnogioaHwii inavkatop DPI** 12 Banact (5 6nokiB no 4,5 r.)***

Hokk

LLlo6 HanawTyBaTh CBOK MULLY, fOAaTE abo BUIAMITL 610KK 6anacTy.
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CaiTnogioAHa iHAVKaLis nepeknoyaHHs npodinio

Konbopw caiTnogiona | Inawkais
IHaMKaTop He CBiTMTbCﬂ‘ 3Bn4aiitui npodine

3eneHuii ‘ Mpodink 1
YepBoHwii ‘ Mpodpink 2
OpaH>KeBuit | Mpodpine 3

**CpiTnopioAHa inavKauis nepekniovaxHs DPI
Konbop# csitnogioaa \ IHpuKauis
2 ‘ DPI nepuioro piHs

4 ‘ DPI piBHs 2

Banyck nporpamu 3anyck nporpamu

CneuianbHo po3po6sieHa nporpama nonepejHbLo iHCTanboBaHa Ha Baw
KoMn’loTep, i ue Haaae Bam MoXXNUBICTL HanawTyBaTy irpoBy MULLY Tak, Wo6
BMKOPUCTOBYBATH BCi TT 0CO6NUBI XapaKTepUCTUKM.

Konu Bu Bnepiue nigknioyaete irpoBy muwy ASUS GX900 go koMn’ioTepa
nepep 3anyckoM Windows® 7, nporpamMa aBToMaTU4HO BU3HAYae MULLY,
i B0 HeT MOXKHa BXoAUTH GeanocepeaHbo. Y NpoTUNEeXXHOMY BUNaaKy Bam

Skwo asTo3anyck Ha komm'toTepi HE BBIMKHEHO, NepernsHbTe BMICT KOMNaKT-A1CKa,
06 3HaiiTh hann GX900.exe. [siui HaTUCHITL haiin GX900.exe, LWO6 3anyCTUTK
nporpamy.

3Hafo06MTLCA BPY4HY BCTaHOBMOBATH yTURITY 3 DVD niaTpuMky.

LLlo6 iHcTantoBaTk nporpamy 3 DVD niaTpumku, sctaste DVD nigTpumMku
710 ONTUYHOrO AUCKOBOJAY i BUKOHYATE iHCTPYKLIT Ha eKpaHi, o6 3anycTUTH
nporpamy.

MepekoHaiiTecs, Lo irpoBa Muwwa nig’eaHasa o USB-nopTty komn’totepa. Mporpama
aBTOMATUYHO 3Haiifie MULLY Ta BiA0GPa3NTb rONIOBHE MEHIO.
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[FonoBHe MeHI0

1
2

3

10
11

HaTucHITb KOXKHY BKNagky, o6 nepernsHyTN MeHK0 BU6paHoro npodisto.
Binobpaxae nikrorpamy npodinto HanawTysaHHs MeHro npodinis 1-3.
HaTucHiTb, Wo6 3MiHnTY HanawTysaHHs DPI Ha nonepeaHb0 36epexeHi
HanawTyBaHHs.

lMepeTarHiTh 6GiryHoK, Wo6 HanawTysaTi BennunHy DPI ans KoxxHoro
PiBHS.

HaTtuCHiTb, WO6 3aMiHNTW HANaLITYBaHHS KHOMKK HA nonepeHi
HanawTyBaHHs

HaTtucHiTb, Wo6 BiA0OPA3NTK iHLLI KONbOPK iHAMKATOPIB NPOINto Ta ix
cTaryc..

HaTucHiTb, W06 3aBaHTaXKUTH 36epexxeHmnin Npodink y CBOKO MULLY.
HaTtucHiTb, WwWo6 36epertit NOTOYHI HANALLTYBaHHS NPOINO Ha XXOPCTKOMY
ZINCKY.

HaTtucHiTb, Wo6 3amMiHMTK HanalITyBaHHs MULLI Ha HanalwTyBaHHS 3a
YMOBYaHHSAM.

HaTtucHiTb, W06 36epertvt 3miHu.

HaTtucHiTb, W06 36eperTvt 3MiHU Ta BUIATY 3 NporpaMu.

* KoxeH npodink Haaae asa pisHi DPI. FKLLo BMMKAeTLCA ABA CBITNOAIOAN NEPEMUKAHHS
DPI — ue 03Havae, LU0 BUKOPUCTOBYETLCA NEPLUNiA PiBEHb, 8 BMUKaHHS HOTUPBOX
CBITNOAIOAIB BKA3YE HA [PYrAii PiBEHD..

ASUS CG8580
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MpodbinL 1 MEHI0

BUTIONSETTIN
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1 HaTuCHITb, W06 BiAKPUTY MEHIO peaaryBaHHs i 3MiIHWTW Ha3BY i
niKTorpamy npowisnto.
2 BeeaiTb Ha3sy npodinto.
3 HaTtucHiTb, W06 BkasaTu aiin 306pa>keHHs, ke BU Xo4eTe
BUKOPUCTATW 5K NIKTOrpamy npoainto.
BubepiTb yHKLitO ANS KOXHOT KHOMKW/AT 3i CNaaHOro Crineky
4
*Y Tabnuui HUXKYE MOXKHA 3HANTW [JOKNAAHILLY iHchopmaLito.

Jlisa kHOMKa DyHKLiS NiBOT KHOMKN MULL
Mpasa kHonka OyHKUis NPasBoi KHONKW MULL
CepepHs kHonka | DyHKLUIS CepeaHbOi KHOMKN MULL

@yHKUis KHOMNKK «Hazaa» B |E. SKLWo BM6paHo Lo yHKLUito,
«Hasap» B IE MO>XHa HAaTUCHY TN KHOMKY, LL06 NOBEPHYTUCS HA NonepeaHto
CTOPIHKY..

@yHKuis KHonku «Bnepea» B IE. Ko BuGpaHo Lo yHKLito,
«Bnepen» B IE MO>XHa HAaTUCHYTYW KHONMKY, W06 NepeiTi Ha HacTynHy
CTOPIHKY..
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OyHKuiT Onuc

KnasiaTypa

Macro

Script #1-6

DPI [+]

DPI []

DPI Level 1/2
Profile Switch
Normal Profile
User Profile 1/2/3

Wheel (left/right)

Rapid Fire
(mouse)

Rapid Fire (key)

Web Browser
E-mail

Media Player

Play/Pause

Stop

Next Track

Prev Track
Volume Up/Down
Mute

Calculator

My Computer
Disabled

HaTucHiTb KHOMKY, W06 BMKOHATW HATUCKAHHSA KNaBilli Yn KoM6iHauii
KnasiLL.

HaTuCHITb KHOMKY, 06 BUKOHATU KOMaHAY Yu Cepito KOMaHA, siki
MO>XHa 3MIHUTV B MEHIO peaarysaHHs Makpoca. [ius. Macro menu
(MeHto makpoca), LWo6 oTpuMaTi AOKNaaHiLLy iHopmaLito.

HaTuCHiTb KHOMKY, LO6 3anyCTUTH CLeHapiid, SKnidi MOXXHa
penaryBaTti B MEHI0 pefiaryBaHHs cueHapito. [us. Edit Script
menu (MeHto peaaryBaHHs cLeHapito), Wo6 oTpuMaTh AoKNafHiLLy
iHpopmaLito.

HaTtuCHiTb KHOMKY, W06 36inbWwnTh Benn4mHy DPI.

HaTucHiTb KHOMKY, W06 3MeHWwuTH BennunHy DPI.

HatwcHiTb kHoMKy, Wo6 BukopucToBysaTh DPI pisHis 1/2.

DyHKLUIS KHOMKN NEPEKNIFOHaHHA NPodinto

HaTuCHITL KHOMKY, LO6 BUKOPUCTOBYBATM 3BMHAIAHIIA NPOIib.
HaTtucHiTb kHOMKy, W6 HanawTysaT npodins 1/2/3.

HaTucHiTb KHOMKy, 06 NPOKPYTUTY BAIBO/BNPaBO, 5K N Yac Haxwny koneca.

7

Lis coyHkuist npautoe nuwe B nporpamax Microsoft®
Office Ha onepauiinnx cuctemax Windows® 7/Vista.

HaTucHiTb KHOMKY, 106 BiAKPUTY LLIBUAKWIA BOTOHb Mif 4ac atakm
B IPi, TAKOro X eeKTy Mo>KHa A06UTUCS, TPUUI HATUCHYBLUK NiBY
KHOMKY MMLL.

HaTucHITb KHOMKY, 106 BiAKPUTY LIBUAKWUIA BOTOHb B IPi, HATUCHYBLUM
npoGiN ANs No4aTKy ataku, Lo Ait0 MOXKHA TakoX BUKOHATH, TPUYi
HaTWCHYBLUW NpO6is.

HaTwucHiTb KHOMKY, W06 3amycTuTy CBill BE6-Nepernsaay 3a
YMOBUYaHHSAM.

HaTWCHITb KHOMKY, 06 3anyCTUTW CBIll MOLITOBMIA KNIEHT 3a
YMOBY@HHSIM.

HaTucHiTb KHOMKY, LWO6 3anyCTUTY CBili Meaianporpasady 3a
YMOBYaHHSM.

Lli KHOMKW € KHOMKaMW KEPYBaHHS BiATBOPEHHSIM aKTUBHOTO
Megianporpasaua.

HaTuCHITb KHOMKY, W06 36iNbWUTU/3MEHLLMTH TYYHICTb CUCTEMM.
HaTuCHITb KHOMKY, 06 BBIMKHYTM Yt BUMKHYTU 3BYK.
HaTtucHiTb KHOMKY, W06 3anycTuTi nporpamy Kanbkynsrtop.
HaTucHiTb KHOMKy, W06 BiakpuTY BikHO Komm'toTep.

BubepiTb Lieit eneMenT, o6 BUMKHY TV BUGPAHY KHOMKY MULLI.
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MeHio peaaryBaHHsi Makpoca

Peparysatu
Makpoc

XpoHomeTpax

BcTtasutu

Posnouatu*
SYNUHUTH
OuncTuTHn

MepemicTuTyn
Bropy/BHu3

Tpusanictb
LMKy KOMaHAu

MosTopioBaTH

BoroHb

MpoposXyBaTy
BOrOHb

Ekcnopt
IMnopt

HaTuCHITb, 1106 BiAKPUTW MEHIO peJaryBaHHs Makpoca.

BunbepiThb Lieit eneMeHT, o6 3anuncaTti 4ac HaTMCKaHHs KHoMKK. (3a
YMOBYaHHSM: 12 MinicekyHA)

Konu BubpaHo uto onuito, HoBa komaHaa 6ye BCTaBnaTucs
nepea BM6PaHO KOMaHAOH. |HaKLLe KOXHa HOBa KOMaHAa
BM3HA4YaTUMETLCS 5K NOYaTKOBA.

HaTuCHITb, 106 po3noyaTyt 3anuUcC HATUCKAHHA KNasgill i/abo Ain MuLui.
HaTtucHiTb, Wo6 3ynMHNTM 3annuC HaTUCKaHHS Knasil i/abo Ai MuLui.
HaTWCHITb, W06 0UMCTUTH 36epeskeHi KOMaHAN.

HaTwucHiTb, Wo6 nepeMicTUT BUGpaHy KOMaHay Bropy/BHu3.

Konn XpoHomeTpak BAMKHEHO, Yac 3aTPUMKW BCix il 6yne
BU3HAYATUCS BENNYMHOIO, SIKY BU BUOEpEeTe 3i CnafiHoro Crimucky.

Makpoc 3anyckaeTbes Nicns HaTUCKaHHS, a 3ynNuUHSAETBCS nicns
MOBTOPHOIO HATUCKaHHS.

MaKpoc BUKOHYETLCA NuLLe pas Micnst OHOTO HATUCKAHHS.

Makpoc 3anycKaeTbCsi, KOnM BM 3aTUCKAETE KHOMKY, a 3yMUHAETHCS,
KON KHOMKY BiAnycKaeTe..

HaTtucHiTb, Wo6 36epertit NOTOYHMIA MaKPOC Ha XXOPCTKOMY AMCKY.

HaTtucHiTb, Wo6 3aBaHTaXXMTU MAKPOC i3 XXOPCTKOro Aucka.

nasa 4: KopucTysaHHs koMn'toTepoM



MeHio peparysaHHs cueHapilo

EnemeHTn Onuc

Peparysatu
cLeHapii

XpoHoMeTpax

BctaButu

Posnouatu*
3ynuHuTH
Ouunctutn

MepeMicTutn
Bropy/BHu3

Tpusanictb
LMKINy KOMaHAau

MosTOptoBaTH

BoroHb

Mponosxysaty
BOTOHb

ExcnopT
IMnopT

HaTtucHiTb, W06 BIAKPUTY MEHIO pefiaryBaHHs CLeHapito.

BnbepiTb Lei enemenT, LWo6 3anucaTi Yac HaTUCKaHHs KHomku. (3a
YMOBYaHHAM: 12 MifiCeKyH[)

Konu Bu6paHo Lo onuito, HoBa KoMmanaa byne BCTaBnsTMCS
nepes Bu6paHor0 KOMaHAOH. IHaKLLIe KOXHA HOBA KOMaHAa
BU3HA4YaTUMETbLCA AK NoYaTKoBa.

HaTucHiTb, W06 po3noyaTi 3anuc HaTUCKaHHS KNasill i/abo A MuyLLi.
HaTuCHITb, W06 3yNUHUTY 3an1C HAaTUCKAHHS KNaBill i/abo A MuLwi.
HaTucHiTh, W06 0uncTUTH 36EpekeHi KOMaHaN.

HaTtucHiTb, W06 nepeMicTUT BUGpaHy KOMaray Bropy/BHu3.

Konun XpoHomeTpaxk BUMKHEHO, Yac 3aTPUMKH BCiX Ll 6yfe
BU3HAYATUCS BENMYMHOIO, SIKY BM BUOEPETE 3i CNafHOro CIMUCKY.

CueHapiit 3anyckaeTbCs MiCNs HATUCKAHHS, a 3yNUHAETLCA Micns
MOBTOPHOIO HATUCKaHHS.

CueHapiil BUKOHYETBCS NWLLE Pas MiCNs OAHOMO HATUCKAHHS.

CueHainl 3anyCKa€eTbCA, KON BU 3aTUCKAETE KHOMKY, a 3YNNUHAETLCA,
KO KHOMKY BiJJI'IYCKaGTe.

HaTucHiTb, W06 36eper™ NOTOUHWIA MakpOC Ha XXOPCTKOMY AUCKY.
HaTtuCHITb, 106 3aBaHTAXXMTW MAKPOC i3 XXOPCTKOrO AMCKA.
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maBa 4: KopucTyBaHHs KOMM'toTEpOM



['naBa 5

[lpoToBe NiAKNIOYEeHHA

Kabenem RJ-45 nigkntodiTe Komn'toTep Ao DSL/kabenbHoro Mofemy abo nokansHoi
mepexxi (LAN).

MNiaknioyeHHs yepe3 DSL/kabenbHuii Mosem

Ans nigknioyeHHs yepes DSL/kabenbHuii MofeM:

1. HanawTyiite DSL/ka6enbHWiA MOLEM.

% KopucTyiitecs pokymeHTauieto o DSL/kabenbHoro mogemy.

2. MMigkntouiTe 0AMH KiHeub Kabento RJ-45 no nopty LAN (RJ-45) Ha 3aaHii naHeni
KoMn'toTepa, a iHWKiA KiHeub - Ao DSL/kabensHOro Moaemy.

©
¥
.
3}
=
[
o
X
>

00
O

3. YBiMkHiTb DSL/KabenbHuit MofieM i kommn'toTep.

4. KoHepirypyiTe HeoOXifHI HanalTyBaHHS NiAKMOYEHHS A0 [HTEPHET.

3BepHiTbCA [0 IHTepHeT-nposaiigepa (ISP), Wwob pisHaTucs GinbLue i oTpumaTy
AOMOMOry B HanalUTyBaHHi NifKMOYEHHS A0 IHTepHeT.
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MigkniovyeHHs Yepes nokanbHy Mepexy (LAN)
LLIo6 nigkniounTHCS Yepes NoKanbHy Mepexy:

1. MigkntouiTe 0AMH KiHeupb Kabento RJ-45 go nopty LAN (RJ-45) Ha 3aaHiin naHeni
KoMM'toTepa, a iHWwui KiHeup - o LAN.

<
A
©
D
=
o
o
A
Q

2. YBIMKHITb KOMM'tOTEP.

3. KoHdirypy#Te HeobXiaHi HanaLTyBaHHS NiAKMOYEHHS A0 IHTEpHeT.

3BEPHITLCA 10 MEPEXXEBOro aAMiHicTpaTopa, Wob AisHaTucs GinbLue | oTpUMaTH
[0MOMOrY B HanaLUTYyBaHHi NiAKMOYEHHS A0 IHTEpHeT.
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BesapoToBe NiAKNIOYEHHS (NIULIe Ha OKPeMMUX MOAENsX)

MigkntouiTe KOMM'tOTEpP A0 IHTEPHET Yepe3 6e34pOTOBE NiAKMOYEHHS.

R LLlo6 BcTaHOBMTY 6€34POTOBE NiAKIIIOYEHHS, CIif NiAKMIOYNTY 6E3APOTOBY TOUKY
noctyny (AP - T).

LLio6 BcTaHOBUTH 6€3ApOTOBE NiAKIIOYEHHS, KOPUCTYHTECS OAHUM i3 HACTYMHUX
MeTopiB:

YKpaiHcbKa

ABO

BesgpoToBa

vvireless AP

Moaem

Moaem
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+ LLlo6 36inblunTK Aiana3oH i YyTAMBICTb A0 6€3APOTOBOrO pagiocurHany, niaknoYite
30BHILLHI aHTEeHW A0 cronyyyBadiB aHTeH Ha kapTi ASUS WLAN.

+ PoaTallyitTe aHTeHM 3ropu Ha KoMn'toTepi, LWo6 0TPUMATK KpaLly SIKiCTb 3B'A3KY.

+ 30BHILLHI aHTEHW € AOAATKOBUMM.

LLio6 niakniounTUCs A0 663APOTOBOT MEpeXi:

1. KnauiTb no niktorpami u y AiNsHUI NOBIAOMNEHb, W06 NoKasaTh LOCTYNH
6e34pOTOBI MEPEXKI.

2. BubepiTb 6e38p0OTOBY MEPEXY, A0 AKOT BaKaeTe NiAKIIoYMTHCS, NOTIM KNaUHiTb Mo
Connect (MipkniounTucs).

3. Moxxe 3HanobuTHCs BBECTU MEPEXXEBUIA KITIOY 6e3nekn i 6e3nekn 6e30poToBOT
Mepexi, a NoTiM knauHiTe no OK.

4. TlodekaiiTe, NOKM KOMM'OTEP NiAKMOYATLCS A0 6E3APOTOBI MEPEXi.

5. Be3apoToBe MiAKNOYEHHS YCNilLHO BCTAHOBNEHO. [10Ka3aHo CTaTyc NiaKMoYeHHs, i

A

niKkTorpaMa Mepexxi NnoKasye cTaTyc niaKoveHHs ke,
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[‘naBa 6

[lo KomnnekTy MoXyTb He BxoanTi DVD nigTpumkm i DVD BifHOBREHHS. [Ins CTBOPEHHS
DVD nigTpumky i DVD BiiHOBNEHHS MO>KHA BUKOPUCTOBYBATK (OyHKL0 Recovery
~ Partition (Jloriunuin auck BigHOBREHHS). [leTanbHille e onucaHo B rnasi Recovering

ASUS Al Suite Il

ASUS Al Suite Il - ue iHTepdpeiic "Bce B 0AHOMY", AKMiA NOELHYE B COOI

nekinbka ytunit ASUS i Hafae MOXXNMBICTb 0AHOYACHO 3anyckaT Ui yTuniTv i
KOPUCTYBATUCS HAMM.

KopuctyBaHHs Al Suite Il

Al Suite Il aBTomMaTu4Ho cTapTye, konm Bu Bxoaute go OC Windows®. Y ginsHui
nosigomnexb Windows® 3'sensieTbes niktorpama Al Suite 1. Knaunite no
nikTorpami, o6 BiAKPUTHU NaHenb ronosBHOro meHto Al Suite 1.

KnauaiiTe no KOXHii 3 KHOMOK, LWo6 BubupaTu i 3anyckaTu yTURIiTy, CTEXXUTH 3a
po60To cucTeMu, BAockoHantoBaTn BIOS maTteprHebkoi nnatu, nokasysaTtu
iHcbopmauito cuctemu i npucTocoByBaTh HanawTysaHHs Al Suite |1

KnauwiTs, wo6 KnauwiTs, wo6 nokasaTtn

K::nl.:mn, o6 Bu6Gpatn BROCKOHaNUTH BIOS :ig)l?guauuo NiATPUMKM
y v MaTepMHCLKOT nnaTtu KnauyHitb, W06 3po6uTy
KnauyHiTb, W06 cTexxuTn 3a KnauHirs, 0COGUCTI HanalTyBaHHA
ceHcopamu a6o 4acToTol wo6 nokasaTtu iHTepdeiicy
LleHTpanbHOro npouecopa. iHcbopMmaLilo cuctemu
R + 3apavi MeHto Tool (IHCTpyMeHT) 3anexarb Bif Mofeni.
+ CkpiHwoTu Al Suite |l B KepiBHULTBI KOPUCTYBAYa HafaHi NuLe K AOBIAKOBUIA

matepian. Cnpas>cHi CKPIHLLOTY BiAPI3HAOTLCS Bifl BKa3aHUX 3aN1eXKHO Bif MOAENI.
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IHCTpYMeHT

Mento Tool (IHcTpymeHT) Bktouae System Level Up (Ha piBeHb Bropy B cuctemi), Probe I,
Sensor Recorder (MarHiTocpoH) i Ai Charger+.

MigHATTS cucTemMu

MigHaTTS cucTemn [o3BONSE posirHaT cuctemy B cepenosuli Windows® 3a [ONOMOrow
HanawTysaHb NPowinto.

LLlo6 3anycTuTu NifHATTS cMCTeMK, HATUCHITL Tool (IHeTpyMeHTH) > System Level Up
(MipHaTTS cucTemn) Ha naHeni mexto nporpamu Al Suite 1.

B HanawwTyBaHHAX (yHKUii Npu3HayTe CnonyYeHHs Knasill Ans 3aMiHyn Npodinto NigHATTS
cvcTeMn. HanawTyBaHHs CNoflyYeHHs KNasilll MOXKHa 3MIHUTY BPpYYHy. [InB. 306paxKeHHs

HWXYe, LWo6 AisHaTvcs binbLue.

Hanawryiite MigHaTTs cuctemn aBoma cnocobamm:

BIOS

Y nporpami HanawTysaHHs BIOS HaTucHiTb Al Tweaker (Mporpama HanawTysaHHs Al) >
System Level Up (MigHsTTs cuctemm).

Knonka OC

Hatwuchits kHonky OC Bropi 3nisa Ha nepepHii naHeni.

'nasa 6: KopucTysaHHs ytunitamm



Probe Il

Probe Il - ue yTuniTa, sika kepye KpMTUHHO BaXKIIMBUMU KOMMOHEHTaMM
Kommn'toTepa, Bu3Ha4ae npobnemu i nosigomnsie npo Hux. Probe Il Bu3Havae,
cepef YCbOro iHLOrO, KiNbKiCTb 06epTiB BEHTUNATOPA, TEMNepaTypy
LieHTpasibHOro npouecopa i Hanpyry B cucteMi. 3 Uieto yTunitoro Bu moxeTe
3aB>XAun 6yTu BMEBHEHUMU Y TOMY, 06 KOMM'IOTEP Mpautoe SK Chif.

3anyck Probe I
Micns iHcTansuii Al Suite Il 3 DVD nigTpumku, 3anycTiTe Probe Il, knayHyswwm no

Tool (IHcTpyMeHT) > Probe Il Ha naHeni ronoBHoro meHto Al Suite |I.

KoHdirypauis Probe Il

KnauHite no naHensm Voltage/Temperature/Fan Speed (Hanpyra/Temnepatypa/
LLsuakicTe BEHTUNSITOPA), LLOG akTMBYBATW CEHCOPK abo perynoBaTy NOPOrosi
3HayeHHs ceHcopiB. NaHenb Preference ([Mepearn) Hapae MOXXNUBICTb 3pO6UTH
BfIACHI HaNaLITyBaHHA 4acoBOro iHTepBany nonepen><eHb Bif CeHcopiB abo
3MIHUTK OAVHWLI BUMIDIOBaHHSA TemnepaTtypu.
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36epirae Bawy
KoHdirypauito
3aBaHTaxye 3aBanTaxye 3ac T.° coBye
36epe>xeHy Bamu noporosi BHECeHi Bamu
KOHdirypauito 3HAYEHHS 3a 3MiHn

3aMOB4YaHHAM Ans
KO>XHOro ceHcopa
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Sensor Recorder (3anucu ceHcopa)

Sensor Recorder (3anucu ceHcopa) Hajae MOXKJIMBICTb BiACTEXYBaTH i
3anuncysaTu 3MiHM y Hanpys3i cuctemu, ii TemnepaTypi, LWBUAKOCTI BEHTUMNSATOPA.

3anyck Sensor Recorder (3anucu cencopa)

Micns iHcTansauii Al Suite || 3 DVD nigTpumkn knauHite no Tool (IHCTpyMeHT) >
Sensor Recorder (3anucu ceHcopa) Ha naHeni ronosHoro meHto Al Suite Il, wob
3anyctutu PC Probe (3oHpa NK).

KoHdirypauis Sensor Recorder (3anucu ceHcopa)
Knauatoum no naHensim Voltage/Temperature/Fan Speed (Hanpyra/
Temnepatypa/LLBuakicte BEeHTUNSATOPA), BUGMpaiTE CEHCOPU, 3a SKUMU
6axkaeTte ctexxuTw. NaHenb History Record (3anuc icTopil) Hanae MoXxnuBicTb
3anucyBaTy 3MiHM y nokasax akTuBoBaHux Bamu ceHcopis.

Bu6epiTb
ceHcopw,
MOKa3HUKM SKUX
Bu 6axcaeTe
BiACTeXyBaTh

A

MepeTsarHiTb, Wo6
MNpPOrnsiHyTH cTaTyc
NpOTAroM NeBHOro

NPOMIXKY Yacy
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KnauHiTte, wo6 KnauniTsb, wo6
noBepHYTUCS — KnauHis, 106 Habnuxatucs/
Y pexum 3a Ha6nuxartucs/ sigpanaTucs no oci Y
3aMOBYaHHAM BiaaansTucs no
oci X
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Launching and configuring Ai Charger+

Ai Charger+, a unique and fast-charging software, allows you to charge your
BC 1.1* mobile devices on your computer’s USB port three times faster than the
standard USB devices**.

/ + Ai Charger+ poctynhuii nuwe ans noptis USB 3.0 i 3anyckaeTbes, konm Baw MK
& 3HAX0AUTLCS B pexxumi SO.

Ai Charger+ fonomorae 3apsgxysatu nigkntoueHi npuctpoi USB HasiTb komm MK
3HaxoauTLCA B pexxumax S3/S4/S5 nicns 3anycky B pexxkumi SO.

R + * Check your USB device manufacturer if it fully supports the BC 1.1 function.
+ ™ The actual charging speed may vary with your USB device’s conditions.

+  Ensure to remove and reconnect your USB device after enabling or disabling
Ai Charger+ to ensure normal charging function.

To launch Ai Charger+, click Tool > Ai Charger+ on the Al Suite || main menu bar.
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MoHiTop

Po3agin Monitor (MoHiTop) MicTUTbL NnaHeni Sensor
(CeHcop) i CPU Frequency (HactoTa ueHTpanbHOro

npouecopa).

Sensor (CeHcop)

MaHenb Sensor (CeHcop) Nokasdye NOTOYHI MOKA3HUKM CEHCOPIB CUCTEMMU, Taki
AK 06epTW BEHTUNATOPA, TEMNepaTypy LeHTpanbHOro npouecopa i Hanpyry.
Knaunite no Monitor (MoHiTop) > Sensor (CeHcop) Ha naHeni rofIOBHOr0 MeHo
Al Suite I, wo6 3anyctutn naHenb Sensor (CeHcop).

CPU Frequency (YacToTa LieHTpanbHOro npovecopa)

MaHens CPU Frequency (YacTtoTa LeHTpanbHOro npouecopa) nokasye noTouHy
4YacTOTy LeHTpasnbHOro npouecopa i KopuctysaHHst HAM. KnauHite no Monitor
(MosiTop) > CPU Frequency (YacToTa LeHTpanbHOro npowecopa) Ha naHeni

§ ronosHoro MeHto Al Suite Il, wo6 3anyctutn naHens CPU Frequency (HactoTta
g LIeHTPanbHOro npoLecopa).

T

9 Maxenb yacToTn
A 3HaxoauTLCA Ha npasii naHeni (iHopmauiiHii ainaHui UeHTpasnbHoro
V) cucTeMm) MNanens cencopa npouecopa

234 'nasa 6: KopucTysaHHs ytunitamm



Update (BaockoHaneHHs)

Po3gin Update (BpockoHaneHHs1) Hagae MOXXUBICTb
BAockoHanmosaty BIOS matepuHcbKoi nnatv i noroTun
nepBUHHOro 3aBaHTa)keHHs BIOS 3i cTBopeHmu
yTunitamm sgockoHaneHHs ASUS.

ASUS Update (BaockoHaneHHsi ASUS)

ASUS Update (BaockoHaneHnHs ASUS) - ue yTuniTa, sika Haaae MO>XKJIMBICTb
KepyBatu, 36epiratu i BaockoHanosatn BIOS maTepuHcekoi nnatn 8 OC
Windows®. Ytunita ASUS Update (BaockoHaneHHst ASUS) Hagae MoXXnuBIiCTb
BAockoHanosaTy BIOS npsiMo 3 IHTepHeT, 3aBaHTa)kyBaTu HaWHOBILLWIA cbaiin
BIOS 3 InTepHeT, BoockoHanosaTtu BIOS 3 BaockoHaneHoro dainy BIOS,
36epiratv noTouHuin cpann BIOS abo nepernsHyTv iHopmadito Npo Bepcito
BIOS.

BpockoHaneHHs BIOS yepes IHTepHeT

LLlo6 BoockoHanutu BIOS uepe3s IHTepHeT:

1. Ha ekpani ASUS Update
(BmockonanenHs ASUS) BrbepiTb
Update BIOS from Internet
(BrockoHanuTy BIOS 3 IHTepHeT), a
noTiM knauHiTe no Next (Aani).

YKpaiHcbKa

2. Bubepitb Hanbnvxuunid o Bac cant
ASUS FTP, W06 YHUKHY T NepeLLKo
Yyepes 3aTopyu B NOTOL|i AAHKX.

Skwo Bu 6axxaeTe akTusysatu
chyHKUito noBepHeHHs BIOS Ha
NPOCTiLLi Bepcii Ta yHKL0
aBTOMATUYHOrO PE3EPBHOr0
konitoBaHHs BIOS, noctaBTe BigMIiTKM ¥
BCiX BIKOHLSIX Nepes ABOMA NyHKTaMu
Ha expaHi.

3. Bubepitb Bepcito BIOS, siky 6axaeTe
3aBaHTakunTu. KnauHite no Next
(Dani).

Konu He 3HainaeHo BOOCKOHaneHoi
BEPCIi, Lie NOKa3yeTbCs SK eKpaH
npasopyu.
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Mo>kHa BUPILLMTH, 4K 3MiHIOBATK
NOroTUN NEPBUHHOTO 3aBAHTAXKEHHS
BIOS - 306pakeHHs], sike 3'aBRseTbCs
Ha eKpaHi Mif 4ac camonepesipku

- (POST). KnauniTb no Yes (Tak), kLo
6axaeTe 3MIHUTU NOroTUN NEPBUHHOIO
3aBaHTaxeHHs a6o No (Hi), wob
MPOLOBXMUTH.

BukoHyiTe iHCTPYKUIT Ha expaHi, o6
3aBepLUNTY NPOLIEC BAOCKOHANEHHS.

BpockonaneHHs BIOS 3 ¢aiiny BIOS
LLlo6 BaockoHanuTu BIOS 3 chaiiny BIOS:

1.

Ha expaHi ASUS Update
(BrockoHaneHHs ASUS) Bn6epitb
Update BIOS from file (BaockoHanuTm
BIOS 3 cbaiiny), a noTiM KNnauHiTb No
Next (Oani).

3Haiiaite daiin BIOS y BikHi Open
(BigkpuTy), KnauHiTe no Open
(BiakpuTh) i Knaunite no Next (Jani).

Bu MoxxeTe BUPILLNTY 3MIHUTK
NOrOTUM NEPBUHHOTO 3aBAHTAXKEHHS
BIOS. KnauHitb no Yes (Tak), sikwo
6a>KaeTe 3MIHUTW NOroTUN NEPBUHHOTO
3aBaHTaxeHHs abo No (Hi), wob
MPOAOBXMTH.

BukoHy#Te IHCTPYKLIT Ha ekpaHi, o6
3aBepLUNTY NPOLIEC BAOCKOHANEHHS.
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System Information (IHcbopmaLis cuctemu)

Y po3agini System Information (IHcpopmauis cuctemm)
nokasaHo iHopMaLlito NPo MaTEPUHCLKY Mnarty,
LieHTpanbHuii NpoLecop Ta 0TBOPY ANs KapT nam'aTi.

+ KnauHite no naxeni MB (MaTepuHcbka
nnara), o6 no6a4nTn Noapobumui Npo
BUPOGHWKA MaTEPUHCbKNX NNat, Ha3By
BMpOGY, Bepcito Ta BIOS.

+  Knaunitb no naHeni CPU (LleHTpanbHuii
npouecop), o6 no6a4nTy NoapobuLi Npo
LeHTpanbHWiA NPoLEecop i KeLL-nam'sTb.

YKpaiHcbKa

+  KnauHitb no naxeni SPD, a noTim
BUOEPITL OTBIP AN KAPTK Nam'aTi, LWo6
no6a4nTi NoApo6uLi NPo MoAy b Nam'aTi,
BCTAHOBJIEHWIA Ha BiANOBIAHWI OTBIP.
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. KnauHite no naxeni Disk ([uck)
i BUOEpITb KOXKEH AMCK, LLI06
no6a4nT NoAPO6MLI NPO HLOTO.

ExpaH niaTpuMku

EkpaH niaTpumkm nokasye iHpopmadito npo
caiT ASUS, caifT TexHiYHOI NiATPUMKN, canT
3aBaHTaxKeHb ab0 KOHTaKTHY iHdopmaLito.
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Settings (HanawTyBaHHs)

Posapin Settings (HanalwtyBaHHsA) Hafaae MOXXNMBICTb
pO6VTN OCOBUCTI HAanaLTyBaHHA NaHeNi rofoBHOrO
MEHIO Ta 3MIHIOBaTU CKiHW iHTepdenciB.

+  3apava Hapae MOXNMBICTbL BUOGMpaTK, sky 3afady Bu 6axaeTte akTuByBaTu.
+  [NaHenb Hagae MOXXJIMBICTb 3MiHIOBATW HANALITYBAHHSA NaHeni,

+  CkiH Haae MOXX/MBICTb POGUTM OCOBMUCTI HANALLTYBAHHSA KOHTPACTY, ICKPABOCTi,
HACMYEHOCTI, BIATIHKY | raMmu iHTepdeiicy.
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ASUS Al Manager

ASUS Al Manager - Le yTuniTa, Sika Hafae WBUAKWIA | NPOCTUIA [OCTYN [0 3aAad, SKi 4acTo
BUKOPUCTOBYHOTBCS.

3anyck Al Manager
LLlo6 sanyctutn Al Manager 3 po6ouoro ctony Windows®, knauite no Start (Ctapt) >
All Programs (Bci nporpamu) > ASUS > Al Manager > Al Manager 1.xx.xx. Ha po6o4omy

am

ctoni Al Manager 3'aBnsieTbCs LUBMAKA NaHENb.

Micns 3anycky 3apadi Ha naHeni 3agav Windows® 3'asnsetbcs nikrorpama Al Manager.

MpaBoto KHOMKOK MULLI KNALHITh MO Wi nikTorpami, o6
NepemMmKaTCS MiXK LIBUAKOK NaHENo Ta rofloBHUM BiKHOM
i 3anyckatu Al Manager sk 3i LUBUAKOT naHeni, Tak i 3 naHeni

3apad.
Switch to Quick Bar

Switch to Main Window

Start at Quick Bar
v Start at ToolBar

Exit

ASUS CG8580
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LLisuaka naHens Al Manager

LLisnaxa naHens Al Manager 3aolaaxye Miclie po604oro cTony i Haaae MoOXXInBICTb
3anyckatun ytunitn ASUS a6o nerko nokasdysaTu iHchopmalito npo cuctemy. KnauHitb
no 6ynb-skiii i3 naHeneit - Main (ConosHe), My Favorites (Moe ynto6nexe), Support

Knonka Exit (Buxin)
MepeMKHyTHUCS Ha
ronosHe Window
Lonatu po ToolBar
(MaHeni iHcTpyMeHTiB)

onosHe NigTpuMka
Moe IHdopmaLis
ynio6neHe
(MigTpnMka) a6o Information (IHpopmauis), Wwo6 nokas3aTut 3MICT MEHHO.
Knaunite no kHonui Maximize/restore (36inbwnTn/BigHOBUTH) @, L1106 NEPEMUKATUCS MK
NOBHUM BIKHOM Ta LUBMAKOKO NaHennto. KnauHite no kHonui Minimize (3meHwuTy) EF,, 06

nmwnt Al Manager Ha naHeni 3aaay. Knaunite no kHonui Close (3axkputy) EI-, 06 BUIATH
3 Al Manager.

lonosHe
Main menu (onosHe MeHt0) MicTUTL Tpu yTuniTv: Al Disk (Auck AI) Al Security (Besneka

KnauHitb, WwWo6 noumpuTu
a60 BigHOBUTH

Al) i Al Booting (MepsunHe 3aBaHTaxeHHs Al). KnauxiTe no ctpinui Ha nikTorpami Main
menu (F0n0BHe MeHI0), W06 NepernsaaTvt yTUniTM B roNIOBHOMY MEHIO.
Al Disk ([iuck Al
Al Disk (duck Al) Haaae MOXXMBICTb NErKO O4MLLyBaTV TUMYacosi dhaiinm IE, kyki IE,
nocunanhs IE Ta ictopito IE a6o BuaansTu BmicT Recycle Bin (Kowwk ans cMiTTs).
KnauiTe no niktorpami Al Disk (duck Al) Ha wswakin naseni, Wob nokasaTtv nosHe
BikHO Al Disk ([uck Al), i BbepiTb NyHKTK, aki 6axaeTe ounctuti. Konm ue 6yae
BUKOHaHO, KnauHiTb no Apply (3acTocysath).

i o T e
1| B e devm il e west iy Lo
; fy—
|
1| 1 chni e EFan [ Ciea € P iy
ﬂ P

Thwa T Cockies Slear W riwiny
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Al Security (besneka Al,
Al Security (Besneka Al) Hafae MOXX/MBICTb BCTAHOBUTU NAPO0Sb, OO 3aXMCTUTH BIif
HECaHKL{iOHOBAHOro [OCTYNy Taki NpucTpoi sk cpnew-nam'ats USB i CD/DVD.

LLlo6 6noKyBaTi nNpucTpiii:

1. Mia vac neporo kopuctyBaHHs Al Security (Beaneka Al) Bac nonpocsaTs
BCTaHOBWTM Naposib. BeeaiTe naponb 3 Makcumym 20 umudbp Ta/abo nitep.

MiaTBEpAITE Naponk.
BBsepiTb niakasky naposnto (PEKOMEHA0BAHO).

4.  BukoHaBLLUW, KnauHiTb no Ok.

. A e e e i
& -

© e e Sebiwinidm nrl w8 X okirm

5. BwbepiTb npucTpiit, ikuii 6axkaeTe 3abnokysaTu, NOTIM KNauHiTe no Apply

(3acTocyBarhm).
6. BBegiTh Naponb, sikuii By nonepeHbo BCTAHOBWIIM, MOTIM KnawHiTb no Ok.
— B F=1=
O- 280
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LLio6 po36nokyBaTh NpUCTPiii:
1. BubepiTb 3a6n0K0BaHMin NpUCTpIlA, NOTiM KnauHiTb no Apply (3actocysath).
2. BsegaiTb naponsb, skuii Bu nonepeaHb0 BCTaHOBUAK, NOTIM KNauHiT no Ok.
LLIo6 3MiHMTK naposnb:

+ Knaunits no Change Password (3MiHUTM naponb), NOTiM BUKOHYATE iHCTPYKLUIi
Ha ekpaHi, Wo6 3MIHUTK NapoJib.
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Al Booting ([epsuHHe 3aBaHTaxeHHs Al
Al Booting (MepBuHHe 3aBaHTaXkeHHs Al) Haaae MOXXMBICTb BKa3aTh NOCAIAOBHICTb

NpiOpUTETIB NEPBUHHOMO 3aBAHTAXKEHHSI.

- 8 &P

LLlo6 Bka3aTi NOCNiAOBHICTb NEPBUHHOrO 3aBaHTa)XXEHHS:

1. BubepiTb NpuCTpiid, @ NOTIM KNALHITL NiBOK/MPABO0 KHOMKOHO, LLI06 BKka3aTh
NOCAIAOBHICTb 3aBaHTaXKEHHSI.

2. BwkoHnaswm, knaurite no Apply (3actocysaty).

My Favorites (Moe ynio6neHe)

My Favorites (Moe Ynio6neHe) Hagae MOXNMBICTb foAaBaTh 3aaadi, ki Bu yacto
BMKOPWCTOBYETE, LL0O HE BUTpAYaTh Yac Ha NOLLYK 3a4ad Yepes Komn'totep.
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LLio6 noaatyn 3apauvy:

1. KnauHite no Add ([loaaTw), noTiM 3HaiAiTL 3afavy, siky 6axaete gogatv go My
Favorites (Moe Ynio6neHe).

2. KnauHit no Open (Biakputh) no BikHy po3TtallyBaHHs daiiny. Liro 3agady aoaaHo
no cnvcky My Favorites (Moe Ynio6nene).

[MpaBoto KHOMKOO KNauHiTh Mo NikTorpami 3agadi, Wwob 3anycTuTu, Buaanuti abo

nepeiMeHyBaTy BUOpaHy 3aaady. TakoxX MOXKHa ABidi KnauHyTH, Wo6 3anyCcTuTi BubpaHy

3apavy.
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Support (MiaTpumka)

KnauHiTe no 6yab-ikoMy nocunaxHio y BikHi Support (MigTpuMKa), Wo6 nepenTu Ha canT
ASUS, caiT TexHiYHOi NiATPUMKK, CaNT 3aBaHTaXKeHb ab0 A0 KOHTAKTHOI iHchopmaLii.

Q LT Coyaley (o Doemie s Sum i T B

'@ e R T T

Information (IHdopmaLis)

KnauHitb no naweni y sikxi Information (Indopmauis), wWo6 no6aunTn fetansHy
iHhopMaUito Npo CUCTEMY, MaTEPUHCBKY NNaTy, LEHTPanbHWA NpoLecop, iHCTanboBaHi
npuctpoi BIOS Ta nam'aTb.

ASUS CG8580
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Nero 9

Nero 9 Hafae MOX/MBICTb CTBOpPHOBATH, KonitoBaTtu, 3annucyeaTtu, peaarysaTu, CMinbHO
KOPUCTYyBaTMUCA Ta NOHOBNOBATA piSHi BUAM OaHUX.

| jrmesnisuns S ™ finnce =

IHcTansuis Nero 9
LLlo6 iHcTanoBaTu Nero 9:
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1. BcrasTe o ontuyHoro auckosogy Nero 9 DVD.

2. Skuwo aKTuBoBaHo Autorun (ABTO3anyck), aBBTOMaTUYHO 3'SBNSETLCS FONOBHE MEHHO.

SAkwo Autorun (ABTO3anyck) BUMKHEHO, ABidi knauHiTe no caiiny SeupX.exe y ronosHii
nvpekTopii Nero 9 DVD.

3. Y ronosHoMy MeHto knnauHiTe no Nero 9 Essentials (OcHoBHe Nero 9).
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4. BubepiTb MoBY, sKy 6axaeTe BukopucToByBaTh Ans Installation Wizard (Mporpama-
nomiuHuK iHcTanauii). Knaurite no Next (Jani).

5. Knaunite no Next (Jani), o6 npoaoBxuty.
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Flegar maley pes dewial mrdes bor detn 3 Ty lals

i TR LM P TP RO TRAH D AT

6.  BigmiTbTe | accept the License Conditions (51 noroaxxyiocsi i3 ymoBamy nileHsiiHol
yroau). BukoHasLum, knauHite no Next (dani).
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7.  Bubepitb Typical (Tunoswuii) i knauHiTe no Next (Hani).
[T ————— -y

8.  BinmiTbTe Yes, | want to help by sending anonymous application data to Nero
(Tak, s 6axkato nonoMoraTv Haacunaloun aHoHiMHI aaHi 3aaay Ao Nero), NoTim
Er—

[T S —
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9.  BwkoHaswwu, knauHiT no Exit (Buith).

e Vi s 0
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3anuc ¢aiinis
LLlo6 sanucaTtu daiinu:
Y ronoBHOMY MeHto knauHiT no Data Burning (3anuc panux) > Add (JoaaTw).

1.
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2. Bubepitb chainu, ski 6axaeTe sanucatu. BukoHasLum, knaunite no Add (JoaaTw) g
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3. Bubpaswmw daiinu, siki Bu 6axxaeTe 3anucaty, knauHite no Burn (3anucartm), 1wo6

3anucatyv annm Ha anck.
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[eTenbHiwe npo kopucTyBaHHs Nero 9 npounTaiite Ha caiti Nero: www.nero.com
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BigHOBRNeHHs cucTeMu

KopucTyBaHHS NOrYHUM AUCKOM BiAHOBNIEHHS

Recovery Partition (JloriuHuii avck BigHOBNEHHS) LWBMAKO BigHOBNOE M3 cTauioHapHoro
MK Ha nonepegrii pobounii cTan. MNeped T1M, K kopucTysaTtuch Recovery Partition
(Moriunwnii anck BIAHOBNEHHS), 3p06iTh KOMito AaHuX (Takux sik paiinu Outlook PST)

Ha npucTpiin nam'sTi USB abo Ha MepexxeBwii AncK i 3aHOTYiTe 6y ab-sKi 0COBUCTI
KOHdirypauii (Taki ik Mepe>xesi HanaluTyBaHHs).

Mpo Recovery Partition (Jloriunuit AucK BigHOBNEHHS)

Recovery Partition (JloriuHnii Auck BifHOBAIEHHS) - Lie 3ape3epBOBaHe MiCLe Ha >XOPCTKOMY
AMCKY, NpU3HaYeHe Ans BiAHOBMIEHHS OnepaLiitHoi cUCTeMW, ApaiBepis Ta yTUAIT,

iHCTaNboBaHNX Ha (habpuLli Ha CTALIOHAPHAN s
K. it <

HE BUAANSANTE noriunuii anck -
R RECOVERY (BigHoBneHHs). Recovery -

Partition (Jloriumuii ACK BiAHOBNEHHS) B e | S ]
CTBOPHOETLCS Ha chabpuLli. SKLLO Lieid e
AVCK BUANUTH, BiAHOBUTM Or0 HEMOXXNINBO. SKLLO BUHUKIM NPO6iemMu i3 npoLecoM
Bi[JHOBJIEHHS, 3BEPHITLCA 3i cTauioHapHUM MK 1o aBTOPU30BAHOr0 CEPBICHOMO LIEHTPY

ASUS.
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KopucTyBaHHS NOriYHUM AUCKOM BiAHOBNEHHS:

1. HatucHiTe <F9> nif Yac NepBUHHOMO 3aBaHTaXEHHS.

2. HatucHiTb <Enter> (BBepeHHs), o6 subpatn Windows Setup [EMS Enabled]
(HanawTysanHs Windows — aktusoBaHo EMS).
3. BubepiTb 0AHY 3 HACTYMHUX OMNL|i/A BiAHOBAEHHS.

BigHOBNEHHS cUCTEMU:

Lls ocobnvBa xapakTepucTika Hajae MOXKJIIMBICTb BiAHOBUTM CUCTEMY Ha (habpuyHi
HanawTyBaHHS 32 3aMOBYAHHSM.

PesepBHa konisi 06pasy cUCTEMM:

Lls ocobnuBa xapakTepucTika Hafae MOXKIMBICTb 3anvcyBaTh Pe3epBHY KOMito
06pa3y cuctemn Ha DVD, sikuii MO>KHa BUKOPUCTOBYBATM Mi3Hilue, LWOo6 BifHOBUTK
CMCTEMY Ha HanalUTyBaHHSA 3@ 3aMOBYaHHSM.

PesepsHa konisi DVD cuctemu:

Lis ocobnusa xapakTepucTika Hafae MoOXKIMBICTb pobUTH pe3epsHy Konito DVD
NigTPUMKN.

4. BwkoHyiTe IHCTPYKUIT Ha eKpaHi, o6 3aBepLUNTH NPOLIEC BiAHOBEHHS.

/ Bigsigaiite caifT ASUS: www.asus.com, 06 0TpuMaTh BLOCKOHANEHI ApaiiBepu Ta
yTURITI.
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KopuctyBaHHsi DVD BigHOBNEHHS (Ha OKPeMUX MOAeNsX)

/ MigroTyiite 1~3 NopoXxHix NnpuaatHux fo 3anucy DVD, sik BkasaHo, o6 cteoputi DVD
BiATBOPEHHS.

3HIMITb 30BHILLHI AMCKOBOA, NEPLL HiXX 3AiACHIOBATY BiAHOBMIEHHS CUCTEMM HA

R crauioHaphmii MK. 3a iHcbopmavieto Microsoft, MoXXHa BTpaTUTV BaXKNnBI AiaHi Yepe3
HanawTysaHHs Windows Ha HenpasuibHOMY AMCKy ab0 hopMaTyBaHHs HEMPaBUIbHOTO
JIOFiYHOrO ANCKY.

LLlo6 kopuctyBaTucs DVD BiaTBOpEHHS:

1. BcrasTe DVD BiiHOBNIEHHS 1O ONTUYHOrO AUCKOBOAY. Chifl yBIMKHYTU XXUBEHHS
cTauioHapHoro K.

2. MepecTapTyiiTe cTauioHapHuii MK i HaTUCHITL <F8>, 06 3p06UTK NepBUHHE
3aBaHTaXXEHHS i BUOPATN ONTUYHWIA AMCKOBOA (MOXXe By Ty No3HayeHuin sk CD/DVD)
i HaTUCHITb <Enter> (BBeaeHHs), LL06 3A4iliCHIOBaTM NepBUHHE 3aBaHTaXKeHHs 3 DVD
BifHOBNEHHS.

A

Bu6epiTe OK, 1106 noyati BigHOBNIOBATH 300PAXKEHHS.

>

Bubepitb OK, 06 nigTBEepANTY BiHOBEHHS CUCTEMM.
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R BinHoBneHHs Byne 3anucaHo 3ropu Ha XXOPCTKMIA anck. MepexoHaiiTecs, wo Bu 3pobunu
pe3epBHY KOMito BCIX BaXXNMBUX AaHUX NEPE BiiHOBNEHHSM CUCTEMM.

5. BuKoHyiiTe iHCTPYKLIT Ha expaHi, L6 3aBEpPLUMTY NPOLEC BiHOBNEHHS.

HE BUAMAWTE aucK BifHOBNEHHS, SIKLLO TiNbKM He OTPUMAETE BKA3IBKM Lie 3p06uTH,
é Mif Yac BiATBOPEHHS - Y MPOTUIEXHOMY BUPAAKY JIOMYHUMM AUCKAMU HEMOXXINBO Byae
KOPUCTYBaTUCS.
% Binsinaiite caint ASUS: www.asus.com, 06 OTpUMaTi BAOCKOHANEHI ApaiiBepu Ta
a yTURiTY.
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3HaiioOMCTBO 3 TEXHONOriAMM LWBUAKOCTI peakuil Intel® 2012
Desktop

Y UbOMY JOKYMEHTi AeTasnibHO OMMCAHO iHCTansLito Ta KOHirypauito TeXHONOriN
LWBUAKOCTI peakuili Intel® 2012 Desktop. TexHonorii WBnAKOCTI peakuii Intel®
2012 Desktop — ue HacTynHi Tpu:

Intel® Smart Response Technology
Intel® Rapid Start Technology

Intel® Smart Connect Technology

CucTteMHi BUMOrn A1t TEXHONOTi# WBMAKOCTI peakuil Intel® 2012
Desktop

LLlo6 cuctema npasuibHO npautosana 3i weuakicTio peaxdii Intel® 2012 Desktop,
Cnif BUKOHyBaTuW Taki BUMOru:

o
LleHTpanbHuin  Sapo npouecopa 2-3 NoKoniHHSA Intel® %
npouecop g
OnepauinHa OnepauiiHi cuctemm Windows® 7 T
cuctema Q‘
SSD HeobxigHuii oanH cneuianbHO Npu3HayeHnin SSD >
(TBEPAOTINbHWIA AnCK) Ans NiATPUMKK Intel® Smart Response
Ta Intel® Rapid Start Technology.
Y Tabmmui SSD Capacity Requirements (Bumoru go o6¢ary SSD) nogaHo
iHbopmavito npo po3mip SSD, 06¢sr NOriYHOro ANUCKY | BUMOTU A0
~ CUCTEMHOI nam’aiTi.
>KopcTkui LLloaHaimMeHLwe oanH XK (KOPCTKUiA ANCK) ANst ANCKY
AUCK: onepauiiHoi cucTemu.
[AunHamiuna LLlo6 akTnByBaTH Intel® Rapid Start Technology, noTpi6Ha
nam’sitb AVHaMiYHa Nam’sTb MeHwwe 8 6.
' MepekoHaiiTecs, o akTuByBanu npuckopeHHs Intel® Smart Response Technology,
o nepLu HX cTBOpIOBaTH noriunkii auck ans Intel® Rapid Start Technology.
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Bumoru go o6esry SSD

Bumoru go o6esry noriyHoro
Aucky SSD

Intel®Rapid Start
Intel® Smart Response
Intel® Smart Response

and
Intel®Rapid Start

Intel® Smart Response,
Intel® Rapid Start,
and
Intel® Smart Connect

noegHaHHs nam’aTi Intel®

noeaHaHHs nam’aTi Intel®

276

4ars
4T6

816

2016

2016

2016

OxpeMi noriuHi
amekn 2062
6 (po3mip SSD >
22106)

OxpeMi noriyHi
anckn 2076
416 (po3mip
SSD >247T16)

OxkpeMi noriyHi
anckn 20 6 i
8 I'6 (po3mip
SSD >2816)

OxkpeMi noriyHi
amekn 20762
6 (po3mip SSD >
2216)

OxpeMi noriyHi
ek 2076
4 T6 (po3mip
SSD >247T16)

OxkpeMi noriyHi
anckn 20 6 i
8 16 (po3mip
SSD >2816)

3abopoHeHo cTeoptoBaTh RAID Ha SSD, npusHavueHoMy Ans Intel® Rapid Start Ta
Intel® Smart Response.
Yepes nosepiHky onepavuiiHoi cuctemu Intel® Rapid Start Technology npauroe

HeedeKTUBHO 3 CUCTEMHOIO NaM’aTTIo NoHaA 4 6 y 32-6iThiii OC Windows® 7.
JTnwe BHYTPILWHI NopTy Intel® SATA (Cipuid | cuHiiA) NiATPMYIOTbL TeXHONOTi
pearysanHs Intel® 2012 Desktop.

Po6oui xapakTepuctukm Intel® Smart Response Technology Ta Intel® Rapid Storage

Technology 3anexars Bif iHcTanboBaHoro SSD.
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Intel® Smart Response Technology

Intel® Smart Response Technology niacuntoe 3aranbHi pobo4i xapakTepUCTUKN
cucTeMu. BiH KOPUCTYETLCS IHCTanboBaHMM WBMAKMM SSD (AOCTYMHO MiH. 20
[6) sk Kel-nam’aTTio AN onepadiidi, 40 SKNX YaCTO 3BEPTAETHLCS, MPUCKOPEHHS
>XOPCTKOro AMCKY/3BEPHEHHS A0 FONOBHOT Nam’aTi. [0n0BHUMK NnepeBaramu

€ NPUCKOPEHHSA PO6OTM XXOPCTKUX ANCKIB, 3MEHLLIEHHS HABAHTaXKEHHS i

yacy o4iKyBaHHs, MaKCManbHO ePeKkTUBHE KOPUCTYBAHHS NaM’aTTHO.
EHeprocno>mBaHHs TakoX 3MEHLLYETbCS 3a PaxyHOK 3MEHLLEHHS HENOTPIOHNX
06epTiB XXOPCTKOro ANUCKY.

k MepLu Hix 3acTocysaTu Intel® Smart Response Technology, Heo6xiaHO BCTaHOBUTH
nyHKT ,BIOS pesxumy SATA” Ha [RAID mode] (Pexxum RAID) y HanawTysaHHi BIOS.

IHcTansyis Intel® Smart Response Technology
1. BctaBTe DVD nigTpvMKm O ONTUYHOrO AncKoBogy. 3'SBNSETLCS NaHesb iHcTansuiji
ApaviBepis, SKLO Ha KOMM'IOTEPi aKTMBOBAHO (PyHKLito Autorun (ABTO3anyck).

2. KnauHite no naneni Drivers ([paiisepw), noTim knauHiTe no M3 Intel® Rapid Storage
Technology Driver.

3. BukoHyiiTe iHCTPYKLIT Ha expaHi, L6 BUKOHATM iHCTanALito.

KopucTyBaHHs Intel® Smart Response Technology

1. Knaurite no Accelerate
(MpwvckopwnTh), Wob 3anycTuTh
HanawTyBaHHsA Smart Response
Technology.

2. a. Bubepitb SSD, sikuii 6a>kaeTe
BVKOPWUCTOBYBATU A5t MPUCKOPEHHS
cucTeMmn nam’aTi.

b. BubepiTb po3Mmip, npuaHayeHunii
[Ns CTBOPEHHS Kew-nam’sTi SSD.

c. BubepiTb >XOpCTKMI ANCK Ans
CTBOPEHHS KeLl-nam’aTi.

d. Enhanced mode (Pexxum
niacunenns): CYUINIbHUNA 3AMUC,
3anuc Ha SSD i >xopcTkuii anck
OAHOYACHO. o
Maximized mode (MakcumisoBaHui
pexkum): MEPE3AMMUC — 3anuc Ha
SSD i ni3HilWKiA nepe3annc Ha X>XOPCTKNIA AUCK.
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3. Bwubepitb Disable Acceleration (BumkHyT® =t =
MiACWIIEHHS), W06 BUMKHYTU Lit0 PyHKLtO, ule | )@ =y

i Bu6epiTb Change Mode (3MiHMTK

PEXMM), 06 NEePEMKHYTH PEXUM
npuckoperHs Ha Enhanced/Maximized
(MipcuneHnir/MakemanbHui).

At

S g s sy s

LLlo6 aktnByBath Intel® Smart Response Technology, cnia MaTi LWOHAAMEHLL
no ogHoMy SSD ( 220 ["6) i >KOPCTKOMY [NCKY, @ ANt CTBOPEHHS KeLU-nam’sTi
BUKOPUCTOBYBATM NULLIE OAUH

Akwo Bu 6axxaeTte BiAHOBUTY onepaviiny cuctemy, nepeiiaite fo BIOS Option
ROM (ROM onuiit BIOS) > Acceleration Options (Onuii NpucKOpeHHS) i 3HIMiTb
Disks/Volume Acceleration (IMpuckopeHHs auckis/obesry), Wob BUMKHYTH Intel®
Smart Response Technology. Y nasi 4, poaaini ,HcTansuis cepiitnoro XX/ ATA”
po3kasaHo npo ROM onuiii BIOS.

MakcumanbHuii o6¢csir ctBopeHoi Ha SSD kelu-nam’aTi — 64 6. AKLO BiH
6inbLUMIA 33 BKa3aHWiA, HAAMWULLOK, He BUKOPUCTaHWIA AN CTBOPEHHS KeLu-nam’aTi

PO3Mi3HAETLCS CUCTEMOLO ANS BUKOPUCTAHHS B IKOCTI 3BUYANHOT nam’aTi.

Intel® Rapid Start Technology

Intel® Rapid Start Technology Hanae MOXXNMBICTb LWBMAKO BUBOAWUTU KOMM'IOTEP
3 PEXXUMY 04iKyBaHHS. 36epe>keHHst NaM’saTi cUCTEMU KoMM'loTepa Ha
KoHirypoBaHuin SSD Hafae LWBMALLNIA BUXIA 3 PEXKMMY OYiKyBaHHS i AJONOMOrae
3a0LlaanTy eHeprito.

RS

MepLu Hix 3acTocysaTu Intel® Rapid Start Technology, nepeigits Ao

nyHkTy BIOS-y Advanced Mode (BucokoTexHonoridHuii pexxum) > Advanced
(BncokoTexHonoriyHuii) > PCH Configuration (Kondirypauis PCH) i aktuyiite
Intel® Rapid Start Technology.

lMepekoHaiitecs, wWwo Bu TouHo BkoHanu npoueaypy Creating a partition
(CTBOpPEHHS NorivHOro Ancky), Wob akTusysaTi pyHKLito Rapid Start. Akiwio
Bu incTantoeTe Intel® Rapid Start Utility paHiwwe, Hix cTBopuTe norivHuii anck,
3'BUTbCS MNOBIAOMNEHHS NPO NOMWUIKY.

CTBOpEHHS NOriYHOro AUCKY

lMepekoHaiiTecs, Lo 3po6unn pe3epBHy KOMito AaHX, NepLU HiX KOPUCTYyBATUCS
iHCTpyMeHTOM Microsoft st CTBOPeHHs norivHOro Ancky. Momunka B npoueci
CTBOPEHHS! NOTYHOr0 ANCKY NpuU3Beae A0 BTPATH AaHNX.

SIKLO BCTAHOBMTM BUCOKY YaCTOTY AWHAMIYHOI Nam’aTi, Le npu3sese Ao
HecTabinbHOi Po60TH CUCTEMU.

1. Mepeiaits oo ,lMyck”, npaBoto KHOMKOO knauHiTe o Computer (Komn’iotep)
> Manage (KepyBatu) > Disk Management (KepyBaHHsi AUCKOM).

2. Bwubepitb SSD, 3 sikoro Bu 6a>kaeTe CTBOPUTU MOTiYHWIA ANCK.
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3. [MpaBoko KHOMKO KNauHiTb
no New Volume (Hoswii
TOM), YacTuHy sikoro Bu
6axxaeTe CTUCHYTH, i
BubepiTb Shrink Volume
(CtuckaHHs ToMy).

4. Skuwo SSD He 3apisiHo i He
chopmaToBaHo:

b e

|| Mo Wkome (D3 Open

§ 547 GB NTFS Laplors

| sk [Py Partition]

| Ak Fortitan i -
Change Dvve Lester anal Putha
Fererat.

* Sk e

Dbt okume

-"HI

Frirmaty partitien

a. [paBoto KHOMKOK KNAUHITb MO AMCKY, 3 IKOro 6axxaeTe CTBOPUTM NOFIYHWUIA ANCK,
i BU6epiTh Initialize (IHiuianisauis).

b. [MpaBoto KHOMKO KNAUHITh

N0 HEPO3MOAINEHOMY TOMY,

BubepiTb New Simple Volume

(HoBwuin npocTwii TOM) i
BUKOHY/TE nofanbLLi KPOKH.

i1 1 |
U v

2 ae 8000 GO
o Inabened Wheidles prpd

Skwo Baw SSD MeHLue 64 6, | BCTaHOBNEHMI HA CTBOPEHHS KELL-NaM’siTi Ha NOBHWIA

A
/
. \‘

o6csr aucky ans Intel® Smart Response, B He no6aumnTe >kofHOro Tomy B ,KepyBaHHs!
nncky”. MNepekoHaiTecs, Wo By BcTaHOBMAM 3HAYEHHS KeLl-nam’siTi Ha 18,6 6 B Intel®

Smart Response, 106 AaTV [OCTATHLO 06CArY ANs noriyHoro aucky Intel® Rapid Start.

5. BsepiTb MOTPi6HUIA 06CAT
NOTIYHOrO AWCKY, KU
MyCWTb BifnoBigaTu
IVHaMiYHIiA nam’aTi cucteMn
(176 =1024 M6). Knaunitb
no Shrink (CtucryTw).
Mepewgite o Start (Myck) >
Control Panel (KoHTponbHa
naHenb) > System and
Security (Cuctema i
6eaneka) > System
(Cnctema) i nepesipTte
06Csr AMHaMIYHOT nam’sTi.

HepoanogineHuii Tom Tenep

pO3MoAineHnii Ha BUGpaHwii
LUCK.
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6.  LLlo6 3anyCTUTH IHCTPYMEHT CTBOPEHHS NOTiYHMX AUCKIB, KNALHITb MO IHCTPYMEHTY
Start (Myck) > Programs (IMporpamu) > Accessories (Akcecyapu) > Command Prompt
(Mipkaska koMaHaw).

7.  HabepiTb diskpart i HATUCHITL
Enter (BeecTn).

8. Y nigkasui diskpart
BBeAiTh list disk nicns
DISKPART i HaTucHiTb Enter
(BeecTu). Bubepitb anck 3
HEPOo3noAineHnm ToMoM, HabpasiLum select disk x (x = Homep aucka), i HaTUCHITL
Enter (BeecTn).

ANUCK.

/}éggj +  3HayeHHs X" N03HAYa€E HOMEP AVCKY, A€ BU CTBOPUIN HEPO3MOAINEHWIA NOTiYHNIA
- + Y Kpoui 5 po3kasaHo npo 06csAr Ha Hepo3noAineHoMy aucky B SSD..

9.  HabepiTb create partition
primary (CTBOPUTY NEPBUHHUIA
NOTiYHNIA ANUCK) |
HaTucHiTb Enter (BeecTn).

10.  CTBOpWBLUM NEPBUHHUIA
NOTiYHNIA ANCK, HAbepITh
detail disk (neTani
AMCKY) | HATUCHITb
Enter (Beectw), wob
nepernsHy TV NOAPOONL
AMCKY, NOAINEHOro Ha
noAanbLui NOFiYHI ANCKN.

ISKPART > zelect volume 3

olume 3 is the selected volume.

ISKPART >

% +  3HayeHHs X" N03HAYaEe HOMEP AVWCKY, fie BU 6aXKAETE CTBOPUTM NOTIYHWIA AUCK
nam’sTi.
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12.  HabepiTb set id=84 override, HaTucHiTb Enter (Beectu) i novekaite, noku
3aKIHYMTLCA ,MPOLIEC CTUCHEHHS, | yTUNITA KEPYBaHHS IVCKOM BU3HAYUTb HOBWUIA
norivnwnid auck Hibernation Partition (Po3gin ans pe>xxumy rnéokoro cy).

800 GB
Healthyy (Hibernation Partit

BubpaHo “GPT (GUID Partition Table store type”. MepekoHaiitecs, wo Unallocated

% Hibernation Partition (Po3ain ans pexxumy rnmbokoro CHy) He 3’IBASETLCS, KO
~ (Hepo3noaineHo) 3HNKNO 3 TOMY, i BU3HAYEHO HOBUIA NOTYHUIA AUCK.

13.  [lepe3anycTiTb CUCTEMY NICNS CTBOPEHHS IOMYHOMO AUCKY.

CTBopeHHs noriyHoro aucky Ans Intel® Rapid Start Technology He3aBepLueHe, SKLO
' KOMMIOTEP He mepecTapTyBany, i Lie NpU3BOANTb [0 HECNpaBHOCTE oyHKLT Intel®
L. Rapid Start Technology.

AkTuBaLis i BAMKHeHHs Intel® Rapid Start Technology B OC

4& Cnouartky iHcTantoiTe Intel® Rapid Start Technology 3 DVD niaTpumkm, o6
3anyctuTm Intel® Rapid Start Manager.

[Micns cTBOPEHHS NoriYHOro Aavcky, 3anycTiTb Intel® Rapid Start Manager, w06
akTusyBaTy abo BUMKHYTK Intel® Rapid Start Technology.

1. KnauHiTe no ctpinui Show hidden icons
(MokasaTu npuxoBaHi nikTorpamu) Npasopy
Ha naHeni 3ajad, i KnauHiTb no nikrorpami
Intel® Rapid Start Technology Manager.
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2. BigmitbTe On (YBiMKHeHO) y noni Status (CtaTyc), o6

Bu6epiTb i KnayHiTh, W06 aKTUBYBaTH
a60 BUMKHYTH DyHKLiI0

Intel® Rapid Start Technology Manager

Intel® Rapid Start Technology Manager

Status ~ -
Intel Rapid Start Technology @ | @ On off | ‘

KnauHiTb, WwWo6
akTusyBaTn a6o
BUMKHYTHU PEXXUM
©Hepro36epe>KeHHs
6aTapel. Lis dyHKuis Fnli:al Battery © on 3 of ‘
npauioe nuie

Hide Advan i

Advanced Settings

ANSi NOpPTaTUBHUX 00 ot
KOMM’I0TepiB. 0 Miirtes
120
Save | Cancel |
| |
‘ |
KnauHiTb, wWo6 akTuByBaTH a60 BUMKHYTHU TaiiMep. KnauHiTb, KnauHiTb, Wwo6
Konu iioro akTuBoBaHoO, NPOKpy4yiTe naHenb o6 36epertu ckacyBaTu
Ha 6a>kaHwii yac. Konu cuctema 6espisinbHa HanawTyBaHHA.  HanalwTyBaHHS.

NPOTAroM TOro nepioay, sikuii Bu BctaHoBUNM, BOHA
aBToMaTn4Ho nepeiine B pexxuM Intel® Rapid Start.
Yac 3a 3aMoBYaHHAM — 10 XBUAIMH.

BigHOBNEHHS NOriYHOro AMCKY
Lis npouenypa Hagae mo>xxnusicTb Buaanuty Intel® Rapid Start Technology 3
CVUCTEMMU | BIiAHOBUTU NIOTYHMIA ANCK, CTBOPeHui Bamu ang iHcTansadii Intel Rapid®
Start Technology.

1. BanycTiTb iHcTpyMeHT Command Prompt (IMigkaska komaHau).
2. Hab6epiTb diskpart i HaTucHiTbL Enter (BBecTw).

3. VY nigkasui diskpart BBeaiTbh
list disk nicns DISKPART i
HaTucHiTb Enter (Bectw).

4. BubepiTb anck (SSD), kyan
PG EN LR N CIET D I S KPART > select disk 1
Start Technology, 106
BiAHOBMTY Oro, HabepiTb
select disk x (x = Homep) i DISKPART >
HaTucHiTb Enter (BBecTn).

Dizk 1 iz now the selected diszk.

/ 3HaueHHs X" No3Ha4Yae HoMep AUCKY, 3 sikoro Bu 6axaeTe BUAANUTM NOTiYHWIA AUCK
nam’sTi.

ASUS CG8580

258



5. HabepiTb list partition, HaTucHI TG
BCTaHOBJEHO Intel® Rapid Start e v ENE
HaTucHiTb Enter (BeecTw).

% 3HaueHHs X" no3Havae HoMep ANUCKY, 3 IKOro Bu 6axkaeTe BUAANMTY NOTiYHWA AUCK
nam’si.

6.  HabepiTb delete partition override i HaTucHiTb Enter (BeecTu). YTunita diskpart
RUNANGE RUBNAHUA NOMYHIIA
|

B.00 GO

Unalicsatad *

7. Hapo6o4omy cToni knauHite no Start (Myck), npaBoto KHOMKOKO KauHiTh Mo
Computer (Komm'toTep) i knauHitTe no Manage (Kepysatw).

8. Y BIKHi KepyBaHHA KOMI'I'}OTepOMy KnauHiTb i |
no Disk Management (KepyBaHHs IMCKOM), | e Vokume ifx

. 2 iGE WTFS 100 GB
MPOBOO KHOMKOO KNALHITb N0 CTUCHEHOMY !
HOBOMY TOMY i B6epiTb Extend Volume
(Po3wwmpeHHs Tomy).

Crunge Dvive Luther mnd Patin

Frumury p Farvmuat

Thrark Vekurne

Chababa Vahara

Przpaten

9.  Konu 3'1BUTbCS NporpaMa-noMiuHmK
PO3LUMPEHHSI TOMY, KNauHiTb no Next

(Oani).

il

Wiehromss In Hhe Extend Vol
Wirard
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10. KnauHite no Next (dani), subpaswm  [fdiees: =
AVCK 3@ 3aMOBYaHHSM. Sekec Doty

3 D S A T 8 I i s T e

11, 3aBepLueHO HanaLITyBaHHS PO3LMPEHHS ToMy. KnauiTe no Finish (3akiHuntn),
106 BifHOBWTK noriyHuiA avck Intel® Rapid Start Technology.

12.  [lepe3anycTiTb CUCTEMY MICNS BUAANEHHS JIOTYHOrO AUCKY.

13.  Tlepeigitb o Start (Myck) > Control Panel (KoHTponbHa naHens) > Programs
(Mporpamwu) > Programs and Features (Mporpamu i dyHKLii), o6 Buaan1Ty Intel®
Rapid Start Manager ans nosHoro suaaneHHs Intel® Rapid Start Technology.

Intel® Smart Connect Technology

Intel® Smart Connect Technology — ue yHKUif, Ska Haaae HaHOBILLI
NMOHOBJIEHHS 3MICTy Ta 3abe3nevye eHeproeeKTUBHICTb NnaTgopmum
KoMmm’toTepa.

Konu BoHa BCTaHOBMEHa i akTnBoBaHa, Intel® Smart Connect Technology
nepioaM4HO BUBOAWTL CUCTEMY 3 PEXKMMY OYiKyBaHHS, 3anuncye faHi kopuctysada
i NOBEpPTaETLCS B PEXXMM OYiKyBaHHS, W06 3HOBY BUATK 3 HbOIO Yepes3 NeBHUI
NMPOMI>XKOK 4acy.

Outlook i Seesmic.

+ HeobxiaHo akTuByBaTh nyHKTM KoHdirypauii PCH y BIOS, nepLu Hix
3acTocysaty Intel® Smart Connect Technology. Mepeiiaits Ao Advanced Mode
(BricokoTexHonoriuHuii pexxim) > Advanced (BucokoTexHonoriunuit) > PCH
Configuration (KoHcpirypauist PCH).

% +  Intel® Smart Connect Technology niatTpumye 3aaadi Windows® Live Mail, Microsoft

IHcTansuis Intel® Smart Connect Technology
1. BcTtasTe DVD nigTpyMKu A0 ONTUYHOIO AUCKOBOAY.

2. MMepeinpite fo Utilities (YTunith) i knauHiTe no Intel® Smart Connect
Technology.

3. Ko 3’aBMTbCS Nporpama-noMivHmK HanawTyBaHHs, KnauHite no Next
(Aani), wob noyaTv HanawTyBaHHS.

4. BiamitbTe | accept the terms in the License Agreement (5 norog>xytocs i3
ymMoBamu niueH3inHoi yroam) i knauHite no Next (dani).
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5. BubepiTb BCE | KNauHiTh Mo
Next (Oani) ans Custom Setup
(HanawTysaHHs kopucTyBaya).

6. KnauHiTb no Install (IHcTantosat),
06 NPOLOBXMUTU iHCTanNALito.

7.

o e ol e — T T

e P T T ey TR P

|
]

o

iHcTanboBaHa Intel® Smart Connect Technology.

KopucTtyBaHHs Intel® Smart Connect Technology

- L]

KnauHite no Yes (Tak), o6 nepectapTyBaT¥t CUCTEMY, | MOYHE NpaLOBATH

R + MepLu HiXX cucTema nepeiifie B peXXnM O4ikyBaHHs, NepekoHaiiTecs, Lo Bu
36epernu 3agadi Ha po6o4oMy CToM, | BBEAITL 3aaadi Ta naponi.
+  [epekoHaiiTecs, Lo BCTAHOBAEHO NiAKIIO4EHHS A0 IHTEpHeT, Konn Bu akTusyeTe
Intel® Smart Connect Technology.

1. Knaunite no Start (Myck) > All Programs (Bci nporpamu) > Intel > Intel® Smart

Connect Technology.

noHoBneHHs). Konu oro aktusosaHo, naHesns Advanced
(BucokoTexHomnorivyHe) AOCTynHa ANst HanalTyBaHb BUCOKOTEXHOMONIYHNX

YHKUIRA.

Maxenb BucokoTexHonoriuHe
aKTMBOBaHa, KOMM aKT!

iHD
Woup

KnauHits, o6 nepernsHyT1

npo Bepcilo Ta

OHOBNEH

KnauyHiTb, wo6
KOHeirypysaTu
OCHOBHi
HanawTyBaHHs
KnauHiTb, wo6
aKTMByBaTH
a60 BUMKHYTH

nosinl

@—_ELT.:J |

Ha naneni Basic (OcHoBHi) knauHiTe no Enable Updating (AkTusysatu

Konu
aKTUBOBaHO

M gy

-

dyHKuilo

Konu aktusoBaHo
naHenb
NPOKPY4EHHS,
Bigperynioite
iHTepBan Buxoay
3 OuiKyBaHHsA Ans

OHOBNEHHSA AaHNX
IHTepHerT.
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OHOBJEHHS,
KNayHiTb, Wo6
CKWHYTH BCi
HanawTyBaHHs
Ha abpuyHi.
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3. o6 BUMKHYTM ot e e e I T

PYHKLtO MOHOBNEHHS, s Mt e

KJ'IaLl,Hin no Disable - T e —— e
Updating (BUMKHyTH @ = . ;:k_ﬂ Gl i
MOHOBEHHS). 5 A - T )
KnauHysLum no et e
Liii KHoMLj, By T pole EER. KL
aBTOMaTUYHO

BUMKHETE
KOHdirypauito Ha
naxeni Advanced
(BucokoTexHonorivxe).
LLlo6 ckuHyTM Ha
3aMOBYaHHS, KNauHiTh
no Reset All to Defaults (CkuryTv Bce Ha dpabpuuHi).

4. Ha naneni Advanced
(BucokoTexHonoriyxe),
BCTaHOBITb PO3Kiaa
NEPExXoay B PEXuUM
OuiKyBaHHs nif
4ac HU3bKOro

ot Fia ma -

Fartomer Imess g

€HEeprocnoXmuBaHHs,
1106 3aolannTm "‘“ e 3
eHeprito. Lle

HanawTyBaHHs T DU S ——

iy sl Sl e mmiion M it

npautoe nuLe ans
NPU3HA4EHOro nepioay
yacy.

5. Ha naHeni Help (Jonomora) knauHite About (Ipo), wo6 no6aunTty Bepcito yHKLUii.
KnauHiTb no Topics (Temu), o6 AisHaTucs binbLue npo Intel® Smart Connect
Technology Ta i koHdirypauito.
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[naBa 7

YCyHeHHs1 HecnpaBHOCTe

Y uiit rnasi po3kasaHo Npo AesKi HECNPABHOCTI, SiKi MOXKYTb BUHMKHYTH, Ta CNOCOGH iX

noaonaHHA.

?  )KusneHHs KoMn'loTepa He BMUKAETbCS, CBITNOAIOA Ha NepeaHii naHei

He CBITUTbCSA

MepesipTe, 4n NPaBUILHO MiAKNKOYEHO KOMM'IOTEP.
MNepesipTe, 4n Npautoe CTiHHA po3eTKa.

MepesipTe, un yBiMkHeHO Power Supply Unit (MpucTpiin xusnenHs). Ous.
po3gin YBIMKHEHHSA/BUMKHEHHS komn'toTepa y nasi 1.

?  Kowmn'totep "3aBuc”.

3po6iTb HACTyMHe, Wo6 3aKpyTK Mporpamu, siki He BiAMOBIAAOTh!

1. OfHo4acHo HaTUCHITL Ha knasiaTypi <Alt> + <Ctrl> + <Delete>, a noTim
KnauHite no Start Task Manger (3anycTutu MeHea>xep 3apau).

2. KnauniTb no naHeni Applications (3apaui).

3. Bubepitb nporpamy, sika He Bignosigae, i knauHite no End Task
(3axiHunTH 3aBAAHHS).

Skwo knasiatypa He BiAnoBifae. HaTUCHITL | yTpumyiiTe kHOMKy Power
(PKvBneHHs) Bropi Ha Kopnyci, MoKV BUMMKAETLCA cMCTEMA KoMM'toTepa.
HatwucHite Ha KHonky Power (XKusnerHs), WWo6 yBiMKHY T i0r0.

?  HemoxnunBo nigkmoynTucs 4o 6e34poToBoi Mepexi 3a JoroMOorow

Kkaptv Wi-Fi ASUS (nnwe Ha okpeMux Mogensix)?

ASUS CG8580

MepekoraiTecs, Wo Bu BBENM NpaBunbHUi MepexeBunii Koy 6e3neku ans
6e30p0OTOBOI Mepexi, A0 SKOi 6axKaeTe MiAKNOUNTIACS.

MigKntoYiT 30BHILLHI @aHTeHW (40AATKOBO) A0 CMOJy4YyBaYiB @aHTEHN Ha KapTi
Wi-Fi ASUS i po3micTiTe aHTeHu Haf KoprnycoM KoMm'toTepa, LWob oTpumatu
HaikpaLLmii 6e3ApPOTOBMIA 3B'A30K.

?  He npaytotoTe KHOMKM 3i CTPINKaMu Ha KnasiaTypi 3 yngppamm.

BiamiTbTe, sikwwo BUMKHEHO caiTnogion Number Lock (BriokyBaHHs
umncbpoBoi knasiaTypw). Konm ysimkHeHo caitnogioa Number Lock
(BrokyBaHHs LUMOPOBOI KNnasiaTypy), Knasili LMdPOBOT KNnasiatypu
BUKOPUCTOBYOTbCS NWLLIE ANS BBEAEHHS Lundp. HaTucHiTb kKnasiwy Number
Lock (BrokysaHHs LdbpoBoi KnasiaTypm), W06 BUMKHYTYU CBITNOAIOA, SKLLO
6a>kaeTe KOPUCTYBATUCA KNasilLamu 3i CTpinkamm Ha LMdpoBii Knasiatypi.
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?  HeMa 306paXkeHHs Ha MOHITOpI.

lNepesipTe, UM yBIMKHEHO MOHITOP.

lNepekoHanTeCs, WO MOHITOP NPaBUbHO NiAKMIOYEHUIA 10 NOPTY BUXOLY
BiZleo Ha KOMM'loTepi.

SAkuwo komn'toTep Mae B6YA0BaHy rpadiuHy KapTy, NepekoHaiTecs, LWob
Bw niakntounnu MOHITOp A0 NOpTY BUXOAY ayAio Ha BOYAOBaHii rpadiuHiii
KapTi.

lNepeBipTe, 4M He 3irHYTi KOHTAKTK CNony4yBaya BiAeo ANs MOHITOpa. AKLLO
B nobaunTe 3irHyTi KOHTAKTK, 3aMiHITb kabenb Cnonyyysaya Bifeo Ans
MOHiTOpA.

lNepesipTe, 4v NPaBWIIbHO NiAKMOYEHO MOHITOP 40 AXKEpena >XUBEHHS.

Y pokymeHTauii A0 MOHITOpa NoAaHo BinbLue iHgopmauii Mpo YCyHEHHs
HECMpaBHOCTEMN.

?  [lig yac KopucTyBaHHs 6araTbMa MOHITOPaMH 300PaXXeHHS 3HAXOANTLCS

JINLe Ha O4HOMY 3 HKX.

lNepekoHaiTecs, Lo 06uaBa MOHITOPK YBIMKHEHI O MEpPEXi.

Mig yac POST nuwe nigkntoyeHuid oo nopty VGA MOHITOp MaTume
306pakeHHs. OyHKLUis noasiiHOro nokady npautoe nuwe y Windows.

Konu Ha komn'toTep BCTaHOBNEHO rpadiyHy KapTy, nepekoHaiTecs, wo Bu
MiAKIIIOYUNIN MOHITOPY A0 NOPTY BUXOAY Ha rpadiuHiii KapTi.

lNepeBipTe, Y1 NpaBWAbHI HANAWTYBaHHA 6aratbox Avucnneis. [eTanbHiwe
npo ue - y po3aini MiagknioyeHHs 6araTbox 30BHilLHIX aucnneis y Mnasi 3.

?  Komn'toTep He poanizHae npucTpiii nam'ati USB.

Konwu Bu BnepLue nigkntovaeTe npucTpii nam'sti USB go komn'toTepa,
Windows aBTOMaTU4HO iHCTaNoE AN HbOro apaisep. Tpoxu noyekante
i nepeigitb o My Computer (Miii komn'toTep), W06 NepeBipuTy, Ym
BU3Ha4YeHO NpucTpiit nam'aTi USB.

MigkntoyiTb NpucTpi nam'aTi USB fo iHworo komn'toTepa, WwWob nepesipuTy,
Yu HeMa HecnpaBHOCTE! Y LiboMy NpucTpoi nam'aTi USB.

5 6axaro BiJHOBUTH CHCTEMHI HANALLTYBaHHS KOMIOTepa abo BigMIHNTH

3MIHH Y HHX, HE BTPaTHBLLUN 0COONCTI Qhasinm i AaHi.

Ocobnvsa xapakTepucTtuka Windows® System Restore (BigHoBneHHs
CHUCTEMM) HAAAE MOXXIIMBICTb BIJHOBUTM CUCTEMY aBO0 BiAMIHUTY 3MiHW Y i
HanawTyBaHHS He BNIMBaKOUM Ha Balli ocobucTi faHi, Taki Sk JOKyMeHTM
a6o choTo. [eTanbHille nNpo Le po3kasaHo y po3Aini BigHoBneHHs cucteMu
y nasi 2.

?  Bo6paxerHs Ha HDTV posTartyTo.

naBa 7: YCcyHeHHs HecnpaBHOCTE



. Lle BuKnmuKaHo pisHuLeto Mix YiTkicTio MoHiTopa Ta HDTV. Bigperyntoiite
YiTKICTb ekpaHy Tak, o6 BoHa nigxoauna ao HDTV. LLIo6 3MiHUTH HiTKiCTb
eKkpaHy:

1. 3po6iTb 6yAb-LUO 3 HACTYMHOrO, W06 BiAKPUTY €KPaH HanaLTyBaHHS
Screen Resolution (YiTkicTb expaHy):

+ KnauniTb no ﬂ > Control Panel (KoHTponbHa naHens) >
Appearance and Personalization (Burnsa i nepconanisadlis)
> Display (Oucnneit) > Change display settings (3MiHuTu
HanawTyBaHHs avcnnero).

+ [NpaBoto KHOMKO KNnauHiTb 6yab-ae Ha poboydomy ctoni Windows.
Konu 3sBuTbCa TUMUYacoBe MeHto, KnauHiTe no Personalize
(Nepconanisysatu) > Display (Aucnneii) > Change display settings
(3MiHMTH HanawTyBaHHA AUCTNeIo).

2. BigperynoBatu YiTkicTb. [eTasbHile npo YiTkiCTb po3ka3aHo B
nokymeHTauii go HDTV.

3. Knaunite no Apply (3actocysatu) a6o OK. MoTim knauHiTe no Keep
Changes (36eperTy 3MiHu) y NOBiAOMIIEHHI NiATBEPAXKEHHS.

?  Hema 3ByKy 3 AMHaMIKiB.

. MepekonaiTecs, Wo Bu nigkniounni AnHamiki o nopTy BUXOAY NiHiT
(3eneHuin) Ha nepepHiin abo 3aaHin naHeni.

. MepesipTe, un NiAKNOYEH AUHAMIKKL IO [XKepena dXUBNEHHS | yBIMKHEHI.
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. BigperyntoiiTe ryyHicTb AvHaMikis.

. nepeKOHaVlTeCﬂ, {0 HE BUMKHEHO 3BYK CUCTEMMW.

* SIKWo 3BYK BUMKHEHO, MiKTOrpama ry4HoCTi nokasaHa ﬂKm . LLo6
aKTUBYBaTH 3BYK

CUCTEMMU, KNAUHITb nom y ginsHui nosigomneHs Windows, noTim
KNauHiTb N0 s .

. SIKLLO 3BYK HE BUMKHEHO, KNauHiTb Mo m i NepeTArHiTb NOB3YH, LWO6
BifperynoBaTh ry4HicTb.

. MMigknoYiTh AMHAMIKK [O iHLWOro koMN'toTepa, LWo6 NepesipnuTy, L0 BOHM
NpautorTb K Chif.

?  [uckosog DVD He MOXe NpoYNTaTH JHCK.

. MepesipTe, 4n BCTaBNEHO AUCK SPIIKOM Bropy.

. [NepeBipTe, 4M ANCK PO3TALLOBAHO MO LEHTPY NOTKa, 0CO6MBO SKLLO ANCK
HecTaHAapTHUX dopmu a6o Po3Mipy.

. lMepeBipTe, Y4 HEMA Ha AMCKY NOAPSINUH i NOLUKOAXEHb.

?  KHonka usinsHeHHs guckoBogy DVD He signosigae.

1. Knaunitb no ﬂ> Computer (Komn'ioTep).

) . IS OVORWDwve
2. [paBoto KHOMKOK MULLI KNAUHITh N0 ==k , MOTIM
KnauHiTo Eject
(BMBINbHUTH) ¥ MEHIO.
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JKuBneHHs

Mpo6nema Mo>xnuBa npuumHa Lis
+ Skwo Baw komn’toTep mMae
nepeMmnkay Hanpyrv XuBneHHs,
BCTaAHOBITb HANPYry Ha MiCLEBUiA
HenpasunbHa Hanpyra cTaHaapT.
CTpymy + BigperyntoBaTtv HanawTyBaHHS
Hanpyru. MNepexkoranTecs, Lo WHyp
XKWBJIEHHS BUMKHEHO 3 PO3ETKM
Hema Mepexi
PKNBNEHHA HaTWCHITb KHOMKY >KMBNEHHS Ha
,(BV'MKHeHO Komn'toTep He yBIMKHEHO. | MepefHii naHeni, Wob nepekoHaTucs,
IHAVIKATOP LU0 KOMM'IOTEp YBIMKHEHO.
XKMBJIEHHS) .
+ [lepekoHainTecs, Lo LHYP
LLIHyp >kuneHHs XKMBJIEHHS KOMN'I0Tepa NpasuIbHO
KoMMN'toTepa HenpasuibHO NPUELHAHMIA.
NPUEAHAHMIA. + BuKopuCTOBY#TE iHLLINIA CyMiCHWIA
LLHYP XKMBNEHHS
Mpo6remn 6roky Bynb nacka, NOA3BOHITb HA HaLLy
KUBNEHHS raps4y Minito, W6 3BepHYTUCS NO
06CnyroByBaHHs.
Oucnneii
Mpo6nema Mo>xnusa npuimHa Lis

Micns
YBIMKHEHHS!
Komn'totepa
Hema
306paXKeHHs
(expaH 1opHwiA)

CwrHanbHuii Kabenb

He NiAKMIoYeHNii A0
npasunbHoro nopty VGA
Ha Komn'toTepi.

« TigKnoYiTh cUrHanbHUM Kabenb
[0 NPaBWIIbHOrO NOPTY AWCMED
(VGA Ha nnati a6o B6yAoBaHuit
nopt VGA).

SAkwo Bu kopucTyeTecs
BOyAoBaHoo KapToto VGA,
MiAKMOYITb CUrHANbHWIA Kabenb [0
BOynoBaHoro nopty VGA

Mpo6nemu curHanbHOro
Kabento

CnpobyiiTe NiaKMYMTY [0 iHLWOro
MOHiTOpa.
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JIoKaJibHa Mepexxa

Mpo6nema Mo>xnuBa npuuuHa Ois
Kabenb nokanbHoi MigkntouiTe Kabenb noKanbHoT
MepeXXi He NiAKNoYEHIA. MepeXxi o komn'loTepa.
[NepekoHanTecs, WO yBIMKHEHO
CBITNOAIOA NIOKANLHOT Mepexi.
Mpo6nemu kabeno SKLWO Hi, CnpobyiiTe iHLWKiA kKaberb
NIOKarbHOi Mepexi noKarbHOi Mepexi. AKLLOo Le Bce
OfIHO He A0MOMOrNIO, 3BEPHITLCS A0
RowiT cepsicHoro ueHTpy ASUS.
oMmn'toTep HeEMpPaBuIbHO o
Hemoxnmso ) P Herp MepeKoHaiTecs, L0 KOMM'IoTep
BiiTY 00 MiAKN0YeHNiA 1o ; o
y A NPasunbLHO MiAKIHOYEHWA A0
IHTepHeT mapLupyTusaropa abo 60 xa6
xa6a mapLupyTu3aTopa abo xaba.
3BEpHITLCA 10 NpoBaiiAepa nocnyr
. IHTepHeT (ISP), Wwo6 oTpumatn
HanawTtysaHHsa Mepexi ) ,
MpasWIIbHI HANALWTYBAHHS NIOKANBHOI
MepeXxi
Mpobnemun BUKNMKaHi o .
pobn Bakpwiite M3 aHTuBIpyCa.
AHTWBIPYCOM
o lNepeiHcTantoiite apansep NoKanbHoOI
Mpo6nemn apaiisepa PeIHC hp P
Mepexi
Ayanio
Mpo6nema Moxnusa npuunHa Ais
+ [lisnaiTecs, sikuid nopT
[unHamik a0 HaByLLIHWK npasunbHWIA, 3 KEpIBHULTBA A0
niaKnoYeHi oo Komn'toTepa.
HenpasuJIbHOrO MOPTY. + BigkntouiTh i 3HOBY NiAKMOYITH
OMHaMIK [0 KOMM'toTepa.
) [vHawmik abo HaBywwHKK He | CnobyiiTe BUKOPUCTATY iHLLINIA
Hewma aypio AMHaMIK 260 HaBYLLHWK.

npauioroTh.

lMNepenHi Ta 3aaHi nopTu
ayaio He NpauroroThb.

Cnpo6yiiTe i nepeHi, i 3aaHi nopTy
ayfio. SKLLO OAUH NOPT HECNPaBHMiA,
nepesipTe, Yy BCTAHOBIIEHWIA BiH Ha
6araTokaHanbHWiA BuXif.

Mpo6nemu apaisepa

lNepeiHcTantoiiTe Apaiisep aynio

ASUS CG8580
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Cucrema

Mpo6nema Mo>xnuea npuunHa Ris

Mpautoe 3abaraTto - )

3akpuiiTe gesiki nporpamu.

nporpam.
Cwuctema + BukopucToByiiTe aHTUBIpYC, W06
MNoBiNbHO A 4OTEDHOMO CKaHyBaTu BipyCH i naroauTy
npauoe BiTa»;a; KOMM'tOTEPHOT Kom'oTep.

pyca. - MepeiHcTantoiiTe onepauiitHy
CUCTEMY.

Hapiwsiime NOLWKOAXEHN
XKOPCTKMIA IMCK [0 CEPBICHOrO
uenTpy ASUS.

3aMiHiTb HOBMM >KOPCTKMM
LIVCKOM.

3aMmiHiTb CyMiCHUMU MOLYNSIMM
nam'siti.

3HiMiTb 10AATKOBI BCTAHOBIIEHi
Bawmu mogyni nam'aTi, noTim

Mpobnema »xopcTKoro
LICKy

Cuctema yacTo Mpo6nemun Mmopynio
He Bianosinae nam'sTi
abo 3aBmupae.

< cnpobyiiTe 3HOBY.

A

8 Komn'toTep HepocTaTHLO lNepecTtasTe KoMM'toTep y Micue,
T BEHTUNIOETHLCS. AKe KpaLLe BEHTUIIETLCS.

¢

A BcTaHoBneHi HecyMicHi lNepeiHcTantoiTe onepaviiy

o Mna3. cuctemy Ta cymicHe MM3.
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LleHTpanbHuii npouecop

Mpo6nema

Ogppasy nicns
YBIMKHEHHS!
KoMmn'toTepa BiH
HaATO rofiocHO

Moxnusa npuunHa

Bin6ysaeTbcs nepsuHHe
3aBaHTaXXEHHS CUCTEMM.

is
Lle HopmanbHo. Konun komn'toTep
BMWKAETbCS, BEHTUASTOP Npautoe
Ha NOBHY MOTY>KHICTb. BeHTunatop
CMOBIMNIbHIOETLCS NICAS BXOLY B
onepaviiHy cucTemy.

HanawTysaHHs BIOS
6yn0 3MiHeHo.

BinHoBiTb BIOS Ha iioro
HanalTyBaHHS 3a 3aMOBYaHHSIM.

3po6iTb noHoBneHHs BIOS Ha

CUNBHO LLYMWUTb
niA Yac po6oTw.

BEHTUNHOETLCA.

LLYMUTb. U . S
HalHoBILLY Bepcito. Biasinaite
CTapa Bepcis BIOS cant nigTpumkm ASUS: hitp:/
support.asus.com, 06
3aBaHTaXXWTU OCcTaHHi Bepcii BIOS
INepekoHawnTecs, Wwo Bu
BeHTunsatop KOPUCTYETECS CYMICHUM
LieHTpanbHoro npouecopa | abo peKoMeHAOBaHWM ANis
6yno 3aMiHeHO. LeHTpanbHoro npouecopa ASUS
BEHTUNATOPOM
Komn'toTep Komn'toTep HeAoCTaTHLO MNepecTasTe KomMn'toTep y Micue,

SKe KpaLle BEHTUNHETLCS.

Temnepatypa cuctemu
HaATO BMCOKA.

+ Bnockonanste BIOS.

* Ko Bu BMieTe nepeBcTaHoBNTH
MaTepuHCLKY nnaTty, cnpobyite
OYNUCTMTY KOPMYC i3 CEepeamnHm.

SKkwo npobnema BCe LLe iCHY€E, 3HANAITb KOHTaKTK cepBiCHOro LeHTpy ASUS y
rapaHTiiiHoMy TanoHi Ao ctauioHapHoro K. Biasigaiite caint niatpumkn ASUS: http:/
~ support.asus.com, |06 3HANTV KOHTAKTV CEPBICHOrO LIEHTPY.
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KonTakTHa iHbopmauis ASUS

ASUSTeK COMPUTER INC.

Anpeca 5 Li-Te Road, Peitou, Taipei, Taiwan 11259
TenedoH +886-2-2894-3447

dake +886-2-2890-7798

EnexTpoHHa nowTa info@asus.com.tw

Be6-cant www.asus.com.tw

TexHiyHa nigTpumMKa

TenedoH +86-21-38429911
MigTpMKa oH-nanH support.asus.com
ASUS COMPUTER INTERNATIONAL (Amepuka)
Anpeca 800 Corporate Way, Fremont, CA 94539, USA
TenedoH +1-510-739-3777
Qakc +1-510-608-4555
Be6-caitt usa.asus.com
x
© TexHiyHa nigTpuMKa
S Tenedbon +1-812-282-2787
o Dakc niaTPUMKM +1-812-284-0883
% MigTpUMKa OH-NaiiH support.asus.com
o
ASUS COMPUTER GmbH (HimeuuuHa i ABCTpist)
Anpeca Harkort Str. 21-23, D-40880 Ratingen, Germany
dake +49-2102-959911
Be6-cait www.asus.de
akc niaTPUMKM www.asus.de/sales

TexHiyHa nigTpuMKa

KomnoHeHTHui1 TenedoH +49-1805-010923"
Cuctema/llopTaTusHuii komn'totep/Eee/TenedoH 3 PK-agucnneem+49-1805-010920*
®akc niaTPUMKM +49-2102-9599-11

MigTpMKa oH-nanH support.asus.com

* 0,14 eBpo 3a XBUNMHY 3i cTalioHapHuX TenedoHiB y HiMeuumnni; 0,42 €Bpo 3a XBUNMHY 3 MOGINbHUX

TenedoHiB.

Bupo6Huk: ASUSTeK Computer Inc.

Appeca: No.150, LI-TE RD., PEITOU, TAIPEI 112,
TAIWAN

ABTOPN30BaHMii NpeACTaBHUK B ASUS Computer GmbH

€sponi:

Appeca: HARKORT STR. 21-23, 40880 RATINGEN,
GERMANY
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